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have been estimated through extrapolation. Actual 
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any other claims related to non-IBM products. 
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Preface

This manual describes the Netcool/Proviso Cisco IP Telephony Technology Pack, focusing on the Cisco IP 
Telephony environment. Specifically, the manual describes the reports for displaying information about the 
devices and technologies that operate in the Cisco IP Telephony environment. The manual also describes the data 
collection model, properties, resources, collection formulas, and metrics that the Cisco IP Telephony Technology 
Pack provides to create the associated reporter sets. 

Note:  This technology pack supports the Cisco CallManager (CCM) environment and its new implementation, 
the Cisco Unified Call Manager (CUCM) environment. Where this guide refers to Cisco CallManager or CCM, 
it also applies to Cisco Unified Call Manager (CUCM), unless an explicit distinction is made.

Audience

The audiences for this manual are the network administration engineers at IBM customer sites who will install, 
configure, and use the Cisco IP Telephony Technology Pack as part of their Netcool/Proviso installation. IBM 
Professional Services engineers may also find this manual useful. 

To install and use the Cisco IP Telephony Technology Pack, you should have a working knowledge of the 
following subjects: 

• Netcool/Proviso DataMart 

• TCP/IP networks 

• Telecom network management 

• Administration of the operating system

The audiences should also be familiar with the specific technology that the Cisco IP Telephony Technology Pack 
deals with, in this case Cisco IP Telephony. 

Organization

This guide is organized as follows: 

• Chapter 1, Introduction

Provides a general introduction to technology packs. 

• Chapter 2, Supported Reports

Provides information about the reports that the Cisco IP Telephony Technology Pack provides for each 
device operating in the Cisco IP Telephony environment. 

• Chapter 3, Devices and Services 

Describes the devices and services that the Cisco IP Telephony Technology Pack supports. 
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• Chapter 4, Element and Sub-Element Properties

Describes the properties that the Cisco IP Telephony Technology Pack discovers during the inventory 
process. 

• Chapter 6, Sub-Element Grouping Rules 

Describes the sub-element collection grouping rules and the NOC reporting grouping rules that the Cisco 
IP Telephony Technology Pack defines. 

• Chapter 5, Defined Resources 

Provides information about the elements and sub-elements that the technology pack defines in the Proviso 
database. 

• Chapter 7, Collection Formulas 

Provides information about the SNMP and bulk collection formulas included in the Cisco IP Telephony 
Technology Pack. 

• Chapter 8, Discovery Formulas 

Provides information about the Discovery formulas that the Cisco IP Telephony Technology Pack provides 
for devices operating in the Cisco IP Telephony environment. 

• Appendix A, Configuration 

Describes how to configure the Cisco IP Telephony Technology Pack. 

• Appendix B, UBA Parameters Reference (443, Topology Editor) 

Provides Unix reference pages for each of the pack-specific UBA parameters supplied with the XSD file for 
the Cisco IP Telephony Technology Pack. 

• Appendix C, Template File Reference 

Explains the edits (using a text editor) that need to be made to pack-specific UBA parameters delivered in 
the pack’s template file. 

The Netcool/Proviso Product Suite

Netcool/Proviso is made up of the following components:

• Netcool/Proviso DataMart is a set of management, configuration and troubleshooting GUIs that the 
Netcool/Proviso System Administrator uses to define policies and configuration, as well as verify and 
troubleshoot operations.

• Netcool/Proviso DataLoad provides flexible, distributed data collection and data import of SNMP and 
non-SNMP data to a centralized database.

• Netcool/Proviso DataChannel aggregates the data collected through Netcool/Proviso DataLoad for use 
by the Netcool/Proviso DataView reporting functions. It also processes on-line calculations and detects real-
time threshold violations.

• Netcool/Proviso DataView is a reliable application server for on-demand, web-based network reports.
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• Netcool/Proviso Technology Packs extend the Netcool/Proviso system with service-ready reports for 
network operations, business development, and customer viewing.

The following figure shows the different Netcool/Proviso modules.

Figure 1: Netcool/Proviso Modules

DataLoad
collects 
network data.

DataChannel
computes
aggregations
and stores data
in DataMart.

DataMart
provides data
management 

DataView
produces and
manages reports.

and applications.

Netcool/Proviso documentations consists of the following:

• release notes

• configuration recommendations

• user guides

• technical notes

• online help

The documentation is available for viewing and downloading on the infocenter at: 
http://publib.boulder.ibm.com/infocenter/tivihelp/v8r1/index.jsp?topic=/com.ibm.netcool_proviso.doc/welcome.htm
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Chapter 1:  Introduction 

This chapter discusses the following topics:

Overview 

Netcool/Proviso Technology Packs are individually installed modules that contain discovery, grouping, 
collection, and reporting instructions created by Technology Pack developers or Professional Services personnel 
for a specific network technology or network equipment provider, such as Cisco IP Telephony. 

Once installed, a Technology Pack “programs” Netcool/Proviso to inventory and group specific network 
resources, perform mathematical calculations on raw or aggregated data streams collected from these resources, 
and produce key performance monitoring metrics that are stored on the Netcool/Proviso database. Reporter sets 
designed for each Technology Pack query the database for this information and display the results on a web portal 
in the form of specialized report tables, graphs, and charts.

This chapter provides an overview of how Technology Packs work with Netcool/Proviso to collect, process, load, 
and report data from a network environment.

How is the Data Collected?

Inventory

After a Netcool/Proviso Technology Pack has been installed, an inventory process must be run so that the 
Technology Pack’s target network resources can be identified and modeled within Netcool/Proviso as sub-
elements. Sub-elements must be created before data from any network resource can be collected, processed, and 
stored in the database. 

How sub-elements are discovered depends on whether the target resources are SNMP resources or non-SNMP 
resources:

• For SNMP network resources, a Technology Pack provides a discovery formula. Discovery formulas are used 
to evaluate network resources, determine which resources become sub-elements, and set values for items 
defined as properties in the formula. Once all the sub-elements have been discovered and created in the 
database, the inventory process organizes the sub-elements according to the grouping rules provided by a 

Topic Page 

Overview 1

How is the Data Collected? 1

How is the Data Processed and Loaded into the Database? 2

How is the Data Reported? 3
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Technology Pack. The grouping rules use the properties and values defined within inventory formulas or 
adaptor design files to filter the sub-elements into their appropriate collection or reporting groups. 

• For non-SNMP network resources, a Technology Pack provides a Bulk Adaptor Design File. Bulk Adaptor 
Design Files define how data fields that reside in files generated by network resources are used to create sub-
elements and set values for items defined as properties.

During the database synchronization phase of the inventory process, the list of discovered sub-elements is 
compared to what exists in the database. Newly discovered sub-elements are assigned a resource identifier (RID) 
and timestamp, and the database uses both items to create a new entry for the sub-element to reflect the known 
state of the network inventory. 

Collection

Following the completion of the inventory process, Netcool/Proviso is ready to collect performance data for a 
Technology Pack’s target network resources. A Technology Pack provides Netcool/Proviso with collection 
formulas that instruct a DataLoad collector residing in a DataChannel to collect specific types of performance 
data against a particular sub-element. 

The types of collection formulas applied to the data depend on whether the sub-element is an SNMP resource 
or non-SNMP resource:

• For SNMP network resources, a Technology Pack provides SNMP collection formulas. SNMP collection 
formulas instruct the SNMP Collector to take the data gathered during a specified collection interval, 
perform some mathematical operation on the data, and output the result as a performance metric. 

• For non-SNMP network resources, a Technology Pack provides Bulk collection formulas. A Bulk collection 
formula, unlike an SNMP collection formula, has no executable instructions. A Bulk collection formula 
consists of a metric name that is mapped by the Bulk Adaptor Design File to a statistic that resides in the 
input file generated by a network resource.

Either type of collection formula outputs a metric and corresponding unique metric identifier (MID) that are 
passed along the DataChannel to the Complex Metric Engine for processing. 

How is the Data Processed and Loaded into the Database?

The Complex Metric Engine (CME) is a component in the DataChannel that performs calculations on data 
gathered by the SNMP or Bulk collectors deployed in a network. These calculations include the following: 

• Pre-defined formulas that are provided by a Technology Pack

• User-defined formulas created using the CME Formula API

• Time aggregations for sub-elements

In addition to performing calculations on the data stream in the DataChannel, the CME also buffers and sorts 
metric records according to their RIDs and MIDs to optimize how the data and metrics are stored in the database.
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CME Operation

The CME is designed to work with data that is gathered over the space of one hour. Within that hour, there are 
several distinct phases that characterize the operation of the CME:

• Loading Phase

• Building Phase

• Processing Phase

• Output Phase

Loading Phase

During the beginning of each hour, the CME creates a new network configuration model based on the inventory 
structure that exists in the database at that time. This model is used as a snapshot of the network environment 
and serves as the basis for all metric processing for the entire duration of the hour. At the end of the hour, the 
CME polls the database for any changes that have been made to the inventory and creates a new network 
configuration model for the next hour.

As the CME reloads its configuration hourly, any metrics produced by sub-elements following the last polling 
period are rejected by the CME until the beginning of the next hour.

Building Phase

Once the current configuration model has been built, the CME creates a table of sub-elements and metrics that 
are expected for the current hour. The CME uses the RIDs and MIDs to build the table and determine which 
metrics should be arriving from the collectors. The table also specifies how resources are related, and determines 
if there are any CME formulas that must be applied to a sub-element’s metrics once the data is gathered.

Processing Phase

Whenever new data arrives at the CME, it is evaluated and stored in the appropriate table location, along with any 
Resource Aggregation information. Once the input and processing dependencies for a metric in the table have 
been met, the CME processes the metrics and stores the data until the end of the hour.

Output Phase

At the end of the current hour, the CME outputs everything in memory to the Hourly and Daily Loaders. The 
data sent to the database loaders includes the sorted data for the current hour, and resource and group 
aggregations for each of the processing periods up to the current time. The Hourly Loader computes group and 
resource aggregations, while the Daily Loader creates metric statistics and inserts the data into the database. 

How is the Data Reported?

The data collected, processed, and stored in the database by Netcool/Proviso is organized and output for 
customers using reporter sets that are designed by developers and Professional Services personnel for a specific 
Technology Pack. 
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A Technology Pack reporter set is a related group of reports that provide performance information on a specific 
set of devices or resources that exist in a network. Each report consists of a series of queries that retrieve related 
sub-elements and their corresponding metrics from the database using the RIDs and MIDs assigned during the 
inventory and collection processes. The retrieved results are then organized within the report and are displayed 
on a web portal in the form of tables, graphs, and charts. 

A Technology Pack provides a variety of reports and charts, including: 

• Resource Summary Reports (RSTs) (sometimes referred to as Resource Summary Tables) aggregate data 
across time for an individual sub-element and define the statistics that are relevant for a measure of its 
network performance. 

• Group Summary Reports (GSTs) (sometimes referred to as Group Summary Tables) aggregate data across 
both time and sub-elements, and define the statistics that are relevant for a measure of network performance 
for a group of resources. 

• Detail Charts (DCs) display raw data for a metric that has been aggregated for an individual sub-element over 
a particular period of time. 

• Dashboards display a series of abbreviated tables and charts that provide an overall summary of the metrics 
collected for the target network resource supported by the Technology Pack. 

• Timeseries charts present time series information, where the x axis is time and the y axis is the data value. 

• TopN reports list the N highest values during a specified time range for a specific metric. 

• Resource Distribution charts (often referred to as pie charts) show the distribution of resources across 
specific ranges. Typically, a legend for the Resource Distribution chart appears in the report. 

• Resource Over Threshold Tables (RTTs) display a list of resources that have violated their threshold for a 
specific metric. Typically, users navigate to an RTT from a Group Summary Table (GST), using the threshold 
overflow cell navigation link. 

• Ratio charts show the relationship of a single metric among different resources or a single resource among 
different metrics. 
4  Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 1:  Introduction
NOTES
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 5



Chapter 1:  Introduction
6  Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 2:  Supported Reports

This chapter discusses the following topics: 

Overview 

The Cisco IP Telephony Technology Pack supplies a set of reports suitable for displaying information about the 
devices and activity associated with the Cisco IP Telephony environment.

Reports contain metrics that are generated by the formulas that this technology pack provides. Metric names are 
the same as the names of the formulas that generate them. For information about a metric that is listed for a 
particular report, see the description of the associated formula in the collection formula chapter of this guide.

This chapter includes information to help you navigate to a particular report on the DataView portal. This 
navigation path is the same as the path where the report has been deployed through the DataMart Resource 
Editor. Note, however, that some reports are not explicitly deployed on the portal navigation path. You can 
display such a report by "drilling down" to it from other reports.

For information about understanding report types, creating reports, configuring reports, viewing and working 
with reports, and deploying reports, see the Netcool/Proviso DataView User’s Guide. This Technology Pack User’s Guide 
assumes an understanding of the report-related topics discussed in the Netcool/Proviso DataView User’s Guide. 

Reporter Sets

  

Reporter Set Tree

This technology pack provides the reporter sets listed below. The list presents the reporter sets as they appear in 
the DataView Navigator tree structure:

AP Cisco VOIP Pack
...Global Customer Reports
...Call Detail Record
......Cluster
......Extension
......K-Factor
......Codec

Topic Page 

Overview 7

Reporter Sets 7

Reports 9
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...Infrastructure

......CallManager Server

......PSTN Gateway

.........Interface

.........Device

.........DSP Card

......Media Devices

......Gatekeeper

.........Device

.........Interface

......Perfmon
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Reports

This technology pack provides the following reports:

CCM Server Quality Resource

CCM Server Quality Resource Detail Chart

CCM Sql Server Group

CCM Sql Server Resource

CCM Sql Server Resource Detail Chart

CDR Call Distribution Detail Chart

CDR Call Distribution Group

CDR Call Distribution Resource

CDR Quality Detail Chart

CDR Quality Group

CDR Quality Resource

CDR Utilization Detail Chart

CDR Utilization Group

CDR Utilization Resource

CDR VoiceMail Usage Detail Chart

CDR VoiceMail Usage Resource

Cluster Call Distribution Detail Chart

Cluster Call Distribution Group

Cluster Call Distribution Resource

Cluster Erlang-B Group

Cluster IP vs Legacy Detail Chart

Cluster IP vs Legacy Resource

Cluster Quality Detail Chart

Cluster Quality Group

Cluster Quality Resource

Cluster Utilization Detail Chart

Cluster Utilization Group

Cluster Utilization MLH Resource

Cluster Utilization Resource

Cluster VoiceMail Usage Detail Chart

Cluster VoiceMail Usage Resource

Errors on Cluster by Codec

Gatekeeper Availability Resource
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Gatekeeper Availability Resource Detail Chart

Gatekeeper Device Quality Resource

Gatekeeper Device Quality Resource Detail Chart

Gatekeeper Interface Availability Resource

Gatekeeper Interface Availability Resource Detail Chart

Gatekeeper Interface Utilization Resource

Gatekeeper Interface Utilization Resource Detail Chart

Global VOIP

K-Factor Detail Chart

K-Factor Group

K-Factor Resource

Media Device Group

Media Device Resource

Media Device Resource Detail Chart

Perfmon Active Calls Detail Chart

Perfmon Active Calls Group

Perfmon Active Calls Resource

Perfmon MOH Detail Chart

Perfmon MOH Group

Perfmon MOH Resource

Perfmon PSTN Detail Chart

Perfmon PSTN Group

Perfmon PSTN Resource

Perfmon Security Detail Chart

Perfmon Security Group

Perfmon Security Resource

PSTN Gateway Availability Resource

PSTN Gateway Availability Resource Detail Chart

PSTN Gateway Device DS0 Usage Detail Chart

PSTN Gateway Device Quality Resource

PSTN Gateway Device Quality Resource Detail Chart

PSTN Gateway DSP Card Resource

PSTN Gateway DSP Card Resource Detail Chart

PSTN Gateway E1/T1 Availability Resource Detail Chart

PSTN Gateway E1/T1 Interface Utilization Resource

PSTN Gateway E1/T1 Interface Utilization Resource Detail Chart
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PSTN Gateway E1/T1Availability Resource

Top 10 CDR Call Completion

Top 10 CDR Call Duration

Top 10 CDR K-Factor

Top 10 CDR Number of Calls

Top 10 CDR Number of Errors

Top 10 Cluster Call Completion

Top 10 Cluster Number of Calls

Top 10 Cluster Number of Errors

Top 10 E1/T1 Utilization Resource

The reports in this technology pack are described on the following pages.
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CCM Server Quality Resource Detail Chart

Description

Detail chart showing CallManager cluster and server quality. 

Reporter Set

CallManager Server

Tables and Charts

Charts: Resource Time Series Chart (4 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

CCM CPU Utilization (percent) (avg last 5 mn)

CCM Physical Memory Utilization (percent)

CCM Registered CTI Devices (Nb) (Gauge)

CCM Registered Devices (Nb) (Gauge)

CCM Registered Gateways (Nb) (Gauge)

CCM Registered Media Devices (Nb) (Gauge)

CCM Registered Phones (Nb) (Gauge)

CCM Registered VoiceMail Devices (Nb) (Gauge)

CCM Rejected Devices (Nb) (Gauge) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

CCM Server Quality Resource
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CCM Server Quality Resource

Description

Resource summary chart showing CallManager cluster and server quality. 

Reporter Set

CallManager Server

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

CCM CPU Utilization (percent) (avg last 5 mn)

CCM Physical Memory Utilization (percent)

CCM Registered Devices (Nb) (Gauge)

CCM Rejected Devices (Nb) (Gauge) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > %(VoIPCallMgrClusterId)

Drills Down To

CCM Server Quality Resource 

CCM Server Quality Resource Detail Chart 

Drilled Down From

CCM Server Quality Resource 

CCM Sql Server Group 

Global VOIP
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CCM Sql Server Group

Description

Group summary chart showing CallManager SQL server usage. 

Reporter Set

CallManager Server

Tables and Charts

Tables: Group Summary Table (1 of 2 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

CCM CPU Utilization (percent) (avg last 5 mn)

CCM SQL Server free buffers (Nb)

CCM SQL Server number active user connections

CCM SQL Server number of blocked users

CCM SQL Server number of locks

CCM SQL Server number of pending rw

CCM SQL Server Total number of Pages 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server

Drills Down To

CCM Server Quality Resource 

CCM Sql Server Resource 

Drilled Down From

None.
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CCM Sql Server Resource Detail Chart

Description 

Detail chart showing CallManager SQL server usage. 

Reporter Set

CallManager Server

Tables and Charts

Charts: Resource Time Series Chart (6 of 8 implemented) 
Metric Ratio Chart (1 of 2 implemented) 

Metrics Used in Report 

CCM SQL Server Availability percentage

CCM SQL Server number active user connections

CCM SQL Server number of blocked users

CCM SQL Server number of locks blocking processes

CCM SQL Server number of locks

CCM SQL Server number of pending rw

CCM SQL Server Total number of Pages 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

CCM Sql Server Resource
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CCM Sql Server Resource

Description

Resource summary chart showing CallManager SQL server usage. 

Reporter Set

CallManager Server

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

CCM SQL Server Availability percentage

CCM SQL Server Cache Hit ratio (percent)

CCM SQL Server free buffers (Nb)

CCM SQL Server number active user connections

CCM SQL Server number of blocked users

CCM SQL Server number of locks

CCM SQL Server number of pending rw

CCM SQL Server Total number of Pages 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > %(VoIPCallMgrClusterId)

Drills Down To

CCM Sql Server Resource 

CCM Sql Server Resource Detail Chart 

Drilled Down From

CCM Sql Server Group 

CCM Sql Server Resource
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CDR Call Distribution Detail Chart

Description

Detail chart showing the specific sub-element call distribution based on information collected through CDRs and 
CMRs. 

Reporter Set

Extension

Tables and Charts

Charts: Resource Time Series Chart (6 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Incoming

Internal

International

Local

LongDistance

OffNet

OnNet

SuccessfulCall

Total Number of Outgoing External Calls (Nb)

UnsuccessfulCall 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

CDR Call Distribution Resource
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CDR Call Distribution Group

Description

Group summary chart showing the specific sub-element call distribution based on information collected through 
CDRs and CMRs. 

Reporter Set

Extension

Tables and Charts

Tables: GroupSummary (1 implemented) 

Charts: Ratio (2 implemented) 

Metrics Used in Report 

Incoming

Internal

International

Local

LongDistance

Total Number of Outgoing External Calls (Nb) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Path Group

Drills Down To

CDR Call Distribution Resource 

Drilled Down From

None.
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CDR Call Distribution Resource

Description

Resource summary chart showing the specific sub-element call distribution based on information collected 
through CDRs and CMRs. 

Reporter Set

Extension

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Incoming

Internal

International

Local

LongDistance

Total Number of Outgoing External Calls (Nb) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > 
%(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > 
%(CDRcustomerId)

Drills Down To

CDR Call Distribution Detail Chart 

Drilled Down From

CDR Call Distribution Group
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CDR Quality Detail Chart

Description

Detail chart showing the specific sub-element quality based on information collected through Call Detail records 
(call signaling) and Call Maintenance Records. 

Reporter Set

Extension

Tables and Charts

Charts: Resource Time Series Chart (6 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Jitter

Latency

MOS

NbPacketsLost

NbPacketsReceived

NbPacketsSent

SuccessfulCall

UnsuccessfulCall 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

CDR Quality Resource 

Errors on Cluster by Codec 

K-Factor Resource 

Perfmon Active Calls Resource 
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Perfmon MOH Resource 

Perfmon PSTN Resource 

Perfmon Security Resource 

Top 10 CDR Call Completion 

Top 10 CDR Number of Errors
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CDR Quality Group

Description

Group summary chart showing the specific sub-element quality based on information collected through Call 
Detail records (call signaling) and Call Maintenance Records. 

Reporter Set

Extension

Tables and Charts

Tables: Group Summary Table (1 of 2 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

Jitter

Latency

MOS

Percentage of Drop Calls (percent) CME(Bulk) VOIP Cisco

Percentage of Packet Lost (percent) CME(Bulk) VOIP Cisco

Percentage of Successful Calls (Nb) CME(Bulk) VOIP Cisco 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Path Group

Drills Down To

CDR Quality Resource 

Cluster Quality Resource 

Drilled Down From

None.
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CDR Quality Resource

Description

Resource summary chart showing the specific sub-element quality based on information collected through Call 
Detail records (call signaling) and Call Maintenance Records. 

Reporter Set

Extension

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

Jitter

Latency

MOS

Percentage of Drop Calls (percent) CME(Bulk) VOIP Cisco

Percentage of Packet Lost (percent) CME(Bulk) VOIP Cisco

Percentage of Successful Calls (Nb) CME(Bulk) VOIP Cisco

SuccessfulCall

UnsuccessfulCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > %(customerId)
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > 
%(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > 
%(CDRcustomerId)

Drills Down To

CDR Quality Detail Chart 

Drilled Down From

CDR Quality Group 

K-Factor Group 

Perfmon Active Calls Group 

Perfmon MOH Group 

Perfmon PSTN Group 

Perfmon Security Group
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CDR Utilization Detail Chart

Description

Detail chart showing the specific sub-element utilization based on information collected through CDRs and 
CMRs. 

Reporter Set

Extension

Tables and Charts

Charts: Resource Time Series Chart (6 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

CallDuration

NbPacketsLost

NbPacketsReceived

NbPacketsSent

OffNet

SuccessfulCall

Total Number of Calls (Nb) CME(Bulk) VOIP Cisco

UnsuccessfulCall 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

CDR Utilization Resource 

Top 10 CDR Call Duration 

Top 10 CDR Number of Calls
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CDR Utilization Group

Description

Group summary chart showing the specific sub-element utilization based on information collected through 
CDRs and CMRs. 

Reporter Set

Extension

Tables and Charts

Tables: Group Summary Table (1 of 2 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

CallDuration

NbPacketsLost

NbPacketsReceived

NbPacketsSent

Percentage of Company Calls (percent) CME(Bulk) VOIP Cisco

Percentage of TollBypass Calls (percent) CME(Bulk) VOIP Cisco

Total Number of Calls (Nb) CME(Bulk) VOIP Cisco 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Path Group

Drills Down To

CDR Utilization Resource 

Cluster Utilization Resource 

Drilled Down From

None.
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CDR Utilization Resource

Description

Resource summary chart showing the specific sub-element utilization based on information collected through 
CDRs and CMRs. 

Reporter Set

Extension

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

CallDuration

NbPacketsLost

NbPacketsReceived

NbPacketsSent

Percentage of Drop Calls (percent) CME(Bulk) VOIP Cisco

Percentage of Successful Calls (Nb) CME(Bulk) VOIP Cisco

Total Number of Calls (Nb) CME(Bulk) VOIP Cisco 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > 
%(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > 
%(CDRcustomerId)

Drills Down To

CDR Utilization Detail Chart 

Drilled Down From

CDR Utilization Group 

PSTN Gateway E1/T1Availability Resource
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CDR VoiceMail Usage Detail Chart

Description

Detail chart showing the specific sub-element voicemail utilization based on information collected through CDRs 
and CMRs. 

Reporter Set

Extension

Tables and Charts

Charts: Resource Time Series Chart (5 of 8 implemented) 
Metric Ratio Chart (1 of 2 implemented) 

Metrics Used in Report 

ForwardToVoiceMail

Total Number of VoiceMail Direct Calls (Nb) CME(Bulk) VOIP Cisco

VoicemailCallDuration

VoiceMailCall

VoicemailPackets 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

CDR VoiceMail Usage Resource
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CDR VoiceMail Usage Resource

Description

Resource summary chart showing the specific sub-element voicemail utilization based on information collected 
through CDRs and CMRs. 

Reporter Set

Extension

Tables and Charts

Tables: ResSummary (1 implemented) 

Charts: Ratio (1 implemented) 

Metrics Used in Report 

ForwardToVoiceMail

Total Number of VoiceMail Direct Calls (Nb) CME(Bulk) VOIP Cisco

VoicemailCallDuration

VoiceMailCall

VoicemailPackets 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > 
%(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > 
%(CDRcustomerId)

Drills Down To

CDR VoiceMail Usage Detail Chart 

Drilled Down From

None.
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Cluster Call Distribution Detail Chart

Description

Detail chart showing cluster call distribution based on information collected through CDRs and CMRs. 

Reporter Set

Cluster

Tables and Charts

Charts: Resource Time Series Chart (6 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Total Number of External Calls (Nb)

Cluster Total Number of Outgoing External Calls (Nb)

ClusterIncomingCall

ClusterInternalCall

ClusterInternationalCall

ClusterLocalCall

ClusterLongDistanceCall

ClusterSuccessfulCall

ClusterUnsuccessfulCall 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Cluster Call Distribution Resource
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 33



Chapter 2:  Supported Reports
Cluster Call Distribution Group

Description

Group summary chart showing cluster call distribution based on information collected through CDRs and CMRs. 

Reporter Set

Cluster

Tables and Charts

Tables: GroupSummary (1 implemented) 

Charts: Ratio (2 implemented) 

Metrics Used in Report 

Cluster Total Number of Outgoing External Calls (Nb)

ClusterIncomingCall

ClusterInternalCall

ClusterInternationalCall

ClusterLocalCall

ClusterLongDistanceCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters

Drills Down To

Cluster Call Distribution Resource 

Drilled Down From

None.
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Cluster Call Distribution Resource

Description

Resource summary chart showing cluster call distribution based on information collected through CDRs and 
CMRs. 

Reporter Set

Cluster

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Total Number of External Calls (Nb)

Cluster Total Number of Outgoing External Calls (Nb)

ClusterIncomingCall

ClusterInternalCall

ClusterInternationalCall

ClusterLocalCall

ClusterLongDistanceCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(CDRclusterId)

Drills Down To

Cluster Call Distribution Detail Chart 

Drilled Down From

Cluster Call Distribution Group
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Cluster Erlang-B Group

Description

Group summary report for predicting call loss in a cluster. 

Reporter Set

Cluster

Tables and Charts

Tables: Group Summary Table (1 of 2 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

Cluster Erlang

Cluster Total Hours of Traffic

ClusterBlocking

ClusterErlangB

ClusterLines 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters

Drills Down To

Cluster Quality Resource 

Drilled Down From

None.
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Cluster IP vs Legacy Detail Chart

Description

Detail chart showing cluster company call distribution based on information collected through CDRs and CMRs.

Company calls are: 

• Intrasite and intersite IP calls 

• Intrasite and intersite legacy PBX calls 

Reporter Set

Cluster

Tables and Charts

Charts: Resource Time Series Chart (3 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Total Number of Company Calls (Nb)

Cluster Total Number of Company IP Calls (Nb)

Cluster Total Number of Company LegacyPBX Calls (Nb)

Cluster Total Number of External Calls (Nb) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Cluster IP vs Legacy Resource
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Cluster IP vs Legacy Resource

Description

Resource summary chart showing cluster company call distribution based on information collected through 
CDRs and CMRs.

Company calls are: 

• Intrasite and intersite IP calls 

• Intrasite and intersite legacy PBX calls 

Reporter Set

Cluster

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Total Number of Company Calls (Nb)

Cluster Total Number of Company IP Calls (Nb)

Cluster Total Number of Company LegacyPBX Calls (Nb)

Cluster Total Number of External Calls (Nb)

ClusterTollBypassCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(CDRclusterId)

Drills Down To

Cluster IP vs Legacy Detail Chart 

Drilled Down From

None.
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Cluster Quality Detail Chart

Description

Detail chart showing cluster quality based on information collected through Call Detail Records (call signaling) 
and Call Maintenance Records. 

Reporter Set

Cluster

Tables and Charts

Charts: Resource Time Series Chart (7 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

ClusterDropCall

ClusterJitter

ClusterMOS

ClusterNbPacketsLost

ClusterNbPacketsReceived

ClusterNbPacketsSent

ClusterSuccessfulCall

ClusterUnsuccessfulCall

MLQK 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Cluster Quality Resource 

Top 10 Cluster Call Completion 

Top 10 Cluster Number of Errors
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Cluster Quality Group

Description

Group summary chart showing cluster quality based on information collected through Call Detail Records (call 
signaling) and Call Maintenance Records. 

Reporter Set

Cluster

Tables and Charts

Tables: Group Summary Table (1 of 2 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Percentage of Drop Calls (percent)

Cluster Percentage of Packet Lost (percent)

Cluster Percentage of Successful Calls (percent)

ClusterJitter

ClusterLatency

ClusterMOS

MLQK 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters

Drills Down To

Cluster Quality Resource 

Drilled Down From

None.
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Cluster Quality Resource

Description

Resource summary chart showing cluster quality based on information collected through Call Detail Records (call 
signaling) and Call Maintenance Records. 

Reporter Set

Cluster

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Total Number of Normal Call Clearing

ClusterDropCall

ClusterJitter

ClusterLatency

ClusterNbPacketsLost

ClusterSuccessfulCall

ClusterUnsuccessfulCall

MLQK 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(CDRclusterId)

Drills Down To

Cluster Quality Detail Chart 

Drilled Down From

CDR Quality Group 

Cluster Erlang-B Group 

Cluster Quality Group 
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Global VOIP
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Cluster Utilization Detail Chart

Description

Detail chart showing cluster utilization based on information collected through CDRs and CMRs. 

Reporter Set

Cluster

Tables and Charts

Charts: Resource Time Series Chart (7 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Erlang

Cluster Total Hours of Traffic

Cluster Total Number of Company Calls (Nb)

ClusterNbPacketsLost

ClusterNbPacketsReceived

ClusterNbPacketsSent

ClusterSuccessfulCall

ClusterTollBypassCall

ClusterTotalCall

ClusterUnsuccessfulCall 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Cluster Utilization MLH Resource 

Cluster Utilization Resource 

Top 10 Cluster Number of Calls
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 43



Chapter 2:  Supported Reports
Cluster Utilization Group

Description

Group summary chart showing cluster utilization based on information collected through CDRs and CMRs. 

Reporter Set

Cluster

Tables and Charts

Tables: Group Summary Table (1 of 2 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Erlang

Cluster Percentage of Company Calls (percent)

Cluster Percentage of TollBypass Calls (percent)

Cluster Total Hours of Traffic

ClusterIntersiteIPCall

ClusterNbPacketsReceived

ClusterNbPacketsSent

ClusterTotalCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters

Drills Down To

Cluster Utilization Resource 

Drilled Down From

None.
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Cluster Utilization MLH Resource

Description

Resource summary report showing cluster utilization based on multi-line hunt (MLH) metrics. 

Reporter Set

Cluster

Tables and Charts

No table and chart information is available for this report (stylesheet PVLsRatio_MLH_RST.html). 

Metrics Used in Report 

Cluster Total Hours of Traffic

Cluster Total Number of Company Calls (Nb)

ClusterNbPacketsLost

ClusterNbPacketsReceived

ClusterNbPacketsSent

ClusterSuccessfulCall

ClusterTollBypassCall

ClusterTotalCall

ClusterUnsuccessfulCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(CDRclusterId)

Drills Down To

Cluster Utilization Detail Chart 

Drilled Down From

None.
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Cluster Utilization Resource

Description

Resource summary chart showing cluster utilization based on information collected through CDRs and CMRs. 

Reporter Set

Cluster

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Erlang

Cluster Total Hours of Traffic

Cluster Total Number of Company Calls (Nb)

Cluster Total Number of External Calls (Nb)

Cluster Total Number of Outgoing External Calls (Nb)

ClusterNbPacketsReceived

ClusterNbPacketsSent

ClusterTollBypassCall

ClusterTotalCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(CDRclusterId)

Drills Down To

Cluster Utilization Detail Chart 

Drilled Down From

CDR Utilization Group 

Cluster Utilization Group 

Global VOIP
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Cluster VoiceMail Usage Detail Chart

Description

Detail chart showing cluster voicemail utilization based on information collected through CDRs and CMRs. 

Reporter Set

Cluster

Tables and Charts

Charts: Resource Time Series Chart (5 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Cluster Number of Direct VoiceMail Calls (Nb)

ClusterForwardToVoiceMail

ClusterTotalCall

ClusterVoicemailCallDuration

ClusterVoiceMailCall

ClusterVoicemailPackets 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Cluster VoiceMail Usage Resource
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Cluster VoiceMail Usage Resource

Description

Resource summary chart showing cluster voicemail utilization based on information collected through CDRs and 
CMRs. 

Reporter Set

Cluster

Tables and Charts

Tables: ResSummary (1 implemented) 

Charts: Ratio (1 implemented) 

Metrics Used in Report 

Cluster Number of Direct VoiceMail Calls (Nb)

ClusterForwardToVoiceMail

ClusterVoicemailCallDuration

ClusterVoiceMailCall

ClusterVoicemailPackets 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(CDRclusterId)

Drills Down To

Cluster VoiceMail Usage Detail Chart 

Drilled Down From

None.
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Errors on Cluster by Codec

Description

Resource summary report for codec errors in a cluster. 

Reporter Set

Codec

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

CauseCallRejected

CauseChannelUnacceptable

CauseDestinationOutOfOrder

CauseInvalidNumberFormat

CauseMisdialedTrunkPrefix

CauseNetworkOutOfOrder

CauseNoAnswerFromUser

CauseNoChannelAvailable

CauseNoRouteToDestination

CauseNoRouteTransitNetwork

CauseNoUserResponding

CauseNumberChanged

CauseOther

CauseResourceUnavailable

CauseSubscriberAbsent

CauseSwitchCongestion

CauseTemporaryFailure

CauseUnassignedNumber

CauseUserBusy 

Navigation Path

Navigation path on the DataView portal:
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Cluster > %(CDRclusterId)

Drills Down To

CDR Quality Detail Chart 

Drilled Down From

None.
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Gatekeeper Availability Resource Detail Chart

Description

Detail chart based on gatekeeper device reachability and response time. 

Reporter Set

Device

Tables and Charts

Charts: Resource Time Series Chart (4 of 8 implemented) 
Metric Ratio Chart (1 of 2 implemented) 

Metrics Used in Report 

Gatekeeper ICMP Inbound Errors (percent)

Gatekeeper ICMP Outbound Errors (percent)

SNMP Availability (percent) (avg last hour)

SNMP Availability (percent) (avg last hour)

SNMP Response Time (ms) (avg last hour)

SNMP Unavailable (percent) (avg last hour) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Gatekeeper > Device

Drills Down To

None. 

Drilled Down From

Gatekeeper Availability Resource
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Gatekeeper Availability Resource

Description

Resource summary chart based on gatekeeper device reachability and response time. 

Reporter Set

Device

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

Gatekeeper ICMP Inbound Errors (percent)

Gatekeeper ICMP Outbound Errors (percent)

SNMP Availability (percent) (avg last hour)

SNMP Response Time (ms) (avg last hour)

SNMP Response Time (ms) (avg last hour) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Gatekeeper > Device

Drills Down To

Gatekeeper Availability Resource Detail Chart 

Drilled Down From

None.
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Gatekeeper Device Quality Resource Detail Chart

Description

Detail chart based on gatekeeper device CPU utilization and network errors. 

Reporter Set

Device

Tables and Charts

Charts: Resource Time Series Chart (6 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Gatekeeper Buffer Utilization (percent)

Gatekeeper Call Setup Quality (percent)

Gatekeeper CPU Utilization (percent) (avg last 5 mn)

Gatekeeper Packet Errors (Nb)

Gatekeeper Total Number of Admission Rejects (Nb)

Gatekeeper Total Number of Admission Requests (Nb)

Gatekeeper Total Number of Concurrent Calls (Nb) (Gauge)

Gatekeeper Total Number of Location Rejects (Nb)

Gatekeeper Total Number of Location Requests (Nb)

Gatekeeper Total Packets (Nb) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Gatekeeper > Device

Drills Down To

None. 

Drilled Down From

Gatekeeper Device Quality Resource
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Gatekeeper Device Quality Resource

Description

Resource summary chart based on gatekeeper device CPU utilization and network errors. 

Reporter Set

Device

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

Gatekeeper Call Setup Quality (percent)

Gatekeeper CPU Utilization (percent) (avg last 5 mn)

Gatekeeper Packet Errors (Nb)

Gatekeeper Total Number of Concurrent Calls (Nb) (Gauge)

Gatekeeper Total Number of Registered EndPoints (Nb)

Gatekeeper Total Packets (Nb) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Gatekeeper > Device

Drills Down To

Gatekeeper Device Quality Resource Detail Chart 

Drilled Down From

None.
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Gatekeeper Interface Availability Resource Detail Chart

Description

Detail chart showing gatekeeper’s interface availability percentage. 

Reporter Set

Interface

Tables and Charts

Charts: Resource Time Series Chart (2 of 8 implemented) 
Metric Ratio Chart (1 of 2 implemented) 

Metrics Used in Report 

Interface Availability (percent)

Interface Packet Loss (percent) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Gatekeeper > Interface

Drills Down To

None. 

Drilled Down From

Gatekeeper Interface Availability Resource
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Gatekeeper Interface Availability Resource

Description

Resource summary chart showing gatekeeper’s interface availability percentage. 

Reporter Set

Interface

Tables and Charts

Tables: ResSummary (1 implemented) 

Metrics Used in Report 

Inbound Loss (percent)

Interface Availability (percent)

Outbound Loss (percent) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Gatekeeper > Interface

Drills Down To

Gatekeeper Interface Availability Resource Detail Chart 

Drilled Down From

None.
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Gatekeeper Interface Utilization Resource Detail Chart

Description

Detail chart showing gatekeeper’s interface bandwidth utilization percentage. 

Reporter Set

Interface

Tables and Charts

Charts: Resource Time Series Chart (4 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Interface Bandwidth Utilization In (percent)

Interface Bandwidth Utilization Out (percent)

Interface Throughput In (kbps)

Interface Throughput Out (kbps) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Gatekeeper > Interface

Drills Down To

None. 

Drilled Down From

Gatekeeper Interface Utilization Resource
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Gatekeeper Interface Utilization Resource

Description

Resource summary chart showing gatekeeper’s interface bandwidth utilization percentage. 

Reporter Set

Interface

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

Interface Bandwidth Utilization In (percent)

Interface Bandwidth Utilization Out (percent)

Interface Throughput In (kbps)

Interface Throughput Out (kbps) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Gatekeeper > Interface

Drills Down To

Gatekeeper Interface Utilization Resource Detail Chart 

Drilled Down From

None.
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Global VOIP

Description

A multi-technologies report that targets the customerís decision maker. In a single view, the decision maker will 
have a global overview about the quality of the IP Telephony application in terms of call setup and termination, 
voice quality, network infrastructure, and system and service performances. 

Reporter Set

Global Customer Reports

Tables and Charts

No table and chart information is available for this report (stylesheet PVLs_Cisco_VOIP_Global.html). 

Metrics Used in Report 

CCM CPU Utilization (percent) (avg last 5 mn)

Cluster Percentage of Packet Lost (percent)

Cluster Total Number of Normal Call Clearing

ClusterDropCall

ClusterJitter

ClusterOffNetCall

ClusterOnNetCall

ClusterSuccessfulCall

ClusterUnsuccessfulCall

Interface Bandwidth Utilization Out (percent)

PSTN Gateway Active DS0 Channels (Nb) (Gauge)

PSTN Gateway Active DS0 Channels (Nb)

PSTN Gateway Network Errors (percent) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Global Customer View

Drills Down To

CCM Server Quality Resource 

Cluster Quality Resource 
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Cluster Utilization Resource 

PSTN Gateway Device Quality Resource Detail Chart 

Top 10 E1/T1 Utilization Resource 

Drilled Down From

None.
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K-Factor Detail Chart

Description

Detail report on listening quality using ITU-standard K-Factor metrics. 

Reporter Set

K-Factor

Tables and Charts

Charts: Resource Time Series Chart (5 of 8 implemented) 
Metric Ratio Chart (0 of 2 implemented) 

Metrics Used in Report 

CCR

CS

ICR

ICRmx

SCS 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

K-Factor Resource 

Top 10 CDR K-Factor
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K-Factor Group

Description

Group summary report on listening quality using ITU-standard K-Factor metrics. 

Reporter Set

K-Factor

Tables and Charts

Tables: Group Summary Table (2 of 2 implemented) 

Charts: Resource Distribution Chart (1 of 2 implemented) 

Metrics Used in Report 

CCR

CS

ICR

ICRmx

MLQKav

MLQK

MLQKmn

SCS 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Customer

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Cluster

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site

Drills Down To

CDR Quality Resource 

K-Factor Resource 
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Drilled Down From

None.
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K-Factor Resource

Description

Resource summary report on listening quality using ITU-standard K-Factor metrics. 

Reporter Set

K-Factor

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

CCR

CS

ICR

ICRmx

MLQKav

MLQK

MLQKmn

SCS 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Customer > 
%(CDRcustomerId)
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)

Drills Down To

CDR Quality Detail Chart 

K-Factor Detail Chart 

Drilled Down From

K-Factor Group
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Media Device Group

Description

Group summary chart showing the media device’s registration availability percentage. 

Reporter Set

Media Devices

Tables and Charts

Tables: Group Summary Table (1 of 2 implemented) 

Charts: Resource Distribution Chart (1 of 2 implemented) 

Metrics Used in Report 

CCM Media Device Registration Availability (percent) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Media Device

Drills Down To

Media Device Resource 

Drilled Down From

None.
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Media Device Resource Detail Chart

Description

Detail chart showing the media device’s registration availability percentage. 

Reporter Set

Media Devices

Tables and Charts

Charts: Resource Time Series Chart (1 of 8 implemented) 
Metric Ratio Chart (0 of 2 implemented) 

Metrics Used in Report 

CCM Media Device Registration Availability (percent) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Media Device Resource
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Media Device Resource

Description

Resource summary chart showing the media device’s registration availability percentage. 

Reporter Set

Media Devices

Tables and Charts

Tables: ResSummary (1 implemented) 

Charts: ResDistrib (1 implemented) 

Metrics Used in Report 

CCM Media Device Registration Availability (percent) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > Media Device > %(VoIPCallMgrClusterId)

Drills Down To

Media Device Resource Detail Chart 

Drilled Down From

Media Device Group
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Perfmon Active Calls Detail Chart

Description

Detail report for Microsoft performance counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Charts: Resource Time Series Chart (9 of 9 implemented) 

Metrics Used in Report 

CallsActive

CallsInProgress

GatewayCallsActive

H323CallsActive

H323CallsInProgress

HuntlistCallsActive

HuntlistCallsInProgress

SIPCallsActive

SIPCallsInProgress 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Perfmon Active Calls Resource 

Perfmon Security Resource
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 69



Chapter 2:  Supported Reports
Perfmon Active Calls Group

Description

Group summary report for Microsoft performance counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Tables: Group Summary Table (2 of 2 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

CallsActive

CallsInProgress

GatewayCallsActive

H323CallsActive

H323CallsInProgress

HuntlistCallsActive

HuntlistCallsInProgress

SIPCallsActive

SIPCallsInProgress 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site

Drills Down To

CDR Quality Resource 

Perfmon Active Calls Resource 

Drilled Down From

None.
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Perfmon Active Calls Resource

Description

Resource summary report for Microsoft performance counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Tables: Resource Summary Table (2 of 1 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

CallsActive

CallsInProgress

GatewayCallsActive

H323CallsActive

H323CallsInProgress

HuntlistCallsActive

HuntlistCallsInProgress

SIPCallsActive

SIPCallsInProgress 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site > %(CDRsiteId)

Drills Down To

CDR Quality Detail Chart 

Perfmon Active Calls Detail Chart 
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Drilled Down From

Perfmon Active Calls Group 

Perfmon MOH Group 

Perfmon PSTN Group 

Perfmon Security Group
72 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 2:  Supported Reports
Perfmon MOH Detail Chart

Description

Detail report for Perfmon Music on Hold (MOH) counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Charts: Resource Time Series Chart (6 of 9 implemented) 

Metrics Used in Report 

MOHMulticastResourceActive

MOHMulticastResourceAvailable

MOHTotalMulticastResources

MOHTotalUnicastResources

MOHUnicastResourceActive

MOHUnicastResourceAvailable 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Perfmon MOH Resource 
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Perfmon MOH Group

Description

Group summary report for Perfmon Music on Hold (MOH) counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Tables: Group Summary Table (1 of 2 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

MOHMulticastResourceActive

MOHMulticastResourceAvailable

MOHTotalMulticastResources

MOHTotalUnicastResources

MOHUnicastResourceActive

MOHUnicastResourceAvailable 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site

Drills Down To

CDR Quality Resource 

Perfmon Active Calls Resource 

Perfmon MOH Resource 

Drilled Down From

None.
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Perfmon MOH Resource

Description

Resource summary report for Perfmon Music on Hold (MOH) counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

MOHMulticastResourceActive

MOHMulticastResourceAvailable

MOHTotalMulticastResources

MOHTotalUnicastResources

MOHUnicastResourceActive

MOHUnicastResourceAvailable 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site > %(CDRsiteId)

Drills Down To

CDR Quality Detail Chart 

Perfmon MOH Detail Chart 

Drilled Down From

Perfmon MOH Group
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Perfmon PSTN Detail Chart

Description

Detail report for Perfmon PSTN counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Charts: Resource Time Series Chart (8 of 9 implemented) 

Metrics Used in Report 

BRIChannelsActive

BRISpansInService

FXOPortsActive

FXOPortsInService

FXSPortsActive

FXSPortsInService

T1ChannelsActive

T1SpansInService 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Perfmon PSTN Resource
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Perfmon PSTN Group

Description

Group summary report for Perfmon PSTN counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Tables: Group Summary Table (2 of 2 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

BRIChannelsActive

BRISpansInService

FXOPortsActive

FXOPortsInService

FXSPortsActive

FXSPortsInService

T1ChannelsActive

T1SpansInService 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site

Drills Down To

CDR Quality Resource 

Perfmon Active Calls Resource 

Perfmon PSTN Resource 

Drilled Down From

None.
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Perfmon PSTN Resource

Description

Resource summary report for Perfmon PSTN counter metrics. 

Reporter Set

Perfmon

Tables and Charts

Tables: Resource Summary Table (2 of 1 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

AttendantConsoleClientsRegistered

BRIChannelsActive

BRISpansInService

FXOPortsActive

FXOPortsInService

FXSPortsActive

FXSPortsInService

T1ChannelsActive

T1SpansInService 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site > %(CDRsiteId)

Drills Down To

CDR Quality Detail Chart 

Perfmon PSTN Detail Chart 
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Drilled Down From

Perfmon PSTN Group
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Perfmon Security Detail Chart

Description

Detail chart for Perfmon counter metrics on active calls. 

Reporter Set

Perfmon

Tables and Charts

Charts: Resource Time Series Chart (9 of 9 implemented) 

Metrics Used in Report 

AttendantConsoleClientsOnline

AttendantConsoleClientsRegistered

AuthenticatedCallsActive

AuthenticatedPartiallyRegisteredPhone

AuthenticatedRegisteredPhones

CallsActive

EncryptedCallsActive

EncryptedPartiallyRegisteredPhones

EncryptedRegisteredPhones 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Perfmon Security Resource
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Perfmon Security Group

Description

Group summary report for Perfmon security metrics. 

Reporter Set

Perfmon

Tables and Charts

Tables: Group Summary Table (2 of 2 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

AttendantConsoleClientsOnline

AttendantConsoleClientsRegistered

AuthenticatedCallsActive

AuthenticatedPartiallyRegisteredPhone

AuthenticatedRegisteredPhones

CallsActive

EncryptedCallsActive

EncryptedPartiallyRegisteredPhones

EncryptedRegisteredPhones 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster

Drills Down To

CDR Quality Resource 

Perfmon Active Calls Resource 

Perfmon Security Resource 

Drilled Down From

None.
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Perfmon Security Resource

Description

Resource summary report for Perfmon security metrics. 

Reporter Set

Perfmon

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (0 of 2 implemented) 

Metrics Used in Report 

AttendantConsoleClientsOnline

AttendantConsoleClientsRegistered

AuthenticatedCallsActive

AuthenticatedPartiallyRegisteredPhone

AuthenticatedRegisteredPhones

CallsActive

EncryptedCallsActive

EncryptedPartiallyRegisteredPhones

EncryptedRegisteredPhones 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > Infrastructure > CCM Server > Perfmon > By Site > %(CDRsiteId)

Drills Down To

CDR Quality Detail Chart 

Perfmon Active Calls Detail Chart 

Perfmon Security Detail Chart 
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Drilled Down From

Perfmon Security Group
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PSTN Gateway Availability Resource Detail Chart

Description

Detail chart based on PSTN gateway errors and availability on the network. 

Reporter Set

Device

Tables and Charts

Charts: Resource Time Series Chart (4 of 8 implemented) 
Metric Ratio Chart (0 of 2 implemented) 

Metrics Used in Report 

PSTN Gateway ICMP Inbound Errors (percent)

PSTN Gateway ICMP Outbound Errors (percent)

SNMP Availability (percent) (avg last hour)

SNMP Response Time (ms) (avg last hour) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

PSTN Gateway Availability Resource
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PSTN Gateway Availability Resource

Description

Resource summary chart based on PSTN gateway errors and availability on the network. 

Reporter Set

Device

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

PSTN Gateway ICMP Inbound Errors (percent)

PSTN Gateway ICMP Outbound Errors (percent)

SNMP Availability (percent) (avg last hour)

SNMP Response Time (ms) (avg last hour) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Device > All

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Device > By Type

Drills Down To

PSTN Gateway Availability Resource Detail Chart 

Drilled Down From

None.
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PSTN Gateway Device DS0 Usage Detail Chart

Description

Detail chart showing PSTN gateway DS0 usage and quality. 

Reporter Set

Device

Tables and Charts

Charts: Resource Time Series Chart (6 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

PSTN Gateway Active DS0 Channels (Nb)

PSTN Gateway Call Setup Quality (percent) (Successful / Total)

PSTN Gateway Total Number of Calls (Nb)

PSTN Gateway Total Number of Calls per mn (Calls/mn)

PSTN Gateway Total Number of Successful Calls (Nb)

PSTN Gateway Total Number of Unsuccessful Calls (Nb) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

None.
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PSTN Gateway Device Quality Resource Detail Chart

Description

Detail chart showing PSTN gateway CPU utilization, number of packets, and errors. 

Reporter Set

Device

Tables and Charts

Charts: Resource Time Series Chart (6 of 8 implemented) 
Metric Ratio Chart (0 of 2 implemented) 

Metrics Used in Report 

PSTN Gateway Active DS0 Channels (Nb)

PSTN Gateway ICMP Inbound Errors (percent)

PSTN Gateway ICMP Outbound Errors (percent)

PSTN Gateway Packet Discards

PSTN Gateway Total Packets per Second

SNMP Response Time (ms) (avg last hour) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

Global VOIP 

PSTN Gateway Device Quality Resource
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 87



Chapter 2:  Supported Reports
PSTN Gateway Device Quality Resource

Description

Resource summary chart showing PSTN gateway CPU utilization, number of packets, and errors. 

Reporter Set

Device

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

PSTN Gateway Active DS0 Channels (Nb)

PSTN Gateway Network Errors (percent)

PSTN Gateway Packet Discards

PSTN Gateway Total Packets per Second

SNMP Response Time (ms) (avg last hour) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Device > All

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Device > By Type

Drills Down To

PSTN Gateway Device Quality Resource Detail Chart 

Drilled Down From

None.
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PSTN Gateway DSP Card Resource Detail Chart

Description

Detail chart showing DSP card utlization percentage. 

Reporter Set

DSP Card

Tables and Charts

Charts: Resource Time Series Chart (2 of 8 implemented) 
Metric Ratio Chart (0 of 2 implemented) 

Metrics Used in Report 

DSP Card Availability (percent)

DSP Card Resource Utilization (percent) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

PSTN Gateway DSP Card Resource
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PSTN Gateway DSP Card Resource

Description

Resource summary chart showing DSP card utlization percentage. 

Reporter Set

DSP Card

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

DSP Card Availability (percent)

DSP Card Resource Utilization (percent) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > DSP Card > All

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > DSP Card > ByGateway: 
%(Element.NAME)

Drills Down To

PSTN Gateway DSP Card Resource Detail Chart 

Drilled Down From

None.
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PSTN Gateway E1/T1 Availability Resource Detail Chart

Description

Detail chart showing E1 or T1 interface availability. 

Reporter Set

Interface

Tables and Charts

Charts: Resource Time Series Chart (2 of 8 implemented) 
Metric Ratio Chart (0 of 2 implemented) 

Metrics Used in Report 

Interface Availability (percent)

Interface Packet Loss (percent) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

PSTN Gateway E1/T1Availability Resource
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PSTN Gateway E1/T1 Interface Utilization Resource Detail Chart

Description

Detail chart showing E1 or T1 interface utilization percentage. 

Reporter Set

Interface

Tables and Charts

Charts: Resource Time Series Chart (5 of 8 implemented) 
Metric Ratio Chart (2 of 2 implemented) 

Metrics Used in Report 

Interface Bandwidth Utilization In (percent)

Interface Bandwidth Utilization Out (percent)

Interface Throughput In (kbps)

Interface Throughput Out (kbps)

PSTN Gateway DS1 Active DS0 Channels (Nb) 

Navigation Path

This report is not deployed on the portal navigation path during the initial configuration of the technology pack. 
To display this report, drill down to it from another report or deploy it with the DataMart Resource Editor.

Drills Down To

None. 

Drilled Down From

PSTN Gateway E1/T1 Interface Utilization Resource 

Top 10 E1/T1 Utilization Resource
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PSTN Gateway E1/T1 Interface Utilization Resource

Description

Resource summary chart showing E1 or T1 interface utilization percentage. 

Reporter Set

Interface

Tables and Charts

Tables: Resource Summary Table (1 of 1 implemented) 

Charts: Resource Distribution Chart (2 of 2 implemented) 

Metrics Used in Report 

Interface Bandwidth Utilization In (percent)

Interface Bandwidth Utilization Out (percent)

Interface Throughput In (kbps)

Interface Throughput Out (kbps)

PSTN Gateway DS1 Active DS0 Channels (Nb) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Interface > All

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Interface > By Gateway

Drills Down To

PSTN Gateway E1/T1 Interface Utilization Resource Detail Chart 

Drilled Down From

Top 10 E1/T1 Utilization Resource
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PSTN Gateway E1/T1Availability Resource

Description

Resource summary chart showing E1 or T1 interface availability. 

Reporter Set

Interface

Tables and Charts

Tables: ResSummary (1 implemented) 

Charts: ResDistrib (1 implemented) 

Metrics Used in Report 

Interface Availability (percent)

Interface Packet Loss (percent) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Interface > All

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Interface > By Gateway

Drills Down To

CDR Utilization Resource 

PSTN Gateway E1/T1 Availability Resource Detail Chart 

Drilled Down From

None.
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Top 10 CDR Call Completion

Description

Top 10 and bottom 10 extensions, gateways, or paths based on successful or unsuccessful calls. 

Reporter Set

Extension

Tables and Charts

Tables: TopN (3 of 9 implemented) 

Charts: TopN (3 of 9 implemented) 

Metrics Used in Report 

Percentage of Drop Calls (percent) CME(Bulk) VOIP Cisco

Percentage of Successful Calls (Nb) CME(Bulk) VOIP Cisco 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(CDRcustomerId)
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > 
%(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > 
%(CDRcustomerId)

Drills Down To

CDR Quality Detail Chart 

Drilled Down From

None.
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Top 10 CDR Call Duration

Description

Top 10 extensions, gateways, or paths based on total call duration. 

Reporter Set

Extension

Tables and Charts

Tables: TopN (2 of 9 implemented) 

Charts: TopN (2 of 9 implemented) 

Metrics Used in Report 

CallDuration

TollbypassCallDuration 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(CDRcustomerId)
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > 
%(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > 
%(CDRcustomerId)

Drills Down To

CDR Utilization Detail Chart 

Drilled Down From

None.
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Top 10 CDR K-Factor

Description

Top-10 CDR data using IDU-standard K-factor metrics. 

Reporter Set

K-Factor

Tables and Charts

Tables: TopN (5 of 9 implemented) 

Charts: TopN (5 of 9 implemented) 

Metrics Used in Report 

CCR

CS

ICR

MLQK

SCS 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Codec > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)
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Drills Down To

K-Factor Detail Chart 

Drilled Down From

None.
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Top 10 CDR Number of Calls

Description

Top 10 extensions, gateways, or paths based on total number of incoming or outgoing calls to PSTN. 

Reporter Set

Extension

Tables and Charts

Tables: TopN (4 of 9 implemented) 

Charts: TopN (4 of 9 implemented) 

Metrics Used in Report 

Incoming

TollBypassCall

Total Number of Calls (Nb) CME(Bulk) VOIP Cisco

Total Number of Outgoing External Calls (Nb) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)
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NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > 
%(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > 
%(CDRcustomerId)

Drills Down To

CDR Utilization Detail Chart 

Drilled Down From

None.
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Top 10 CDR Number of Errors

Description

Top 10 extensions, gateways, or paths based on total number of errors. 

Reporter Set

Extension

Tables and Charts

Tables: TopN (4 of 9 implemented) 

Charts: TopN (4 of 9 implemented) 

Metrics Used in Report 

Percentage of Drop Calls (percent) CME(Bulk) VOIP Cisco

Percentage of Packet Lost (percent) CME(Bulk) VOIP Cisco

Percentage of Successful Calls (Nb) CME(Bulk) VOIP Cisco

ShortCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > %(siteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(clusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > %(customerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Extensions > By Site > %(CDRsiteId)
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 103



Chapter 2:  Supported Reports
NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Cluster > 
%(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Customer > 
%(CDRcustomerId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Media Gateways > By Site > 
%(CDRsiteId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Cluster > %(CDRclusterId)

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Paths > By Customer > 
%(CDRcustomerId)

Drills Down To

CDR Quality Detail Chart 

Drilled Down From

None.
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Top 10 Cluster Call Completion

Description

Top 10 and bottom 10 clusters based on the percentage of successful calls. 

Reporter Set

Cluster

Tables and Charts

Tables: TopN (4 of 9 implemented) 

Charts: TopN (4 of 9 implemented) 

Metrics Used in Report 

Cluster Percentage of Drop Calls (percent)

Cluster Percentage of Normal Call Clearing (percent)

Cluster Percentage of Successful Calls (percent) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters

Drills Down To

Cluster Quality Detail Chart 

Drilled Down From

None.
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Top 10 Cluster Number of Calls

Description

Top 10 clusters based on number of incoming and outgoing calls. 

Reporter Set

Cluster

Tables and Charts

Tables: TopN (5 of 9 implemented) 

Charts: TopN (5 of 9 implemented) 

Metrics Used in Report 

Cluster Total Number of Outgoing External Calls (Nb)

ClusterIncomingCall

ClusterOffNetCall

ClusterOnNetCall

ClusterTotalCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters

Drills Down To

Cluster Utilization Detail Chart 

Drilled Down From

None.
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Top 10 Cluster Number of Errors

Description

Top 10 cluster based on number of errors. 

Reporter Set

Cluster

Tables and Charts

Tables: TopN (4 of 9 implemented) 

Charts: TopN (4 of 9 implemented) 

Metrics Used in Report 

Cluster Percentage of Drop Calls (percent)

Cluster Percentage of Packet Lost (percent)

Cluster Percentage of Successful Calls (percent)

ClusterShortCall 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > IP Telephony Call Detail Record > Clusters

Drills Down To

Cluster Quality Detail Chart 

Drilled Down From

None.
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Top 10 E1/T1 Utilization Resource

Description

Top 10 E1 or T1 interfaces based on bandwidth utilization percentage. 

Reporter Set

Interface

Tables and Charts

Tables: TopN (5 of 9 implemented) 

Charts: TopN (5 of 9 implemented) 

Metrics Used in Report 

Interface Bandwidth Utilization In (percent)

Interface Bandwidth Utilization Out (percent)

Interface Throughput In (kbps)

Interface Throughput Out (kbps)

PSTN Gateway DS1 Active DS0 Channels (Nb) 

Navigation Path

Navigation path on the DataView portal:

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Interface > All

NOC Reporting > VOIP > Cisco > Infrastructure > PSTN Gateway > Interface > By Gateway

Drills Down To

PSTN Gateway E1/T1 Interface Utilization Resource 

PSTN Gateway E1/T1 Interface Utilization Resource Detail Chart 

Drilled Down From

Global VOIP
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Chapter 3:  Devices and Services 

This chapter discusses the following topics: 

Overview 

This chapter provides a summary of Cisco IP Telephony device technology that the Cisco IP Telephony 
Technology Pack is designed to support.

Note:  This technology pack supports the Cisco CallManager (CCM) environment and its new implementation, 
the Cisco Unified Call Manager (CUCM) environment. Where this guide refers to Cisco CallManager or CCM, 
it also applies to Cisco Unified Call Manager (CUCM), unless an explicit distinction is made.

Summary of Device Technology 

The Netcool/Proviso Cisco IP Telephony Technology Pack collects and reports performance metrics in an 
Architecture for Voice, Video and Integrated Data (AVVID) environment where Cisco CallManager (CCM) 
IP-PBXs are deployed.

The technology pack manages the IP telephony application by focusing on an end-to-end voice path. It uses 
advanced data consolidation, with data coming from the end user (the phone extension itself), as well as data 
coming from network infrastructure devices.

Topic Page 

Overview 111

Summary of Device Technology 111 

Sources of Collected Data 113

Pre-Requisites 116

Supported MIBs 117
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Categories of Service Reporting

The technology pack provides the following categories of service reporting:

• Voice Quality Management — Latency, jitter, packet loss, network bandwidth, Class Based QoS, and 
element availability.

• Call Signaling Management — Call setup and termination metrics, based on data from Call Detail Records 
(CDRs).

• Converged Network Infrastructure Management — Network and system devices in charge of the 
Service and Voice Data Packets Delivery.

Services and Devices Monitored

The Netcool/Proviso Cisco IP Telephony Technology Pack creates automatic, on demand, historical, and real-
time reports showing performance and trend analysis for the following services and devices:

• Voice Quality — Jitter, latency, packet drops, mean opinion score, per cluster, per location, per business 
department, and even for each extension number.

• CallManager System & Application — Server availability, performance, CPU load, memory, service 
availability, disk usage, and registered devices.

• PSTN Gateway Devices — Catalyst6500, Cisco AS5x00 series, Cisco 2600 & 3600 series, E1 & T1 Serial 
Links, DS0 Channel availability and utilization, DSP availability and utilization, capacity planning, bandwidth, 
errors. Also, total number of calls per gateway, total duration per gateway.

• Gatekeeper Devices — Number of successful / unsuccessful requests (routing, location, admission), 
registered endpoints, errors.

• Telephony Usage — Total number of calls, total duration of calls, total number of packets, per location, per 
business department, per extension number, top10 clusters (or sites, offices, extensions, departments). 
Number of outbound and inbound calls. Total accumulated hours of traffic per hour, day, week, month.

• Call Completion — Percentage of outgoing and incoming successful/unsuccessful calls, what are the main 
errors (phones, LAN, WAN, PSTN network, congestions, no resource available).

• Call Distribution — On-net vs. off-net ratio (number of IP routed calls vs. calls routed toward PSTN), 
number of internal (private extension to private extension) calls, local calls, long distance calls, international 
calls. Capability to provide statistics on number of calls to mobile networks (supported in some countries 
only).

• Site to Site Path Analysis — End-to-end measurement between customer offices. Voice quality, call 
distribution, call completion, IP telephony usage, TopN sites for errors, number of calls, duration and voice 
quality.
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Sources of Collected Data

The Netcool/Proviso Cisco IP Telephony Technology Pack uses both SNMP and bulk data collection. The 
technology pack collects performance data from the following sources:

CDR and CMR data is collected in Cisco CallManager (CCM) environments and Cisco Unified Call Manager 
(CUCM) environments. The technology pack accesses CDR and CMR data differently in each environment. 

The following sections provide an overview of how the technology pack accesses CDR and CMR data in these 
different environments. A basic understanding of the different access methods will help you when you configure 
the technology pack.

Collecting CDR and CMR Data with Cisco CallManager

With Cisco CallManager (CCM), the technology pack collects CDR and CMR data through SQL requests to the 
CallManager Publisher SQL database.

Source of Collected Data Collection Type

PSTN gateway, media gateway SNMP

Gatekeeper SNMP

Cisco CallManager Server

Each server in the cluster has an SNMP agent

SNMP

Call Detail Records (CDR)

Accounting data

Bulk

Call Maintenance Records (CMR)

Voice quality data

Bulk

Microsoft performance counter metrics 
(Perfmon)

Bulk
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The following figure illustrates the technology pack’s data collection architecture in a CCM environment:

Port for SQL Access

CallManager Publisher runs on an MS-SQL2000 server. To collect SQL data from the CallManager Publisher, an 
SQL bridge must be set up on the machine where Netcool/Proviso DataLoad resides. This bridge is provided as 
part of the Netcool/Proviso Cisco IP Telephony Technology Pack.

The connection between the Data Direct SQL server bridge and the MS-SQL2000 server is made through TCP 
port number 1433 or 1370, according to the Cisco CallManager Publisher configuration.

Troubleshooting Note for SQL Requests

If you have problems issuing SQL queries to the Cisco CallManager (CCM) Publisher, check the following:

• Ensure that tempdb has been set to an adequate size (at least 100Mb) in order to correctly receive the SQL 
result set, as recommended in the Cisco CallManager Installation Guide.

• Check the log file (proviso.log by default) for any SQL error messages. By default, the log file is in 
$DC_HOME/log — for example, /opt/datachannel/log.
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• With pre-4.4.3 Netcool/Proviso versions, ensure that the dc.cfg file contains a URI for each CCM 
Publisher bulk adaptor, and that the URI matches the URI of the associated data source in the odbc.ini 
file.

Collecting CDR, CMR, and Perfmon Data with Cisco Unified Call Manager

With Cisco Unified CallManager (CUCM), the technology pack collects CDR, CMR, and Perfmon data files in 
either of the following ways:

• Through SOAP requests to the CUCM server and PerfmonPorts API. 

• Through a schedule for pushing the data files back to the DataChannel server. The schedule is specified by 
CUCM Web administration configuration settings.

In both cases, the CUCM pushes the data back to the technology pack via FTP.

The technology pack includes a Java application called ProvisoCUCM. This application is responsible for sending 
the SOAP requests to the CUCM, and for producing the CSV files for the UBA from the data files pushed back 
to the DataChannel server by the CUCM server. 

The ProvisoCUCM finds the address of the CUCM server, authentication information, and other configuration 
details in the file cucm.properties. You install and edit this file when you configure the technology pack, as 
described in the section Configure the Technology Pack on page 440

The following figure illustrates the technology pack’s data collection architecture in a CUCM environment:
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Pre-Requisites

This section describes the pre-requisites for the Netcool/Proviso Cisco IP Telephony Technology Pack.

SNMP Access

The Netcool/Proviso Cisco IP Telephony Technology Pack needs read access to SNMP agents of PSTN gateway, 
gatekeeper, and CallManager Server devices. Customers must provide a valid IP address and community name to 
access these devices.

UDP Port number 161 needs to be open in the remote firewalls.

CallManager servers, as well as Unity servers and other Cisco media servers running under the Microsoft 2000 
environment, can be configured with the following standard SNMP Extensions:

• HOST-MIB

• PERFMON-MIB (optional – perfmon counters)

• SQL-MIB (optional – SQL Server and Database metrics)

• EXCHANGE-MIB (optional – MS Exchange metrics)

• DHCP-MIB (optional – Dhcp server metrics)

• HTTP-MIB (optional – Http server metrics)

Cisco CallManager Configuration

To enable CDR and CMR collection from CCM and CUCM environments, some configuration parameters must 
be set using the CCM System Administrator. Configuration settings must be defined separately on every server 
in a cluster.

The following configuration service parameters control the generation of CDR records: 

• cdrEnabled — Determines whether CDR records are generated. Default value: false.

• CdrLogCallsWithZeroDurationFlag — Enables logging of CDR records for calls that were never 
connected, or which lasted less than one second. This parameter must be enabled to allow data to be 
collected on short connections.

• CallDiagnosticsEnabled — Determines whether CMR records are generated. Only IP phones and MGCP 
gateways support CMR records. Default value: false.

• MaxCdrRecords — Controls the maximum number of CDRs on the system. When this limit is exceeded, 
the oldest CDRs are automatically removed once a day, along with the related CMR records. Default value: 
1.5 million records.

The Netcool/Proviso Cisco IP Telephony Technology Pack never deletes records. IBM recommends 
retrieving CDRs every hour or every four hours. This polling interval permits the system administrator to 
decrease the maximum number of CDRs on the CallManager and to improve performance.
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In addition, the following enterprise parameters must be set: 

• LocalCDRPath — A directory for local CDR files written by Cisco CallManager. If this value is empty or 
invalid, the CDR files will not be moved.

• PrimaryCDRUNCPath — A central collection point for CDR files. If this value is empty or invalid, the 
CDR files will not be moved. The installation procedure sets this parameter.

• CDRFormat — A parameter that determines whether the files are written to the database. The value 
specifies either FLAT or DB. Default value: DB. 

For performance reasons, the Netcool/Proviso Cisco IP Telephony Technology Pack collects CDRs using 
SQL requests, not flat files. Netcool/Proviso does not support FLAT for CDR collection.

• PrimaryCDRDSN — An optional parameter that references the primary CDR server on which to insert 
CDRs. The referenced system does not need Cisco CallManager installed, but does need SQL server and a 
CDR database. 

This parameter allows movement of the CDRs off of the Cisco CallManager cluster. If this parameter is 
missing, CDRs are written locally to the PrimaryCDRUNCPath.

• CDRFlatFileInterval — A parameter that determines the amount of time, in minutes, that a CDR file can 
be written to before Cisco CallManager closes the CDR file and opens a new one.

Supported MIBs

This technology pack uses the following MIB files:

• cisco-10-mib

• CISCO-CCM-MIB.my

• CISCO-CDP-MIB.my

• CISCO-DSP-MGMT-MIB.my

• CISCO-GATEKEEPER-MIB.my

• CISCO-POP-MGMT-MIB.my

• MSSQL-MIB.my

• rfc1213-MIB-II

• rfc1514-HOSTRESOURCES

• rfc1907-SNMPv2-MIB

• rfc2127-ISDN-MIB

• rfc2233-IF-MIB
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Properties

This chapter discusses the following topics: 

Overview 

Note:  To see a list of the properties that this technology pack defines for each of the sub-element it creates, see the 
chapter on defined resources. 

A Netcool/Proviso property is an attribute or characteristic of an element or sub-element. Typically, a 
Netcool/Proviso Technology Pack uses an inventory process to collect information generated by the devices, 
interfaces, and services operating in the technology environment it supports. 

A technology pack uses Netcool/Proviso properties for some or all of the following purposes: 

• To organize information in reports 

• To display values in reports 

• To construct names such as sub-element names, sub-element instance names, and sub-element labels 

The following pages describe the sub-element properties used in this technology pack.

Topic Page 

Overview 119
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AP_ifType

Description

Open-format name of the specific type of resource represented (for example, Ethernet and DS1).

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting

Sub-Element Collect
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CDRclusterId

Description

The cluster identifier. Used with bulk data.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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CDRcustomerId

Description

The customer identifier. Used with bulk data.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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CDRsiteId

Description

The site identifier. Used with bulk data.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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cdrType

Description

The type of Call Detail Record (CDR) — for example, Extension, Gateway, Path. Used with bulk data.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

CDR Quality Detail Chart

CDR Utilization Resource

K-Factor Detail Chart

Used in Grouping Rules

None.
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clusterId

Description

This property has been replaced by CDRclusterId.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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customerId

Description

This property has been replaced by CDRcustomerId.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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Element.NAME

Description

The name of a Cisco IP element.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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Element.STATE

Description

Indicates whether an element is active.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting

Sub-Element Collect
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FAMILY

Description

Identifies a sub-element for reporting and sub-element grouping purposes.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting

Sub-Element Collect
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NAME

Description

The path name of collected path sub-elements.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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siteId

Description

This property has been replaced by CDRsiteId.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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STATE

Description

Indicates whether the entry is active.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting

Sub-Element Collect
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VoIPCallMgrClusterId

Description

The cluster ID. This value is based on the following MIB values:

• ccmClusterId, with CallManager devices. 

• sysLocation, with PSTN Gateway devices.

Captured in Discovery Formulas

CCM_Gateway_Device

CCM_Media_Device

CCM_Server_Device

CCM_Server_FileSystem

CCM_Server_Interface

CCM_Server_Process

CCM_Server_SqlDatabase

PSTN_Gateway_Device

PSTN_Gateway_DSP_Card

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting
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VoIPCallMgrCustomerId

Description

The customer ID. This value is based on the following MIB values:

• sysName, with PSTN Gateway E1/T1 interfaces and PSTN Gateway DSP.

• cdpCacheVTPMgmtDomain, with other PSTN Gateway devices.

Captured in Discovery Formulas

CCM_Server_Interface

PSTN_Gateway_Device

PSTN_Gateway_DSP_Card

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrDSPMaxChannel

Description

The maximum number of channels allowed in each DSP. The value of this property is based on the MIB object 
cdspCardMaxChanPerDSP.

Captured in Discovery Formulas

PSTN_Gateway_DSP_Card

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrFileSystemName

Description

The file server name, based on the MIB value hrStorageDescr.

Captured in Discovery Formulas

CCM_Server_FileSystem

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrGatewayIpAddress

Description

The last known IP Address of the gateway. The value of this property is based on the MIB object 
ccmGatewayInetAddress.

Captured in Discovery Formulas

CCM_Gateway_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 137



Chapter 4:  Element and Sub-Element Properties
VoIPCallMgrGatewayName

Description

The name that the CallManager assigns to the gateway.

Captured in Discovery Formulas

CCM_Gateway_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrGatewayType

Description

The gateway type. This value is based on the MIB object ccmGatewayType.

Captured in Discovery Formulas

CCM_Gateway_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 139



Chapter 4:  Element and Sub-Element Properties
VoIPCallMgrMediaDeviceIpAddress

Description

The media device IP address, based on the MIB value ccmMediaDeviceInetAddress.

Captured in Discovery Formulas

CCM_Media_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrMediaDeviceName

Description

The media device name, based on the MIB value ccmMediaDeviceDescription.

Captured in Discovery Formulas

CCM_Media_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 141



Chapter 4:  Element and Sub-Element Properties
VoIPCallMgrMediaDeviceType

Description

The media device type, based on the MIB value ccmMediaDeviceType.

Captured in Discovery Formulas

CCM_Media_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrProcessName

Description

The CallManager Server process identifier, based on the MIB value hrSWRunName.

Captured in Discovery Formulas

CCM_Server_Process

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrSerialOrDsp

Description

Indicates a voice device.

Captured in Discovery Formulas

None.

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting

Sub-Element Collect
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VoIPCallMgrServerDescr

Description

The CallManager Server description, based on the MIB value ccmDescription.

Captured in Discovery Formulas

CCM_Server_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrServerId

Description

The CallManager Server ID. This value is based on the following MIB values:

• cdpGlobalDeviceId, with CallManager Server devices.

• cdpCacheDeviceId, with Win2000 server PSTN Gateway devices that are registered to the CallManager 
Server.

Captured in Discovery Formulas

CCM_Server_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrServerVersion

Description

The CallManager Server version, based on the MIB value ccmVersion.

Captured in Discovery Formulas

CCM_Server_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPCallMgrSqlDbName

Description

The CallManager Server SQL database name, based on the MIB value mssqlDbInfoDbName.

Captured in Discovery Formulas

CCM_Server_SqlDatabase

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

None.
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VoIPDeviceType

Description

One of the following Cisco IP Telephony devices:

• CallManagerServer

• CiscoGatekeeper

• PSTNGatewayCisco3745

• PSTNGatewayCiscoAS5300

• PSTNGatewayCiscoOtherISDN

• PSTNGatewayCiscoCat6k 

Captured in Discovery Formulas

CCM_Server_Device

Gatekeeper_Device

PSTN_Gateway_Device

Used in CME Formulas

None.

Used in Reports

None.

Used in Grouping Rules

NOC Reporting

Sub-Element Collect
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NOTES
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Chapter 5:  Defined Resources 

This chapter discusses the following topics: 

Overview

A Netcool/Proviso resource is a network element or sub-element, such as a router or a hub. Typically, an IBM 
Technology Pack defines a set of Netcool/Proviso elements, sub-elements, and properties that map to specific 
devices and services operating in a network. These resources allow IBM support engineers to: 

• Configure (using the Netcool/Proviso DataMart Request Editor) data collection requests for the sub-
elements associated with each Technology Pack 

• View (using the Netcool/Proviso DataMart Resource Editor) sub-elements and sub-element groups 
associated with each Technology Pack 

Cisco IP Telephony Technology Pack Resources

The Cisco IP Telephony Technology Pack provides the following Netcool/Proviso resources for the devices, 
services, and interfaces that the Cisco IP Telephony device manages:

Topic Page

Overview 151

Cisco IP Telephony Technology Pack Resources 151

Sub-Element Types 153

Resource Description

Element The name that identifies the Cisco IP Telephony technology being monitored. With SNMP 
collection, this name is typically the IP address where the associated SNMP Agent is running. 
With bulk collection of CDR and CMR data, the name is typically the CallManager cluster name.

Example: hqccm.canalst.dev.mycorp.com
Example: SFCLSTR

In the Netcool/Proviso DataMart Resource Editor, element names appear in the name column 
on the Element tab.
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Sub-elements An element has one or more sub-elements for statistics that apply to the Cisco IP Telephony 
technology. The sub-element name identifies a sub-element that resides in the database. Sub-
element names are often used in reports to identify specific entities. 

With SNMP collection, the sub-element name is constructed from the element name plus the 
instance name. With bulk collection, the sub-element name is the same as the instance name. 

Example: hqccm.canalst.dev.mycorp.com_SqlDb<5>
Example: Extension_SFCLSTR_<2928>

With SNMP collection, a sub-element instance name is constructed from a shorthand name for 
the sub-element type plus an identifier. With Bulk collection, a sub-element instance name is 
constructed from a name for the sub-element type, the element name, plus an identifier.

Example: SqlDb<5>
Example: Extension_SFCLSTR_<2928>

In the Netcool/Proviso DataMart Resource Editor, sub-element names appear in the name 
column on the Sub-Element tab. The instance name appears in the instance column of the Sub-
Element tab.

Sub-element labels A sub-element label is often used in reports to identify a particular instance of a sub-element. 
With SNMP collection, a sub-element label is constructed from a shorthand name for the sub-
element type plus a filename. With Bulk collection, a sub-element label is the same as the sub-
element name.

Example: SqlDatabase: "pubs"
Example: Extension_SFCLSTR_<2928>

In the Netcool/Proviso DataMart Resource Editor, sub-element labels appear in the label 
column on the Sub-Element tab.

Sub-element families This technology pack categorizes the sub-elements it creates into the following families:

• 1213_Device
• IETF_IF
• VOIP_Cisco_CCM_Gateway_Device
• VOIP_Cisco_CCM_Media_Device
• VOIP_Cisco_CCM_Server_FileSystem
• VOIP_Cisco_CCM_Server_Process
• VOIP_Cisco_CCM_Server_SqlDatabase
• VOIP_Cisco_CDR_Cluster
• VOIP_Cisco_CDR_Codec
• VOIP_Cisco_CDR_Extension
• VOIP_Cisco_CDR_Gateway
• VOIP_Cisco_CDR_Path
• VOIP_Cisco_CCM_Server_PERFMON
• VOIP_Cisco_PSTN_Gateway_DSP_Card

In the Netcool/Proviso DataMart Resource Editor, family names appear in the fam column on 
the Sub-Element tab.

Resource Description
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Sub-Element Types

The Cisco IP Telephony Technology Pack creates the following kinds of sub-elements: 

• CallManager Gateway Device

• CallManager Media Device

• CallManager Server Device

• CallManager Server File System

• CallManager Server Interface

• CallManager Server Process

• CallManager Server SQL Database

• Cluster

• Codec

• Extension

• Gatekeeper Device

• Gateway

• Path

• Perfmon

• PSTN Gateway Device

• PSTN Gateway DSP Card

Tables of Sub-Element Types

The tables in this section describe the kinds of Cisco IP Telephony sub-elements that this technology pack 
manages. Note the following about the tables: 

• The Naming Structure row defines how sub-element names, sub-element labels, and sub-element instance 
names are constructed. The following typeface conventions are used: 

—  MIB object names are presented in bold type (for example, cdspCardIndex). 

—  Cisco IP Telephony Technology Pack property names are presented in monospace type (for 
example, DSPCard) 

—  References to element names, instance names, and other variables are presented in italic type (for 
example, ElementName_<InstanceName>. 

• The Properties row lists the Cisco IP Telephony Technology Pack properties associated with the particular 
sub-element type. For descriptions of the properties, see the chapter on element and sub-element properties. 
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CallManager Gateway Device  

Collection Type SNMP

Family VOIP_Cisco_CCM_Gateway_Device

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: Gateway<Gateway>

Label: Gateway: <ccmGatewayInetAddress>

Properties

Gateway 
VoIPCallMgrClusterId 
VoIPCallMgrGatewayIpAddress 
VoIPCallMgrGatewayName 
VoIPCallMgrGatewayType

Comments

This sub-element is a gateway device discovered through the ccmGatewayTable object in the 
CISCO-CCM-MIB. This object is grouped together with PSTN_Gateway_Device sub-elements. 
This sub-element provides information about the registration status for each gateway. Because a 
gateway can be registered to another server, ClusterId_GatewayDescription is used as invariant 
for this sub-element.

CallManager Media Device  

Collection Type SNMP

Family VOIP_Cisco_CCM_Media_Device

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: MediaDevice<MediaDevice>

Label: MediaDevice: ccmMediaDeviceName

Properties

MediaDevice 
VoIPCallMgrClusterId 
VoIPCallMgrMediaDeviceIpAddress 
VoIPCallMgrMediaDeviceName 
VoIPCallMgrMediaDeviceType

Comments

This sub-element is a media device discovered through the ccmMediaDeviceTable object in the 
CISCO-CCM-MIB. Because a gateway can be registered to another server, 
ClusterId_MediaDeviceIpAddress is used as invariant for this sub-element. 

Media devices such as music on hold and conference bridge are media server sub-elements. 
Information about their registration status comes from the CCM Server SNMP Agent.
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CallManager Server Device  

Collection Type SNMP

Family 1213_Device

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: If<ifAdminStatus>

Label: -UNSPECIFIED

Properties

VoIPCallMgrClusterId
VoIPCallMgrDeviceType
VoIPCallMgrServerDescr
VoIPCallMgrServerId
VoIPCallMgrServerVersion

Comments Each CallManager Server is part of one cluster.

CallManager Server File System 

Collection Type SNMP

Family VOIP_Cisco_CCM_Server_FileSystem

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: FileSys<hrStorageIndex>

Label: File System: VoIPCallMgrFileSystemName

Properties
FileSys
VoIPCallMgrClusterId
VoIPCallMgrFileSystemName

Comments None.

CallManager Server Interface 

Collection Type SNMP

Family IETF_IF

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: If<ifAdminStatus>

Label: -UNSPECIFIED

Properties
If
VoIPCallMgrClusterId
VoIPCallMgrCustomerId

Comments None.
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CallManager Server Process 

Collection Type SNMP

Family VOIP_Cisco_CCM_Server_Process

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: Process<Process>

Label: Process<hrSWRunName>

Properties
Process
VoIPCallMgrClusterId
VoIPCallMgrProcessName

Comments None.

CallManager Server SQL Database 

Collection Type SNMP

Family VOIP_Cisco_CCM_Server_SqlDatabase

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: SqlDb<SqlDb>

Label: SqlDatabase: <mssqDbInfoDbName>

Properties
SqlDb
VoIPCallMgrClusterId
VoIPCallMgrSqlDbName

Comments None.

Cluster 

Collection Type Bulk

Family VOIP_Cisco_CDR_Cluster

Naming 
Structure

Sub-element name: ElementName_<NULL>

Instance name: ElementName_<NULL>

Label: ElementName_<NULL>

Properties
CDRclusterId
CDRcustomerId

Comments
Each CallManager cluster is both an element and a sub-element. The element name is defined in 
the design file CCMAdaptor.js. The sub-element name is similar to clusterId_NULL (where 
clusterId is the cluster’s element name.)
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Codec

Collection Type Bulk

Family VOIP_Cisco_CDR_Codec

Naming 
Structure

Sub-element name: ElementName_Codec_CodecType

Instance name: ElementName_Codec_CodecType

Label: ElementName_Codec_CodecType

Properties
CDRclusterId
CDRcustomerId

Comments None.

Extension  

Collection Type Bulk

Family VOIP_Cisco_CDR_Extension

Naming 
Structure

Sub-element name: Extension_ElementName_<extensionNumber>

Instance name: Extension_ElementName_<extensionNumber>

Label: Extension_ElementName_<extensionNumber>

Properties

cdrType
CDRclusterId
CDRcustomerId
CDRsiteId
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Comments

This sub-element is the extension number for a phone or a CTI application. An extension can be 
any internal phone number managed by the CallManager’s DialPlan, according to its 
configuration. Supported extensions include:

• Cisco IP Phone (79xx series) registered to the CallManager cluster.

• Analog Phone connected to a voice gateway (for example, ATA186 or Cisco VG200 Series,) 
and registered to the CallManager cluster.

• Legacy phone connected to a legacy PBX. It is not registered to the CallManager cluster, but 
has an extension number defined within the company’s internal DialPlan. A record can be 
stored by the CallManager each time an internal legacy phone makes a call with an IP phone.

• VoiceMail application, which is defined in the CallManager as a special range of extension 
numbers.

• Front desk operator.

• Hunt Group — a group of people in the company with the same extension number.

• Conference bridge.

• Any other CTI Application (IVR, AutoAttendant).

External PSTN numbers and unknown numbers that are not defined in the internal DialPlan of 
the CallManager configuration are not managed by Netcool/Proviso through a specific sub-
element. However, each time a record is found in the CDR database with an external or unknown 
number, metrics for either of the following specific sub-elements are created or updated: 

• ExternalNumber

• UnknownExtension

Gatekeeper Device 

Collection Type SNMP

Family 1213_Device

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: <NULL>

Label: -UNSPECIFIED

Properties VoIPIPDeviceType

Comments
Optional H.323 component. A gatekeeper can be registered to several clusters. A gatekeeper can 
be a Cisco 2600 or 3600 Series.

Extension  (cont.)
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Gateway 

Collection Type Bulk

Family VOIP_Cisco_CDR_Gateway

Naming 
Structure

Sub-element name: Gateway_ElementName_<gatewayIpAddress>

Instance name: Gateway_ElementName_<gatewayIpAddress>

Label: Gateway_ElementName_<gatewayIpAddress>

Properties

cdrType
CDRclusterId
CDRcustomerId
CDRsiteId

Comments

IP telephony sub-elements can be grouped according to family name and properties:

• Per customer: A customer can have one or several clusters deployed in a network.

• Per cluster: A cluster is the IP-PBX itself.

• Per site: Physical location where gateways and extensions are deployed.

The gateway IP address appears in a CDR each time a call goes through it. Gateways can then be 
managed as a sub-element from the call-accounting point of view. This sub-element is attached to 
the cluster element, not to the SNMP PSTN gateway element. A gateway can be a PSTN gateway 
or a legacy PBX gateway, which is useful to connect a legacy PBX to the IP network.

Path 

Collection Type Bulk

Family VOIP_Cisco_CDR_Path

Naming 
Structure

Sub-element name: Path_ElementName_<caller_callee>

Instance name: Path_ElementName_<caller_callee>

Label: Path_ElementName_<caller_callee>

Properties
cdrType
CDRclusterId
CDRcustomerId

Comments

A path sub-element contains information about the calling site and information about the callee 
site. Both ends of a call are from different sites.

A path can be an internal call between 2 IP phones from different sites, or between an internal IP 
phone and a PSTN gateway, or between an internal IP phone and a legacy PBX gateway — for 
example:

• Internal extension from SiteA to internal extension from SiteB (SiteA_SiteB)

• Internal extension from SiteB to internal extension from SiteA (SiteB_SiteA)

• Internal extension from SiteA to PSTN Gateway from SiteB (SiteA_GatewayIPAddress)

• PSTN Gateway from SiteB to internal extension from SiteA (GatewayIPAddress_SiteA)
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Perfmon  

Collection Type Bulk

Family VOIP_Cisco_CCM_Server_PERFMON

Naming 
Structure

Sub-element name: CallManager_<subelement>

Instance name: <subelement>

Label: CallManager_<subelement>

Properties
CDRclusterId
CDRsiteId

Comments None.

PSTN Gateway Device  

Collection Type SNMP

Family 1213_Device

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: <NULL>

Label: -UNSPECIFIED

Or...

*WS6608: cdpCacheDeviceID (for Catalyst 6500 with MSFC WAN module)

Properties
VoIPCallMgrClusterId
VoIPCallMgrCustomerId
VoIPCallMgrDeviceType

Comments

This technology pack can collect data from gateways installed at the customer site or within the 
service provider core network. 

This sub-element supports the following types of PSTN gateways:

• PSTNGatewayCisco3745: Any 3700 series device supporting POP-MIB, DSP-MIB, ISDN-
MIB, and DIAL-CONTROL-MIB.

• PSTNGatewayCiscoAS5300: Any AS5x00 series device supporting POP-MIB and DSP-MIB.

• PSTNGatewayCiscoOtherISDN: Any 2600, 3600, 1700 series device supporting only ISDN-
MIB.

• PSTNGatewayCiscoCat6k: Any Catalyst6500 with MSFC Wan module with T1/E1 PRI 
interfaces for PSTN connectivity, supporting only MIB2 for those PSTN interfaces.

A PSTN gateway is registered to a CCM server, not to the cluster itself. PSTN gateways can be 
registered to one or more clusters. You cannot get any CDRclusterId attributes based on 
available SNMP information.

To get information about D Channel status and gateway registration status with CallManager, 
additional Media Gateway data are also collected through the CCM Server SNMP Agent. In this 
case, this technology pack creates a separate sub-element per entry in the ccmGatewayTable.
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PSTN Gateway DSP Card 

Collection Type SNMP

Family

VOIP_Cisco_PSTN_Gateway_DSP_Card (for cards discovered through CISCO_DSP-MGMT-
MIB)

Or...

IETF_IF (for Catalyst 6500 DSP resources)

Naming 
Structure

Sub-element name: ElementName_<InstanceName>

Instance name: DSPCard<DSPCard>

Label: DSPCard: <cdspCardIndex>

Properties

DSPCard
VoIPCallMgrClusterId
VoIPCallMgrCustomerId
VoIPCallMgrDSPMaxChannel

Comments None.
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 161



Chapter 5:  Defined Resources
NOTES
162 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 6: Sub-Element Grouping Rules

This chapter discusses the following topics: 

Overview 

Typically, a Netcool/Proviso Technology Pack defines sub-element grouping rules. Grouping rules organize and 
filter networking data into a structure that makes it easier to collect data on thousands or millions of resources. 

Sub-element grouping rules organize data in tree structures. Each folder (branch) in the tree is associated with a 
rule or condition. If a sub-element property satisfies the rule or condition associated with a folder in the grouping 
tree, the sub-element is placed in the folder. The sub-element is then tested against the rule or condition in the 
next folder below. If the sub-element passes that test, it is tested against the rule or condition in the next folder, 
and so on. 

The Cisco IP Telephony Technology Pack uses some of its Netcool/Proviso properties to define sub-element 
grouping rules. Grouping rule names appear in the Name field (Rule Sub-Element view) of the Netcool/Proviso 
DataMart Rule Editor. For information on how to use the Netcool/Proviso DataMart Rule Editor, see the 
Netcool/Proviso DataMart Configuration Guide. 

The Rule Editor contains two grouping rule trees — the NOC reporting tree and the sub-element collect tree. 
The following sections describe the filtering rules and conditions in these trees. 

Topic Page 

Overview 163

NOC Grouping 164

Sub-Element Collect Grouping 171
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NOC Grouping

The NOC reporting tree provides the framework that allows users to navigate to reports. 

The NOC reporting tree for this technology pack contains the following high-level branches. The tree is shown 
as it appears in the DataMart Rule Editor:

These high-level branches are used to organize the sub-branches of the tree. The following sections describe how 
sub-elements are grouped within these high-level branches.

Note:  In the IP Telephony Call Detail Record and Infrastructure branches, some properties have been replaced. 
Those properties and the replacement properties are as follows:

*  clusterId is replaced by CDRclusterId

*  customerId is replaced by CDRcustomerId

*  siteId is replaced by CDRsiteId

Global Customer View Branch

The Global Customer View branch of the Cisco IP Telephony NOC reporting tree contains the sub-branches 
shown below:

This branch has no rules or conditions. All sub-elements are tested against the conditions in its sub-branches.
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The sub-branches are described as follows:

Global Customer View Branch (No Rules or Conditions)  

Sub-branch Name Description

CCM Servers Type: Static.
Purpose: Filters by condition:

%(FAMILY) LIKE 'VOIP_Cisco_CCM%' OR %(VoIPDeviceType)
= 'CallManagerServer'

Clusters Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Cluster'

DSP Type: Static.
Purpose: Filters by condition:

%(FAMILY) LIKE 'VOIP_Cisco_PSTN_Gateway_DS%' OR
%(VoIPCallMgrSerialOrDsp) LIKE 'voice%'

E1T1 Interfaces Type: Static.
Purpose: Filters by condition:

%(AP_ifType) = 'ds1' AND %(VoIPCallMgrSerialOrDsp)
NOT LIKE 'voice%'

Extensions Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Extension'

PSTN Gateways Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) LIKE 'PSTNGatewayCisco%' OR
%(FAMILY) = 'VOIP_Cisco_CDR_Gateway'

Path Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Path'
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IP Telephony Call Detail Record Branch

The IP Telephony Call Detail Record branch of the Cisco IP Telephony NOC reporting tree contains the sub-
branches shown below:

This branch has the following condition:

%(FAMILY) LIKE 'VOIP_Cisco_CDR_%'
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Sub-elements that match this condition are tested against the rules and conditions in the sub-branches. The sub-
branches are described as follows:

IP Telephony Call Detail Record Branch — %(FAMILY) LIKE 'VOIP_Cisco_CDR_%'  

Sub-branch Name Description

Clusters Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Cluster'

Clusters 
--%(CDRclusterId)

Type: Rule.
Purpose: Groups the collected cluster sub-elements by cluster ID.

Codec Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Codec'

Codec 
--By Cluster

Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Codec'

Codec 
--By Cluster 
----%(CDRclusterId)

Type: Rule.
Purpose: Groups the collected codec sub-elements by cluster ID.

Codec 
--By Customer

Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Codec'

Codec 
--By Customer 
----%(CDRcustomerId)

Type: Rule.
Purpose: Groups the collected codec sub-elements by customer ID.

Extensions Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Extension'

Extensions 
--By Cluster

Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Extension'

Extensions 
--By Cluster 
----%(CDRclusterId)

Type: Rule.
Purpose: Groups the collected extension sub-elements by cluster ID.

Extensions 
--By Customer

Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Extension'

Extensions 
--By Customer 
----%(CDRcustomerId)

Type: Rule.
Purpose: Groups the collected extension sub-elements by customer ID.

Extensions 
--By Site

Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Extension'

Extensions 
--By Customer 
----%(CDRsiteId)

Type: Rule.
Purpose: Groups the collected extension sub-elements by site ID.
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Media Gateways Type: Static.
Purpose: Filters by condition:
%(FAMILY) = 'VOIP_Cisco_CDR_Gateway'

Media Gateways 
--By Cluster

Type: Static.
Purpose: Filters by condition:
%(FAMILY) = 'VOIP_Cisco_CDR_Gateway'

Media Gateways 
--By Cluster 
----%(CDRclusterId)

Type: Rule.
Purpose: Groups the collected media gateway sub-elements by cluster ID.

Media Gateways 
--By Customer

Type: Static.
Purpose: Filters by condition:
%(FAMILY) = 'VOIP_Cisco_CDR_Gateway'

Media Gateways 
--By Customer 
----%(CDRcustomerId)

Type: Rule.
Purpose: Groups the collected media gateway sub-elements by customer ID.

Media Gateways 
--By Site

Type: Static.
Purpose: Filters by condition:
%(FAMILY) = 'VOIP_Cisco_CDR_Gateway'

Media Gateways 
--By Customer 
----%(CDRsiteId)

Type: Rule.
Purpose: Groups the collected media gateway sub-elements by site ID.

Path Group Type: Static.
Purpose: Filters by condition:
%(FAMILY) = 'VOIP_Cisco_CDR_Path'

Path Group 
--%(NAME)

Type: Rule.
Purpose: Groups the collected path group sub-elements by path name.

Paths Type: Static.
Purpose: Filters by condition:
%(FAMILY) = 'VOIP_Cisco_CDR_Path'

Paths 
--By Cluster

Type: Static.
Purpose: Filters by condition:
%(FAMILY) = 'VOIP_Cisco_CDR_Path'

Paths 
--By Cluster
----%(CDRclusterId)

Type: Rule.
Purpose: Groups the collected path sub-elements by cluster ID.

Paths 
--By Customer

Type: Static.
Purpose: Filters by condition:
%(FAMILY) = 'VOIP_Cisco_CDR_Path'

Paths 
--By Customer
----%(CDRcustomerId)

Type: Rule.
Purpose: Groups the collected path sub-elements by customer ID.

IP Telephony Call Detail Record Branch — %(FAMILY) LIKE 'VOIP_Cisco_CDR_%'  (cont.)

Sub-branch Name Description
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Infrastructure Branch

The Infrastructure branch of the Cisco IP Telephony NOC reporting tree contains the sub-branches shown 
below:

This branch has no rules or conditions. All sub-elements are tested against the rules and conditions in its sub-
branches.

The sub-branches are described as follows:

Infrastructure Branch (No Rules or Conditions)  

Sub-branch Name Description

CCM Server Type: Static.
Purpose: Filters by condition:

%(FAMILY) LIKE 'VOIP_Cisco_CCM_Server%' OR
%(VoIPDeviceType) = 'CallManagerServer'

CCM Server 
--%VoIPCallMgrClusterId

Type: Rule.
Purpose: Groups the collected CCM Server sub-elements by CCM cluster ID.

Perfmon Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) = 'CUCM_Perfmon'

Perfmon 
--By Cluster

Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CCM_Server_PERFMON'

Perfmon 
--By Cluster 
----%(CDRclusterID)

Type: Rule.
Purpose: Groups the collected Perfmon sub-elements by CCM cluster ID.

Perfmon 
--By Site

Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CCM_Server_PERFMON'
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Perfmon 
--By Site 
----%(CDRsiteID)

Type: Rule.
Purpose: Groups the collected Perfmon sub-elements by CCM site ID.

Gatekeeper Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) = 'CiscoGatekeeper'

Gatekeeper 
--Device

Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) = 'CiscoGatekeeper'

Gatekeeper 
--Interface

Type: Static.
Purpose: Filters by condition:

(%(AP_ifType) = 'ds1' AND %(VoIPCallMgrSerialOrDsp)
NOT LIKE 'voice%')

Media Device Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CCM_Media_Device'

Media Device 
--%VoIPCallMgrClusterId

Type: Rule.
Purpose: Groups the collected media device sub-elements by CCM cluster ID.

PSTN Gateway Type: Static.
Purpose: Organizational only. No rules or conditions.

PSTN Gateway 
--DSP Card

Type: Static.
Purpose: Filters by condition:

%(FAMILY) LIKE 'VOIP_Cisco_PSTN_Gateway_DS%' OR
%(VoIPCallMgrSerialOrDsp) LIKE 'voice%'

PSTN Gateway 
--DSP Card 
----All

Type: Static.
Purpose: Filters by condition:

%(FAMILY) LIKE 'VOIP_Cisco_PSTN_Gateway_DS%' OR
%(VoIPCallMgrSerialOrDsp) LIKE 'voice%'

PSTN Gateway 
--DSP Card 
----ByGateway: %Element.NAME)

Type: Rule.
Purpose: Groups the collected PSTN gateway DSP card sub-elements by name.

PSTN Gateway 
--Device

Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) LIKE 'PSTNGatewayCisco%'

PSTN Gateway 
--Device 
----All

Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) LIKE 'PSTNGatewayCisco%'

PSTN Gateway 
--Device 
----By Type

Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) LIKE 'PSTNGatewayCisco%'

PSTN Gateway 
--Device 
----By Type
------%(VoIPDeviceType)

Type: Rule.
Purpose: Groups the collected PSTN gateway device sub-elements by device type.

Infrastructure Branch (No Rules or Conditions)  (cont.)

Sub-branch Name Description
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Sub-Element Collect Grouping

The sub-element collection tree organizes the requests that collect metrics from sub-elements. 

The following illustration is a portion of the Sub-Element Collect tree as it appears in the DataMart Rule Editor. 
The shaded branches represent the Cisco IP Telephony portion of the tree:

Interface Type: Static.
Purpose: Filters by condition:

(%(AP_ifType) = 'ds1' AND %(VoIPCallMgrSerialOrDsp)
NOT LIKE 'voice%')

Interface 
--All

Type: Static.
Purpose: Filters by condition:

%(AP_ifType) = 'ds1' AND %(VoIPCallMgrSerialOrDsp)
NOT LIKE 'voice%'

Interface 
--By Gateway

Type: Static.
Purpose: Filters by condition:

%(AP_ifType) = 'ds1' AND %(VoIPCallMgrSerialOrDsp)
NOT LIKE 'voice%'

Interface 
--By Gateway 
----%(ElementNAME)

Type: Rule.
Purpose: Groups the collected PSTN gateway interface sub-elements by name.

Infrastructure Branch (No Rules or Conditions)  (cont.)

Sub-branch Name Description
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%(FAMILY) = 'VOIP_Cisco_CCM_Media_Device'

%(VoIPDeviceType) = 'CallManagerServer'

The branches are described as follows:

Sub-branch Name Description

CCM Media Device Type: Static.
Purpose: Filters by condition:

CCM Server Device Type: Static.
Purpose: Filters by condition:

CDR Extension Path 
Gateway

Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Extension' OR %(FAMILY) =
'VOIP_Cisco_CDR_Path' OR %(FAMILY) =
'VOIP_Cisco_CDR_Gateway'

Cluster CDR Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Cluster'

Codec Type: Static.
Purpose: Filters by condition:

%(FAMILY) = 'VOIP_Cisco_CDR_Codec'

DSP Card Type: Static.
Purpose: Filters by condition:

%(FAMILY) LIKE 'VOIP_Cisco_PSTN_Gateway_DS%' OR
%(VoIPCallMgrSerialOrDsp) LIKE 'voice%'

Interface Type: Static.
Purpose: Filters by condition:

%(AP_ifType) = 'ds1' AND %(VoIPCallMgrSerialOrDsp) NOT
LIKE 'voice%'

PSTN Gateway Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) LIKE 'PSTNGatewayCisco%'

Perfmon Type: Static.
Purpose: Filters by condition:

%(VoIPDeviceType) = 'CUCM_Perfmon'
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NOTES
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Chapter 7:  Collection Formulas

This chapter discusses the following topics: 

Overview

This technology pack provides the following types of collection formulas:

• SNMP collection formulas specific to the associated network devices and technologies on which it operates. 
These SNMP collection formulas are installed with the Cisco IP Telephony Technology Pack. 

• Bulk collection formulas. Unlike an SNMP collection formula, a bulk collection formula has no executable 
instructions. However, the Bulk Collector requires database IDs for the value it returns after reading Bulk 
input files. Bulk collection formulas provide these unique database IDs. The Formula Table (FRML_DESC) 
must contain an ID for each metric the Bulk Collector might return. If the entry in the Formula Table does 
not exist, the Bulk Collector cannot report the value. 

Typically, a Bulk collection formula consists of a name that maps to a statistic that resides in a Bulk input file. 
Typically, the device or devices that the technology pack supports generate the statistics that reside in these 
Bulk input files. In many cases, the statistics reside in these Bulk input files as data records or data fields. 

Each Bulk collection formula name has an associated ID. It is the Bulk collection formula ID (along with the 
sub-element ID and timestamp) that identify a specific location in the database where the statistic resides. In 
other words, the Bulk collection formulas do not perform any calculations, but merely serve as pointers to 
the actual statistics residing in the database. 

There are many formats associated with Bulk input files, for example CSV, XML, and binary. Typically, a 
technology pack provides a Bulk Adaptor Design File (implemented as a JavaScript file) that defines the format 
or formats of the Bulk input files for which it is responsible for processing. This Bulk Adaptor Design File 
processes both inventory and statistics from the same Bulk input file. More specifically, this Bulk Adaptor Design 
File provides a function that creates the Bulk collection formula names.

Topic Page 
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Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 175



Chapter 7:  Collection Formulas
Data Collection

This technology pack uses both SNMP collection and bulk collection to gather data about Cisco IP Telephony 
devices and services:

• With SNMP collection, data is gathered from objects in standard and vendor-specific MIBs.

• With bulk collection, the Netcool/Proviso Bulk Collector gathers input files that contain non-SNMP data 
generated by Cisco IP Telephony devices. This data is processed by the technology pack’s Bulk Adaptor 
Design File, CCMAdaptor.js.

Formulas and Metrics

After the network data is collected, Netcool/Proviso processes the data and generates the metrics that are stored 
in the DataMart database and used in DataView reports. This processing is performed by the formulas described 
in this chapter.

A metric has the same name as the formula that generates it.

Metrics are categorized according to the type of process used to calculate the metric, as follows:

• SNMP — Data collected from MIB objects and processed by formulas included with this technology pack. 
Formulas that generate SNMP metrics are listed in this chapter in the Syntax section of the reference pages.

• Import — Data collected from bulk input files generated by a Cisco IP Telephony device and processed by 
the Bulk Adaptor Design File. In some cases, the design file maps a bulk metric to a single statistic in an input 
file. In other cases, the design file generates a bulk metric value through a calculation involving multiple input 
file statistics.

• Generic — A metric whose database location is mapped to multiple formulas. This allows the formulas 
to store the metrics they generate against a single database ID, allowing the metrics to appear in a single 
DataView report.

• CME — Metrics that are produced by calculations that the Netcool/Proviso Complex Metric Engine (CME) 
performs, using other metrics and sub-element properties as inputs.

Note:  Generic and CME formulas may not be included in this technology pack.

Metrics may appear in DataView reports as raw data, or they may be further processed by the Complex Metric 
Engine — for example, to produce data aggregations over time. To learn where the metrics generated by the 
formulas in this chapter are used, see the chapter on supported reports in this guide. 

This chapter is a reference of the formulas that the Cisco IP Telephony Technology Pack provides. The chapter 
lists formulas alphabetically.
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Formula Reference

The following pages provide a reference of the formulas that this technology pack provides. The reference pages 
have the following sections: 

• Type. The source of data for the formula being described — for example, SNMP (collect). 

• Description. The description of the formula. 

• Syntax. The formula that generates the metric from the collected SNMP data. 

After this formula processes the data, the resulting metric can be used in Netcool/Proviso DataView reports 
and in calculations of other metrics. 

See the Netcool/Proviso SNMP Formula Language Guide for detailed information about the syntax used to write 
SNMP collection formulas. 

• Formula Input. This section appears with CME formulas only. It shows the variables that the CME formula 
uses as input, and the property or formula that supplies a variable’s value. In the following example, the 
formula Egress Octets Forwarded is the source of the value of the input variable EgressOct:

Input: EgressOct
Source: Egress Octets Forwarded (Formula)

• Generic Database Alias. A database location where the metric generated by a formula can be stored. 

Typically, generic metrics serve as repositories in the database for mixed data collected from a particular kind 
of sub-element — for example, low- and high-capacity interfaces. Storing mixed data against a generic metric 
ID allows you to display the different kinds of data in a single report. 

• Path. The path where the referenced SNMP collection formula is defined in the Netcool/Proviso database. 

You view the formula tree through the Formula Selector dialog of the Netcool/Proviso Formula Editor. To 
display this dialog, click File > Load in the Formula Editor. 

• MIB. One or more MIBs that supply data to the referenced SNMP formula. 
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AttendantConsoleClientsOnline

Type

Import

Description

Total number of attendant console clients currently online.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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AttendantConsoleClientsRegistered

Type

Import

Description

Total number of attendant console clients registered to the device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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AuthenticatedCallsActive

Type

Import

Description

Total number of active authenticated calls.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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AuthenticatedPartiallyRegisteredPhone

Type

Import

Description

Total number of active authenticated extensions that have not completed the registration process.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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AuthenticatedRegisteredPhones

Type

Import

Description

Total number of active authenticated and fully registered extensions.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Availability (percent)

Type

SNMP (collection)

Description

The percentage of time that this resource was in an operational state.

Syntax

DEF UseLib RFC1213Interface;

DEF SaveAlias 2955;

ifAvailability(Percent)

Generic Database Alias

Interface Availability (percent)

Formula Editor Path

AP > Specific > SNMP > Interfaces > Availability

MIB

rfc1213-MIB-II
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BRIChannelsActive

Type

Import

Description

Total number of BRI channels currently in use in the target device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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BRISpansInService

Type

Import

Description

Total number of BRI spans available in the target device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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CallDuration

Type

Import

Description

The duration of the call, in seconds.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
186 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 7:  Collection Formulas
CallsActive

Type

Import

Description

Total number of currently active calls for the resource or resources specified.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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CallsInProgress

Type

Import

Description

Total number of calls being established at the time of sampling.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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CauseCallRejected

Type

Import

Description

Call rejected. Cause code 21.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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CauseChannelUnacceptable

Type

Import

Description

Channel unacceptable. Cause code 6.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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CauseDestinationOutOfOrder

Type

Import

Description

Destination out of order. Cause code 27.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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CauseInvalidNumberFormat

Type

Import

Description

Address incomplete, invalid number format. Cause code 28.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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CauseMisdialedTrunkPrefix

Type

Import

Description

Misdialed trunk prefix. Cause code 5.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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CauseNetworkOutOfOrder

Type

Import

Description

Network out of order. Cause code 38.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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CauseNoAnswerFromUser

Type

Import

Description

No answer from user. Cause code 19.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseNoChannelAvailable

Type

Import

Description

No channel/circuit available. Cause code 34.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseNoRouteToDestination

Type

Import

Description

No route to destination. Cause code 3.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseNoRouteTransitNetwork

Type

Import

Description

No route to specified transit network. Cause code 2.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseNoUserResponding

Type

Import

Description

No user responding to the call. Cause code 18.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseNumberChanged

Type

Import

Description

CNumber changed. Cause code 22.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseOther

Type

Import

Description

Unspecified error.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseResourceUnavailable

Type

Import

Description

Resource unavailable or unspecified. Cause code 47.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseSubscriberAbsent

Type

Import

Description

Subscriber absent. Cause code 20.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseSwitchCongestion

Type

Import

Description

Switching equipment congestion. Cause code 42.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseTemporaryFailure

Type

Import

Description

Temporary failure. Cause code 41.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseUnassignedNumber

Type

Import

Description

Unassigned or unallocated number. Cause code 1.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CauseUserBusy

Type

Import

Description

User busy. Cause code 17.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
CCM CPU Utilization (percent) (avg last 5 mn)

Type

SNMP (collection)

Description

The average percentage of time, over the last five minutes, that this processor was not idle.

Syntax

hrProcessorLoad.1

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

rfc1514-HOSTRESOURCES
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Chapter 7:  Collection Formulas
CCM Media Device Registration Availability (percent)

Type

SNMP (collection)

Description

The availability (percentage) that the media devices can register with a CCM server.

Syntax

Def DefaultNoRespResult 0;

Dim I1 AS Integer Default * NAME MediaDevice;

100 * abs( delta(sysUpTime.0) * (1 + distrib(ccmMediaDeviceStatus.%I1,"==1:-
1,==2:1,==3:-1,==4:-1") )/2 - delta(sysUpTime.0)/2 * abs( 
delta(distrib(ccmMediaDeviceStatus.%I1,"==1:-1,==2:1,==3:-1,==4:-1"))/2 ) ) / 
delta(sysUpTime.0)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

CISCO-CCM-MIB.my

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
CCM Physical Memory Utilization (percent)

Type

SNMP (collection)

Description

The percentage of CallManager physical memory utilization. The percentage is determined by finding the total 
amount of real system memory allocated to each process, and then dividing the total by the amount of physical 
memory contained by the host.

Syntax

Dim I0 AS Integer Default * NAME Mem;

V1=OIDVAL(hrSWRunPerfMem.%I0);

V2=OIDVAL(Sum(*, %V1));

V3=OIDVAL(hrMemorySize.0);

100*(%V2/%V3)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

rfc1514-HOSTRESOURCES
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Chapter 7:  Collection Formulas
CCM Registered CTI Devices (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of CTI devices registered to the CallManager.

Syntax

ccmRegisteredCTIDevices.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

CISCO-CCM-MIB.my
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Chapter 7:  Collection Formulas
CCM Registered Devices (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of devices currently registered to the CallManager device.

Syntax

ccmRegisteredPhones.0 + ccmRegisteredGateways.0 + ccmRegisteredMediaDevices.0 + 
ccmRegisteredCTIDevices.0 + ccmRegisteredVoiceMailDevices.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

CISCO-CCM-MIB.my
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Chapter 7:  Collection Formulas
CCM Registered Gateways (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of media gateways registered to a CallManager device.

Syntax

ccmRegisteredGateways.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

CISCO-CCM-MIB.my
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Chapter 7:  Collection Formulas
CCM Registered Media Devices (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of media devices registered to a CallManager Server.

Syntax

ccmRegisteredMediaDevices.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

CISCO-CCM-MIB.my
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Chapter 7:  Collection Formulas
CCM Registered Phones (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of IP phones registered to a CallManager device.

Syntax

ccmRegisteredPhones.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

CISCO-CCM-MIB.my
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Chapter 7:  Collection Formulas
CCM Registered VoiceMail Devices (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of registered voicemail devices.

Syntax

ccmRegisteredVoiceMailDevices.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

CISCO-CCM-MIB.my
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Chapter 7:  Collection Formulas
CCM Rejected Devices (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of rejected devices.

Syntax

ccmRejectedPhones.0 + ccmRejectedGateways.0 + ccmRejectedMediaDevices.0 + 
ccmRejectedCTIDevices.0 + ccmRejectedVoiceMailDevices.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device

MIB

CISCO-CCM-MIB.my
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Chapter 7:  Collection Formulas
CCM SQL Server Availability percentage

Type

SNMP (collection)

Description

The availability percentage of the CallManager SQL server.

Syntax

Def DefaultNoRespResult 0;

Dim I0 AS Integer Default * NAME Sqlserver;

100 * abs( delta(sysUpTime.0) * (1 + distrib(mssqlSrvState.%I0,"==1:1,==2:-
1,==3:-1,==4:1,5==-1,6==1,7==-1") )/2 - delta(sysUpTime.0)/2 * abs( 
delta(distrib(mssqlSrvState.%I0,"==1:1,==2:-1,==3:-1,==4:1,5==-1,6==1,7==-1"))/2 
) ) / delta(sysUpTime.0)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
CCM SQL Server Cache Hit ratio (percent)

Type

SNMP (collection)

Description

The buffer cache hit ratio. The percentage of time that a requested data page was found in the data cache instead 
of being read from disk.

Syntax

Dim I0 AS Integer Default * NAME Sql;

V1=OIDVAL(mssqlSrvInfoCacheHitRatio.%I0);

Sum(*, %V1)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my
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Chapter 7:  Collection Formulas
CCM SQL Server free buffers (Nb)

Type

SNMP (collection)

Description

The total number of data cache buffers currently in the free pool.

Syntax

Dim I0 AS Integer Default * NAME Sql;

V1=OIDVAL(mssqlSrvInfoFreeBuffers.%I0);

Sum(*, %V1)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my
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Chapter 7:  Collection Formulas
CCM SQL Server number active user connections

Type

SNMP (collection)

Description

The total number of open user connections.

Syntax

Dim I0 AS Integer Default * NAME Sql;

V1=OIDVAL(mssqlSrvInfoUserConnections.%I0);

Sum(*, %V1)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my
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Chapter 7:  Collection Formulas
CCM SQL Server number of blocked users

Type

SNMP (collection)

Description

The total Number of users blocked by other users.

Syntax

Dim I0 AS Integer Default * NAME Sql;

V1=OIDVAL(mssqlSrvInfoUsersBlocked.%I0);

Sum(*, %V1)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my
222 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 7:  Collection Formulas
CCM SQL Server number of locks blocking processes

Type

SNMP (collection)

Description

The total number of locks blocking other processes.

Syntax

Dim I0 AS Integer Default * NAME Sql;

V1=OIDVAL(mssqlSrvInfoTotalBlockingLocks.%I0);

Sum(*, %V1)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my
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Chapter 7:  Collection Formulas
CCM SQL Server number of locks

Type

SNMP (collection)

Description

The total number of locks in use by SQL Server.

Syntax

Dim I0 AS Integer Default * NAME Sql;

V1=OIDVAL(mssqlSrvInfoTotalLocks.%I0);

Sum(*, %V1)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my
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Chapter 7:  Collection Formulas
CCM SQL Server number of pending rw

Type

SNMP (collection)

Description

The total number of pending reads and writes.

Syntax

Dim I0 AS Integer Default * NAME Sql;

V1=OIDVAL(mssqlSrvInfoOutstandingReads.%I0 + mssqlSrvInfoOutstandingWrites.%I0);

Sum(*, %V1)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my
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Chapter 7:  Collection Formulas
CCM SQL Server Total number of Pages

Type

SNMP (collection)

Description

The total number of pages read and written.

Syntax

Dim I0 AS Integer Default * NAME Sql;

V1=OIDVAL(delta(mssqlSrvInfoPageReads.%I0) + 
delta(mssqlSrvInfoSinglePageWrites.%I0));

Sum(*, %V1)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Sql Server

MIB

MSSQL-MIB.my
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Chapter 7:  Collection Formulas
CCR

Type

Import

Description

Cumulative concealment ratio during a call represented as concealment time / speech time.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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Chapter 7:  Collection Formulas
Cluster Erlang

Type

CME

Description

Cluster Erlang measured in minutes: ClusterCallDuration / 60.

Syntax

^(duration/60)

Formula Input

Input: duration
Source: ClusterCallDuration (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Number of Direct VoiceMail Calls (Nb)

Type

CME

Description

The total number of voicemail calls that are direct calls to voicemail (that is, users calling voicemail directly rather 
than being forwarded). This metric is the opposite of ClusterForwardToVoiceMail.

Syntax

^(ClusterVoiceMailCall - ClusterForwardToVoiceMail)

Formula Input

Input: ClusterForwardToVoiceMail
Source: ClusterForwardToVoiceMail (Formula)

Input: ClusterVoiceMailCall
Source: ClusterVoiceMailCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Percentage of Company Calls (percent)

Type

CME

Description

The ratio between company calls and the total number of calls.

For information on company calls, see Cluster Total Number of Company Calls (Nb).

Syntax

^(100*(ClusterIntrasiteIPCalls+ClusterIntersiteIPCalls+ClusterIntrasiteLegacyPBX
Calls+ClusterIntersiteLegacyPBXCalls)/ClusterTotalCalls)

Formula Input

Input: ClusterIntersiteIPCalls
Source: ClusterIntersiteIPCall (Formula)

Input: ClusterIntersiteLegacyPBXCalls
Source: ClusterIntersiteLegacyPBXCall (Formula)

Input: ClusterIntrasiteIPCalls
Source: ClusterIntrasiteIPCall (Formula)

Input: ClusterIntrasiteLegacyPBXCalls
Source: ClusterIntrasiteLegacyPBXCall (Formula)

Input: ClusterTotalCalls
Source: ClusterTotalCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Percentage of Drop Calls (percent)

Type

CME

Description

The ratio between dropped calls and the total number of calls.

Syntax

(100*(ClusterDropCalls/ClusterTotalCalls)) > 100 ifTrue: [^nil].

^(100*(ClusterDropCalls/ClusterTotalCalls))

Formula Input

Input: ClusterDropCalls
Source: ClusterDropCall (Formula)

Input: ClusterTotalCalls
Source: ClusterTotalCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Percentage of Normal Call Clearing (percent)

Type

CME

Description

The ratio between calls that have a normal termination code and the total number of calls. This metric is the 
opposite of the Percentage of Drop Calls.

Syntax

^(100*((ClusterTotalCalls - ClusterDropCalls)/ClusterTotalCalls))

Formula Input

Input: ClusterDropCalls
Source: ClusterDropCall (Formula)

Input: ClusterTotalCalls
Source: ClusterTotalCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Percentage of Packet Lost (percent)

Type

CME

Description

The ratio between packets lost and the total number of packets sent and received.

Syntax

^(100*(ClusterNbPacketsLost/(ClusterNbPacketsReceived+ClusterNbPacketsSent)))

Formula Input

Input: ClusterNbPacketsLost
Source: ClusterNbPacketsLost (Formula)

Input: ClusterNbPacketsReceived
Source: ClusterNbPacketsReceived (Formula)

Input: ClusterNbPacketsSent
Source: ClusterNbPacketsSent (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Percentage of Successful Calls (percent)

Type

CME

Description

The ratio between successful calls and the total number of calls.

Syntax

^(100*(ClusterSuccessfulCall/(ClusterSuccessfulCall + ClusterUnsuccessfulCall)))

Formula Input

Input: ClusterSuccessfulCall
Source: ClusterSuccessfulCall (Formula)

Input: ClusterUnsuccessfulCall
Source: ClusterUnsuccessfulCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Percentage of TollBypass Calls (percent)

Type

CME

Description

The ratio between toll bypass calls and the total number of calls.

Syntax

^(100*(ClusterTollBypassCall/(ClusterTotalCall)))

Formula Input

Input: ClusterTollBypassCall
Source: ClusterTollBypassCall (Formula)

Input: ClusterTotalCall
Source: ClusterTotalCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Total Hours of Traffic

Type

CME

Description

The total call duration in hours. This formula will be useful for future Erlang calculation.

Syntax

^(duration/3600)

Formula Input

Input: duration
Source: ClusterCallDuration (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Total Number of Company Calls (Nb)

Type

CME

Description

The total number of company calls. This is the opposite of an external call (see Cluster Total Number of 
External Calls (Nb)).

Any call with a caller and callee that is part of the internal dial plan is a company call — for example:

• An intrasite IP call

• An intersite IP call

• An intrasite legacy PBX call

• An intersite legacy PBX call

Syntax

^(ClusterIntrasiteIPCalls+ClusterIntersiteIPCalls+ClusterIntrasiteLegacyPBXCalls
+ClusterIntersiteLegacyPBXCalls)

Formula Input

Input: ClusterIntersiteIPCalls
Source: ClusterIntersiteIPCall (Formula)

Input: ClusterIntersiteLegacyPBXCalls
Source: ClusterIntersiteLegacyPBXCall (Formula)

Input: ClusterIntrasiteIPCalls
Source: ClusterIntrasiteIPCall (Formula)

Input: ClusterIntrasiteLegacyPBXCalls
Source: ClusterIntrasiteLegacyPBXCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Total Number of Company IP Calls (Nb)

Type

CME

Description

The total number of intrasite and intersite IP calls.

Syntax

^(ClusterIntrasiteIPCalls+ClusterIntersiteIPCalls)

Formula Input

Input: ClusterIntersiteIPCalls
Source: ClusterIntersiteIPCall (Formula)

Input: ClusterIntrasiteIPCalls
Source: ClusterIntrasiteIPCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Total Number of Company LegacyPBX Calls (Nb)

Type

CME

Description

The total number of company legacy PBX Calls.

A legacy PBX call is an intrasite or intersite legacy PBX call.

Syntax

^(ClusterIntrasiteLegacyPBXCalls+ClusterIntersiteLegacyPBXCalls)

Formula Input

Input: ClusterIntersiteLegacyPBXCalls
Source: ClusterIntersiteLegacyPBXCall (Formula)

Input: ClusterIntrasiteLegacyPBXCalls
Source: ClusterIntrasiteLegacyPBXCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Total Number of External Calls (Nb)

Type

CME

Description

Any call to or from the PSTN. This is the opposite of a company call (see  Cluster Total Number of 
Company Calls (Nb)).

An external call can be any of the following call types:

• Local

• Long distance

• International

• Incoming 

Syntax

^(ClusterLocalCall + ClusterInternationalCall + ClusterLongDistanceCall + 
ClusterIncomingCall)

Formula Input

Input: ClusterIncomingCall
Source: ClusterIncomingCall (Formula)

Input: ClusterInternationalCall
Source: ClusterInternationalCall (Formula)

Input: ClusterLocalCall
Source: ClusterLocalCall (Formula)

Input: ClusterLongDistanceCall
Source: ClusterLongDistanceCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Total Number of Normal Call Clearing

Type

CME

Description

The total of calls with a normal termination code.

Syntax

^(ClusterTotalCalls - ClusterDropCalls)

Formula Input

Input: ClusterDropCalls
Source: ClusterDropCall (Formula)

Input: ClusterTotalCalls
Source: ClusterTotalCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
Cluster Total Number of Outgoing External Calls (Nb)

Type

CME

Description

The total of outbound calls going to the PSTN. This metric is a subset of Cluster Total Number of 
External Calls (Nb).

An outgoing external call can be any of the following call types:

• Local

• Long distance

• International

Syntax

^(ClusterLocalCall + ClusterInternationalCall + ClusterLongDistanceCall)

Formula Input

Input: ClusterInternationalCall
Source: ClusterInternationalCall (Formula)

Input: ClusterLocalCall
Source: ClusterLocalCall (Formula)

Input: ClusterLongDistanceCall
Source: ClusterLongDistanceCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Chapter 7:  Collection Formulas
ClusterBlocking

Type

Import

Description

Total number of times that call blocking occurred. This can be due to lack of channel availability or switch 
congestion. Error codes 34 and 42 are used in the calculation.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCallDuration

Type

Import

Description

The duration of the call, in seconds.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseCallRejected

Type

Import

Description

Call rejected. Cause code 21.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseChannelUnacceptable

Type

Import

Description

Channel unacceptable. Cause code 6.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseDestinationOutOfOrder

Type

Import

Description

Destination out of order. Cause code 27.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseInvalidNumberFormat

Type

Import

Description

Address incomplete, invalid number format. Cause code 28.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseMisdialedTrunkPrefix

Type

Import

Description

Misdialed trunk prefix. Cause code 5.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseNetworkOutOfOrder

Type

Import

Description

Network out of order. Cause code 38.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseNoAnswerFromUser

Type

Import

Description

No answer from user. Cause code 19.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseNoChannelAvailable

Type

Import

Description

No channel/circuit available. Cause code 34.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseNoRouteToDestination

Type

Import

Description

No route to destination. Cause code 3.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseNoRouteTransitNetwork

Type

Import

Description

No route to specified transit network. Cause code 2.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseNoUserResponding

Type

Import

Description

No user responding to the call. Cause code 18.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseNumberChanged

Type

Import

Description

Number changed. Cause code 22.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
256 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 7:  Collection Formulas
ClusterCauseOther

Type

Import

Description

Unspecified error.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseResourceUnavailable

Type

Import

Description

Resource unavailable or unspecified. Cause code 47.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
258 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 7:  Collection Formulas
ClusterCauseSubscriberAbsent

Type

Import

Description

Subscriber absent. Cause code 20.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 259



Chapter 7:  Collection Formulas
ClusterCauseSwitchCongestion

Type

Import

Description

witching equipment congestion. Cause code 42.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseTemporaryFailure

Type

Import

Description

Temporary failure. Cause code 41.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 261



Chapter 7:  Collection Formulas
ClusterCauseUnassignedNumber

Type

Import

Description

Unassigned or unallocated number. Cause code 1.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterCauseUserBusy

Type

Import

Description

User busy. Cause code 17.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterDropCall

Type

Import

Description

Identifies a call successfully established, but that has been dropped accidentally during the communication 
between the two parties.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterErlangB

Type

Import

Description

Probability that a new arriving call will be rejected because circuits are busy.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterErlang

Type

Import

Description

Distribution of voice traffic tha traverses the PSTN, divided by time.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterForwardToVoiceMail

Type

Import

Description

Identifies a call forwarded to another destination by the original callee. In this case, the destination is the voicemail 
extension number, defined through an addVoiceMailRange() method in the CCMConfig.js file.

This metric is the opposite of Cluster Number of Direct VoiceMail Calls (Nb).

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterIncomingCall

Type

Import

Description

Identifies a call where the caller is not an internal extension.

An incoming call can also be an inbound call or an off-net call that comes from the PSTN. 

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterInternalCall

Type

Import

Description

An internal call is a call between two internal extensions, managed by one or more CallManager clusters, where 
the caller and callee extensions are short, internal numbers.

An Internal call can be any of the following:

• An outbound or inbound call

• A call between two IP phones from the same site

• A call between two IP phones from different sites

• A call between one IP phone and one legacy phone from the same site

• A call between one IP phone and one legacy phone from different sites

• An intrasite or intersite legacy PBX call

• An on-net call (pure IP network transit)

• An off-net call (IP to PSTN Gateway)

An internal call can never be:

• A call between an internal extension and any external PSTN number

Ranges of internal extensions are defined through addExtensionRange() methods in the CCMConfig.js file.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterInternationalCall

Type

Import

Description

Identifies a call where the caller is an internal extension and where the callee is an international external PSTN 
number, according to the numbering plan (NANP or other prefixes). 

An international call can be any of the following call types:

• Outbound

• Off-net, routed towards the PSTN

• Toll bypass, if a remote PSTN Gateway is involved in the Voice path

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterIntersiteIPCall

Type

Import

Description

Identifies a specific internal call where the caller and callee are from different sites and are using a pure IP network 
transit path (that is, no PSTN Gateway is involved in the voice path).

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterIntersiteLegacyPBXCall

Type

Import

Description

Identifies a specific internal call where the caller and callee are from different sites and where the voice path goes 
through a PSTN Gateway.

This type of call occurs between between either:

• One IP phone and one legacy phone from two different sites, according to their extension range number. 
The legacy phone is managed by a legacy PBX, which is interconnected to the CallManager through a PSTN 
Gateway.

In this case, the legacy phone is part of the company’s internal dialplan, but is not at the same physical site.

• Two IP phones that are part of the company’s internal dialplan but are not at the same site, and are using a 
PSTN Gateway somewhere in the voice path.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterIntrasiteIPCall

Type

Import

Description

Identifies a specific internal call where the caller and callee are both at the same site and are using a pure IP 
network transit path (that is, no PSTN Gateway is involved in the voice Path).

Internal extensions are attached to a specific site through the CCMConfig.js file, where one or more 
addExtensionRange() methods are called for particular site objects.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterIntrasiteLegacyPBXCall

Type

Import

Description

Identifies a specific internal Call where the caller and callee are both at the same site, but where the voice path 
goes through a PSTN Gateway.

In this case, the call can be between one IP phone and one legacy phone from the same location, according to 
their extension range number.

The legacy phone is managed by a legacy PBX, which is interconnected to the CallManager through a PSTN 
Gateway. The legacy phone is part of the company’s internal dialplan.

PSTN gateways and ranges of internal extensions and are attached to a specific site through the methods 
addPstnGatewayIpAddress() and addExtensionRange(), respectively. These methods are called for a 
particular site object in the CCMConfig.js file.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterJitter

Type

Import

Description

Provides an estimate of the statistical variance of the RTP data packet interval, in milliseconds.

This metric comes from the CMR table. It is set once the call is established. Also, this metric is available only for 
IP phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterLatency

Type

Import

Description

An estimate of network latency, expressed in milliseconds.

This value represents the average of the difference between the NTP timestamp indicated by the RTP Control 
Protocol (RTCP) messages and the NTP timestamp of the receivers, measured when these messages are received.

Cisco CallManager obtains the average by summing all the estimates, and then dividing by the number of RTCP 
messages that have been received.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterLines

Type

Import

Description

Total number of type-18 interfaces lines.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterLocalCall

Type

Import

Description

Identifies a call where the caller is an internal extension and the callee is a local external PSTN number, according 
to the numbering plan (NANP or other prefixes).

A local call can also be any of these call types:

• Outbound

• Off-net call, routed towards the PSTN

• Toll bypass, if a remote PSTN Gateway is involved in the voice path

The file CCMConfig.js contains methods that specify local call prefixes for a given site. A phone number is 
determined to be a local number if its prefix matches a local prefix specified for a site object in CCMConfig.js.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterLongDistanceCall

Type

Import

Description

Identifies a call where the caller is an internal extension and the callee is a long distance external PSTN number, 
according to the numbering plan (NANP or Other prefixes).

A long distance call can also be any of these call types:

• Outbound

• Off-net, routed towards the PSTN

• Toll bypass, if a remote PSTN Gateway is involved in the voice path

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterMOS

Type

Import

Description

The mean opinion score (MOS). This is a high-level metric.

In voice communications, particularly internet telephony, the MOS provides a numeric measure of the quality of 
human speech at the destination end of the circuit.

There is no algorithm for MOS calculations. This is a subjective metric based on the end-user’s judgment of call 
quality.

The scheme uses subjective scores that are mathematically averaged to obtain a quantitative indicator of the 
performance. To determine MOS, a number of listeners rate the quality of test sentences read aloud over the 
communications circuit by male and female speakers. Listeners give each sentence a rating as follows:

• 1 (bad)

• 2 (poor)

• 3 (fair)

• 4 (good)

• 5 (excellent)

The MOS is the arithmetic mean of all the individual scores. It can range from 1 (worst) to 5 (best). In our context, 
our MOS calculation is based on the consolidation of Jitter, latency, and packets lost, which give a good overview 
of the real MOS value.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterNbPacketsLost

Type

Import

Description

Total number of packets that the sub-element loses during a call.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterNbPacketsReceived

Type

Import

Description

Total number of packets that the sub-element receives during a call.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterNbPacketsSent

Type

Import

Description

Total number of packets that the sub-element sends during a call.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterOffNetCall

Type

Import

Description

Identifies a call where at least one PSTN Gateway is involved in the voice path, with the following criteria:

• Inbound or outbound call

• Internal call, or a call to/from a PSTN number

• Intersite or intrasite legacy PBX call

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterOnNetCall

Type

Import

Description

Identifies a call where both the caller and callee are internal extensions, from the same site or different sites, and 
with the following criteria:

• Outbound call

• Internal call

• Intersite or intrasite IP call

• No PSTN Gateway is involved in the voice path

• A pure IP-to-IP call

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterShortCall

Type

Import

Description

Identifies a call successfully established, but with a call duration of less than one second. In this case, the 
CallManager set the CallDuration value to 0 in the CDR table.

A short call is also:

• A successful call

• Any inbound, outbound, or other type of call described in this chapter

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterSuccessfulCall

Type

Import

Description

Identifies a call successfully established. Once the call is established, the communication starts between the two 
parties.

A successful call can be inbound, outbound, or any other type of call described in this chapter.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterTollBypassCall

Type

Import

Description

Identifies a call where the caller is an internal extension managed by the CallManager, and where the callee can 
be an internal extension or any external PSTN number, with one or more of the following criteria:

• Outbound call

• Off-net call

• The call is going through a PSTN Gateway, and the caller site and PSTN Gateway site are different

An intersite legacy PBX call can be also a toll bypass call if the PSTN Gateway site is different from the caller site.

Toll bypass calls can save money on long distance or international calls by using a remote PSTN Gateway with 
local fees. For example: A caller in Boston makes a call to an external PSTN number in London. Because there 
is an IP-VPN between the Boston office and the London office with a PSTN Gateway in London, the call goes 
through the IP network until the London office’s PSTN Gateway.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterTotalCall

Type

Import

Description

Total number of calls,including call attempts, for the entire cluster.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterTotalHoursOfTraffic

Type

Import

Description

Sum of all call durations for the period, measured in hours.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterUnsuccessfulCall

Type

Import

Description

Identifies a call that has not been successfully established. In this case, the call setup has been rejected, and 
communication between the two parties never started.

An unsuccessful call can be inbound, outbound, or any other type of call described in this chapter.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 291



Chapter 7:  Collection Formulas
ClusterVoicemailCallDuration

Type

Import

Description

Duration of a call with the voicemail application, in seconds.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterVoiceMailCall

Type

Import

Description

Identifies a call where the final destination (callee) is voicemail. The voicemail application is managed through a 
specific range of extensions numbers, defined site by site, using the global variable VoiceMailExtensionRange.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
ClusterVoicemailPackets

Type

Import

Description

Number of packets that the sub-element sent and received during a voicemail call. 

This metric comes from the CMR table. It is set once the call is established with one of the voicemail extensions.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CLUSTER
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Chapter 7:  Collection Formulas
CS

Type

Import

Description

The number of seconds of concealment during a call.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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Chapter 7:  Collection Formulas
DropCall

Type

Import

Description

Identifies a call successfully established, but that has been dropped accidentally during the communication 
between the two parties.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
DSP Card Availability (percent)

Type

SNMP (collection)

Description

DSP card availability percentage.

Syntax

Def DefaultNoRespResult 0;

Dim I1 AS Integer Default * NAME Interface;

100 * abs( delta(sysUpTime.0) * (1 + distrib(cdspCardState.%I1,"==1:1,==2:1,==3:-
1,==4:-1,==5:-1") )/2 - delta(sysUpTime.0)/2 * abs( 
delta(distrib(cdspCardState.%I1,"==1:1,==2:1,==3:-1,==4:-1,==5:-1"))/2 ) ) / 
delta(sysUpTime.0)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > DSP Card

MIB

rfc1213-MIB-II

CISCO-DSP-MGMT-MIB.my
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Chapter 7:  Collection Formulas
DSP Card Resource Utilization (percent)

Type

SNMP (collection)

Description

Total percentage of DSPs in use for a DSP card.

Syntax

cdspCardResourceUtilization.%I1

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > DSP Card

MIB

CISCO-DSP-MGMT-MIB.my
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Chapter 7:  Collection Formulas
EncryptedCallsActive

Type

Import

Description

Total number of currently active encrypted calls.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 299



Chapter 7:  Collection Formulas
EncryptedPartiallyRegisteredPhones

Type

Import

Description

Total number of encrypted extensions that have not completed the registration process.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
EncryptedRegisteredPhones

Type

Import

Description

Total number of active authenticated calls.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
ForwardToVoiceMail

Type

Import

Description

Identifies a call forwarded to another destination by the original callee. In this case, the destination is one of the 
voicemail extension numbers. Voicemail extension numbers are defined for a site through 
addVoiceMailRange() methods in the CCMConfig.js file.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
FXOPortsActive

Type

Import

Description

Total number of FXO ports currently in use in the target device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 303



Chapter 7:  Collection Formulas
FXOPortsInService

Type

Import

Description

Total number of FXO ports available in the target device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
FXSPortsActive

Type

Import

Description

Total number of FXS ports currently in use in the target device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
FXSPortsInService

Type

Import

Description

Total number of FXS ports available in the target device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
Gatekeeper Buffer Utilization (percent)

Type

SNMP (collection)

Description

The percentage of a gatekeeper device’s buffer space that is in use.

Syntax

100*((bufferSmTotal.0+bufferMdTotal.0+bufferBgTotal.0+bufferLgTotal.0+bufferHgTo
tal.0)-
(bufferSmFree.0+bufferMdFree.0+bufferBgFree.0+bufferLgFree.0+bufferHgFree.0))/(b
ufferSmTotal.0+bufferMdTotal.0+bufferBgTotal.0+bufferLgTotal.0+bufferHgTotal.0)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

cisco-10-mib
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Chapter 7:  Collection Formulas
Gatekeeper Call Setup Quality (percent)

Type

SNMP (collection)

Description

Percentage of calls that have been set up successfully.

Syntax

100 * (delta(cgkStatsAdmissionConfirms.0) + delta(cgkStatsRcvdLocationConfirms.0) 
+ delta(cgkStatsSentLocationConfirms.0)) / (delta(cgkStatsAdmissionConfirms.0) + 
delta(cgkStatsRcvdLocationConfirms.0) + delta(cgkStatsSentLocationConfirms.0) + 
delta(cgkStatsAdmissionRejects.0) + delta(cgkStatsRcvdLocationRejects.0) + 
delta(cgkStatsSentLocationRejects.0))

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

CISCO-GATEKEEPER-MIB.my
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Chapter 7:  Collection Formulas
Gatekeeper CPU Utilization (percent) (avg last 5 mn)

Type

SNMP (collection)

Description

CPU utilization percentage over the last five minutes.

Syntax

avgBusy5.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

cisco-10-mib
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Chapter 7:  Collection Formulas
Gatekeeper ICMP Inbound Errors (percent)

Type

SNMP (collection)

Description

Percentage of inbound ICMP packets that triggered errors.

Syntax

(100*(delta(icmpInErrors.0)/distrib(delta(icmpInMsgs.0), "==0:1, 
default:*")))*distrib(delta(sysUpTime.0), "default:1"); 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Gatekeeper ICMP Outbound Errors (percent)

Type

SNMP (collection)

Description

Percentage of outbound ICMP packets that triggered errors.

Syntax

(100*(delta(icmpOutErrors.0)/distrib(delta(icmpOutMsgs.0), "==0:1, 
default:*")))*distrib(delta(sysUpTime.0), "default:1"); 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Gatekeeper Packet Errors (Nb)

Type

SNMP (collection)

Description

Total number of packet errors for a gatekeeper device.

Syntax

V1=OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(ifInDiscards.%I1) + delta(ifInErrors.%I1) + delta(ifInUnknownProtos.%I1)));

V2=OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(ifOutDiscards.%I1) + delta(ifOutErrors.%I1)));

%V1 + %V2; 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Gatekeeper Total Number of Admission Rejects (Nb)

Type

SNMP (collection)

Description

Total number of admission rejections.

Syntax

V1=OIDVAL(distrib(delta(sysUpTime.0), "default:1") * 
delta(cgkStatsAdmissionRejects.0));

%V1; 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

rfc1213-MIB-II

CISCO-GATEKEEPER-MIB.my
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Chapter 7:  Collection Formulas
Gatekeeper Total Number of Admission Requests (Nb)

Type

SNMP (collection)

Description

Total number of gatekeeper admission requests.

Syntax

V1=OIDVAL(distrib(delta(sysUpTime.0), "default:1") * 
delta(cgkStatsAdmissionRequests.0));

%V1; 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

CISCO-GATEKEEPER-MIB.my

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Gatekeeper Total Number of Concurrent Calls (Nb) (Gauge)

Type

SNMP (collection)

Description

Total number of concurrent calls for a gatekeeper device.

Syntax

cgkStatsTotalConcurrentCalls.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

CISCO-GATEKEEPER-MIB.my
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Chapter 7:  Collection Formulas
Gatekeeper Total Number of Location Rejects (Nb)

Type

SNMP (collection)

Description

Total number of location reject messages that a gatekeeper device sent and received.

Syntax

V1=OIDVAL(distrib(delta(sysUpTime.0), "default:1") * ( 
delta(cgkStatsRcvdLocationRejects.0) + delta(cgkStatsSentLocationRejects.0 )));

%V1; 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

rfc1213-MIB-II

CISCO-GATEKEEPER-MIB.my
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Chapter 7:  Collection Formulas
Gatekeeper Total Number of Location Requests (Nb)

Type

SNMP (collection)

Description

Total number of location requests that a gatekeeper device sent and received.

Syntax

V1=OIDVAL(distrib(delta(sysUpTime.0), "default:1") * ( 
delta(cgkStatsRcvdLocationRequests.0) + delta(cgkStatsSentLocationRequests.0)) 
);

%V1; 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

rfc1213-MIB-II

CISCO-GATEKEEPER-MIB.my
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Chapter 7:  Collection Formulas
Gatekeeper Total Number of Registered EndPoints (Nb)

Type

SNMP (collection)

Description

Total number of endpoints registered to a Cisco gatekeeper.

Syntax

cgkStatsRegisteredEndpoints.0

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

CISCO-GATEKEEPER-MIB.my
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Chapter 7:  Collection Formulas
Gatekeeper Total Packets (Nb)

Type

SNMP (collection)

Description

Total number of packets that the gatekeeper device sent and received.

Syntax

V1=OIDVAL(distrib(delta(sysUpTime.0), "default:1") * ( delta(ipForwDatagrams.0) + 
delta(ipOutRequests.0) + delta(ipInReceives.0) ));

%V1; 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
GatewayCallsActive

Type

Import

Description

Total number of currently active calls for the gateway resource or resources specified.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
H323CallsActive

Type

Import

Description

Total number of currently active H.323 calls for the resource or resources specified.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
H323CallsInProgress

Type

Import

Description

Total number of H.323 calls being established at the time of sampling.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
HuntlistCallsActive

Type

Import

Description

Total number of currently active huntlist calls.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
HuntlistCallsInProgress

Type

Import

Description

Total number of currently active huntlist calls.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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Chapter 7:  Collection Formulas
ICR

Type

Import

Description

Interval Conceal Ratio. The average concealment rate measured during the last three seconds of speech.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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Chapter 7:  Collection Formulas
ICRmx

Type

Import

Description

Maximum conceal ratio during a call.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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Chapter 7:  Collection Formulas
Inbound Loss (percent)

Type

Generic

Description

Of all inbound traffic received by this entity, the percentage of PDUs that either:

• Contained defects (such bad checksums or bad length) that prevented them from being deliverable to a 
higher-layer protocol.

• Were discarded even though no errors were detected (that is, due to congestion, policing, or resource 
limitations).

• Were discarded because they were of an unknown or unsupported protocol.

Alias For

No formulas are mapped to this alias.

Formula Editor Path

AP > Generic > Universal > Other
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Chapter 7:  Collection Formulas
Incoming

Type

Import

Description

Identifies a call where caller is not an internal extension.

An Incoming call is also:

• An Inbound call

• An off-net call, coming from the PSTN

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
Interface Availability (percent)

Type

Generic

Description

The percentage of time that this interface was in an operational state.

Alias For

Availability (percent)

Formula Editor Path

AP > Generic > Universal > Availability
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Chapter 7:  Collection Formulas
Interface Availability (percent)

Type

SNMP (collection)

Description

Percentage of availability of a PSTN gateway interface.

Syntax

Def DefaultNoRespResult 0;

Dim I1 AS Integer Default * NAME Interface;

100 * abs( delta(sysUpTime.0) * (1 + distrib(ifOperStatus.%I1,"==1:1,==2:-1,==3:-
1") )/2 - delta(sysUpTime.0)/2 * abs( delta(distrib(ifOperStatus.%I1,"==1:1,==2:-
1,==3:-1"))/2 ) ) / delta(sysUpTime.0)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Availability (percent)

Type

SNMP (collection)

Description

Interface availability percentage for a Cisco gatekeeper.

Syntax

Def DefaultNoRespResult 0;

Dim I1 AS Integer Default * NAME Interface;

100 * abs( delta(sysUpTime.0) * (1 + distrib(ifOperStatus.%I1,"==1:1,==2:-1,==3:-
1") )/2 - delta(sysUpTime.0)/2 * abs( delta(distrib(ifOperStatus.%I1,"==1:1,==2:-
1,==3:-1"))/2 ) ) / delta(sysUpTime.0)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Bandwidth Utilization In (percent)

Type

SNMP (collection)

Description

Inbound bandwidth utilization percentage for a PSTN gateway interface.

Syntax

Dim I1 AS Integer Default *;

100 * 8 * delta(ifInOctets.%I1) / ((delta(sysUpTime.0) / 100) * ifSpeed.%I1) * 
distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Bandwidth Utilization In (percent)

Type

SNMP (collection)

Description

Inbound bandwidth utilization measured on a Gatekeeper interface.

Syntax

Dim I1 AS Integer Default *;

100 * 8 * delta(ifInOctets.%I1) / ((delta(sysUpTime.0) / 100) * ifSpeed.%I1) * 
distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Bandwidth Utilization Out (percent)

Type

SNMP (collection)

Description

Outbound bandwidth utilization percentage for a PSTN gateway interface.

Syntax

Dim I1 AS Integer Default *;

100 * 8 * delta(ifOutOctets.%I1) / ((delta(sysUpTime.0) / 100) * ifSpeed.%I1) * 
distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Bandwidth Utilization Out (percent)

Type

SNMP (collection)

Description

Outbound bandwidth utilization measured on a Gatekeeper interface.

Syntax

Dim I1 AS Integer Default *;

100 * 8 * delta(ifOutOctets.%I1) / ((delta(sysUpTime.0) / 100) * ifSpeed.%I1) * 
distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Packet Loss (percent)

Type

SNMP (collection)

Description

Percentage of interface packet loss.

Syntax

Dim I1 AS Integer Default * NAME Interface;

100 * (delta(ifInErrors.%I1) + delta(ifInUnknownProtos.%I1) + 
delta(ifInDiscards.%I1) + delta(ifOutErrors.%I1) + delta(ifOutDiscards.%I1)) / 
distrib(delta(ifInUcastPkts.%I1) + delta(ifInNUcastPkts.%I1) + 
delta(ifInDiscards.%I1) + delta(ifInErrors.%I1) + delta(ifInUnknownProtos.%I1) + 
delta(ifOutUcastPkts.%I1) + delta(ifOutNUcastPkts.%I1) + delta(ifOutDiscards.%I1) 
+ delta(ifOutErrors.%I1),"==0:1,default:*") * distrib(delta(sysUpTime.0), 
"default:1") * distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Packet Loss (percent)

Type

SNMP (collection)

Description

Total percentage of packets lost for a gatekeeper interface.

Syntax

Dim I1 AS Integer Default * NAME Interface;

100 * (delta(ifInErrors.%I1) + delta(ifInUnknownProtos.%I1) + 
delta(ifInDiscards.%I1) + delta(ifOutErrors.%I1) + delta(ifOutDiscards.%I1)) / 
distrib(delta(ifInUcastPkts.%I1) + delta(ifInNUcastPkts.%I1) + 
delta(ifInDiscards.%I1) + delta(ifInErrors.%I1) + delta(ifInUnknownProtos.%I1) + 
delta(ifOutUcastPkts.%I1) + delta(ifOutNUcastPkts.%I1) + delta(ifOutDiscards.%I1) 
+ delta(ifOutErrors.%I1),"==0:1,default:*") * distrib(delta(sysUpTime.0), 
"default:1") * distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Throughput In (kbps)

Type

SNMP (collection)

Description

Inbound interface throughput measured in kilobits per second.

Syntax

Dim I1 AS Integer Default * NAME Interface;

(8 * delta(ifInOctets.%I1) / (delta(sysUpTime.0)/100))/1000 * 
distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Throughput In (kbps)

Type

SNMP (collection)

Description

Total inbound throughput for a Gatekeeper interface, measured in kilobits per second.

Syntax

Dim I1 AS Integer Default * NAME Interface;

(8 * delta(ifInOctets.%I1) / (delta(sysUpTime.0)/100))/1000 * 
distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Throughput Out (kbps)

Type

SNMP (collection)

Description

Outbound interface throughput measured in kilobits per second.

Syntax

Dim I1 AS Integer Default * NAME Interface;

(8 * delta(ifOutOctets.%I1) / (delta(sysUpTime.0)/100))/1000 * 
distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Interface Throughput Out (kbps)

Type

SNMP (collection)

Description

Total outbound throughput for a Gatekeeper interface, measured in kilobits per second.

Syntax

Dim I1 AS Integer Default * NAME Interface;

(8 * delta(ifOutOctets.%I1) / (delta(sysUpTime.0)/100))/1000 * 
distrib(delta(ifLastChange.%I1), "==0:1")

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Interface

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
Internal

Type

Import

Description

A call between two internal extensions, managed by one or more CallManager clusters, where the caller and callee 
extension numbers are short, internal numbers.

An internal call can be:

• An outbound or inbound call

• A call between two IP phones from the same site

• A call between two IP phones from different sites

• A call between one IP phone and one legacy phone from the same site

• A call between one IP phone and one legacy phone from different sites

• An intrasite or intersite legacy PBX call

• An on-net call (pure IP network transit)

• An off-net call (IP to PSTN Gateway call)

An internal call can never be:

• A call between an internal extension and any external PSTN number.

Ranges of internal extensions are defined through addExtensionRange() methods in the CCMConfig.js file.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
International

Type

Import

Description

Identifies a call where the caller is an internal extension and the callee is an international external PSTN number, 
according to the numbering plan (NANP or other prefixes).

An international call is also:

• An outbound call

• An off-net call, routed towards the PSTN

• A toll bypassCall, if a remote PSTN Gateway is involved in the voice path

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
IntersiteIPCall

Type

Import

Description

Identifies a specific internal Call where caller and callee are from different sites and are using a pure IP network 
transit path (that is, no PSTN Gateway is involved in the voice Path).

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Chapter 7:  Collection Formulas
IntersiteLegacyPBXCall

Type

Import

Description

Identifies a specific internal call where the caller and callee are from different sites and where the voice path goes 
through a PSTN Gateway.

The call can be between any of the following:

• One IP phone and one legacy phone from two different siteas, according to their extension range number. 
The legacy phone is managed by a legacy PBX, which is interconnected to the CallManager through a PSTN 
Gateway.

In this case, the legacy phone is part of the company’s internal dialplan, but is not at the same physical site.

• Two IP phones, which are part of the company’s internal dialplan, are not on the same site, and are using a 
PSTN Gateway somewhere in the voice path.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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IntrasiteIPCall

Type

Import

Description

Identifies a specific internal Call where the caller and callee are both at the same site and are using a pure IP 
Network transit path (that is, no PSTN Gateway is involved in the voice path).

Ranges of internal extensions are defined for a specific site through addExtensionRange() methods called for 
the site object in the CCMConfig.js file.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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IntrasiteLegacyPBXCall

Type

Import

Description

Identifies a specific internal Call where the caller and callee are both at the same site, but where the voice path 
goes through a PSTN Gateway.

The call can be between one IP phone and one legacy phone from the same location, according to their extension 
range number.

The legacy phone is managed by a legacy PBX, which is interconnected to the CallManager through a PSTN 
Gateway. In this case, the legacy phone is part of the company’s internal dialplan.

PSTN gateways and ranges of internal extensions and are attached to a specific site through the methods 
addPstnGatewayIpAddress() and addExtensionRange(), respectively. These methods are called for a 
particular site object in the CCMConfig.js file.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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isCallee

Type

Import

Description

Identifies the callee portion of the call.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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isCaller

Type

Import

Description

Identifies the caller portion of the call.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Jitter

Type

Import

Description

Provides an estimate of the statistical variance of the RTP data packet interval, in milliseconds.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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Latency

Type

Import

Description

An estimate of network latency, expressed in milliseconds.

This value represents the average of the difference between the NTP timestamp indicated by the RTP Control 
Protocol (RTCP) messages and the NTP timestamp of the receivers, measured when these messages are received.

Cisco CallManager obtains the average by summing all the estimates, and then dividing by the number of RTCP 
messages that have been received.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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Local

Type

Import

Description

Identifies a call where the caller is an internal extension and the callee is a local external PSTN number, according 
to the numbering plan (NANP or other prefixes).

A local call is also any of these call types:

• Outbound

• Off-net, routed towards the PSTN

• Toll bypass, if a remote PSTN Gateway is involved in the voice path

The file CCMConfig.js contains methods that specify local call prefixes for a given site. A phone number is 
determined to be a local number if its prefix matches a local prefix specified for a site object in CCMConfig.js.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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LongDistance

Type

Import

Description

Identifies a call where the caller is an internal extension and where the callee is a long distance external PSTN 
number, according to the numbering plan (NANP or other prefixes).

A long distance call is also any of these call types:

• Outbound

• Off-net, routed towards the PSTN

• Toll bypass, if a remote PSTN Gateway is involved in the voice path

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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MLQKav

Type

Import

Description

Average MOS Listening Quality K-factor for a call

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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MLQK

Type

Import

Description

MOS Listening Quality K-factor. This is an estimate of the MOS score of the last eight seconds of speech 
measured on the receiving end.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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MLQKmn

Type

Import

Description

Minimum MOS Listening Quality K-factor for the worst-sounding eight seconds.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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MOHMulticastResourceActive

Type

Import

Description

Total number of currently active message-on-hold multicast resources.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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MOHMulticastResourceAvailable

Type

Import

Description

Total number of available message-on-hold multicast resources.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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MOHTotalMulticastResources

Type

Import

Description

Total number of active and inactive message-on-hold multicast resources.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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MOHTotalUnicastResources

Type

Import

Description

Total number of active and inactive message-on-hold unicast resources.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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MOHUnicastResourceActive

Type

Import

Description

Total number of currently active message-on-hold unicast resources.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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MOHUnicastResourceAvailable

Type

Import

Description

Total number of available message-on-hold unicast resources.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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MOS

Type

Import

Description

The mean opinion score (MOS). This is a high-level metric.

In voice communications, particularly internet telephony, the MOS provides a numeric measure of the quality of 
human speech at the destination end of the circuit.

There is no algorithm for MOS calculations. This is a subjective metric based on the end-user’s judgment of call 
quality.

The scheme uses subjective scores that are mathematically averaged to obtain a quantitative indicator of the 
performance. To determine MOS, a number of listeners rate the quality of test sentences read aloud over the 
communications circuit by male and female speakers. Listeners give each sentence a rating as follows:

• 1 (bad)

• 2 (poor)

• 3 (fair)

• 4 (good)

• 5 (excellent)

The MOS is the arithmetic mean of all the individual scores. It can range from 1 (worst) to 5 (best). In our context, 
our MOS calculation is based on the consolidation of Jitter, latency, and packets lost, which give a good overview 
of the real MOS value.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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NbPacketsLost

Type

Import

Description

Number of packets the sub-element lost during a call.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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NbPacketsReceived

Type

Import

Description

Number of packets that the sub-element received during a call.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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NbPacketsSent

Type

Import

Description

Number of packets that the sub-element sent during a call.

This metric comes from the CMR table. It is set once the call is established. This metric is only available for IP 
phones.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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Chapter 7:  Collection Formulas
OffNet

Type

Import

Description

Identifies a call where at least one PSTN Gateway is involved in the voice path, with the following criteria:

• Inbound or outbound call

• Internal call or call to/from a PSTN number

• Intersite or intrasite legacy PBX call

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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OnNet

Type

Import

Description

Identifies a call where both the caller and callee are internal extensions, from the same site or different sites, with 
the following criteria:

• Outbound call

• Internal call

• Intersite or intrasite IP call

• No PSTN Gateway is involved in the voice path

• The call is a pure IP to IP call

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Outbound Loss (percent)

Type

Generic

Description

Out of all outbound traffic to be sent by this entity, the percentage of PDUs that either:

• Contained defects that prevented them from being transferable

• Were discarded even though no errors were detected (that is, due to congestion or resource limitations)

Alias For

No formulas are mapped to this alias.

Formula Editor Path

AP > Generic > Universal > Other
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Percentage of Company Calls (percent) CME(Bulk) VOIP Cisco

Type

CME

Description

Ratio between company calls and the total number of calls.

For a definition of company calls, see Cluster Total Number of Company Calls (Nb).

Syntax

(isCaller + isCallee) = 0 ifTrue: [^nil].

^(100*((IntrasiteIPCalls+IntersiteIPCalls+IntrasiteLegacyPBXCalls+IntersiteLegac
yPBXCalls)/(isCaller+isCallee)))

Formula Input

Input: IntersiteIPCalls
Source: IntersiteIPCall (Formula)

Input: IntersiteLegacyPBXCalls
Source: IntersiteLegacyPBXCall (Formula)

Input: IntrasiteIPCalls
Source: IntrasiteIPCall (Formula)

Input: IntrasiteLegacyPBXCalls
Source: IntrasiteLegacyPBXCall (Formula)

Input: isCallee
Source: isCallee (Formula)

Input: isCaller
Source: isCaller (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Percentage of Drop Calls (percent) CME(Bulk) VOIP Cisco

Type

CME

Description

Ratio between dropped calls and the total number of calls.

Syntax

(isCaller + isCallee) = 0 ifTrue: [^nil].

^(100*(DropCalls/(isCaller + isCallee)))

Formula Input

Input: DropCalls
Source: DropCall (Formula)

Input: isCallee
Source: isCallee (Formula)

Input: isCaller
Source: isCaller (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Percentage of Packet Lost (percent) CME(Bulk) VOIP Cisco

Type

CME

Description

Ratio between packets lost and the total number of packets sent and received.

Syntax

^(100*(NbPacketsLost/(NbPacketsReceived+NbPacketsSent)))

Formula Input

Input: NbPacketsLost
Source: NbPacketsLost (Formula)

Input: NbPacketsReceived
Source: NbPacketsReceived (Formula)

Input: NbPacketsSent
Source: NbPacketsSent (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Percentage of Successful Calls (Nb) CME(Bulk) VOIP Cisco

Type

CME

Description

Ratio between the number of successful calls and the total number of calls.

Syntax

(successful+unsuccessful) = 0 ifTrue: [^nil].

^(100*(successful/(successful+unsuccessful)))

Formula Input

Input: successful
Source: SuccessfulCall (Formula)

Input: unsuccessful
Source: UnsuccessfulCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Percentage of TollBypass Calls (percent) CME(Bulk) VOIP Cisco

Type

CME

Description

Ratio between toll bypass calls and the total number of calls.

Syntax

(isCaller + isCallee) = 0 ifTrue: [^nil].

^(100*(TollBypassCall/(isCaller + isCallee)))

Formula Input

Input: isCallee
Source: isCallee (Formula)

Input: isCaller
Source: isCaller (Formula)

Input: TollBypassCall
Source: TollBypassCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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PSTN Gateway Active DS0 Channels (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of currently active DS0 channels for a PSTN gateway PRI.

Syntax

DEF SaveAlias 10703;

cpmActiveDS0s.0

Generic Database Alias

PSTN Gateway Active DS0 Channels (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > POP DS0 Channel Usage

MIB

CISCO-POP-MGMT-MIB.my
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Chapter 7:  Collection Formulas
PSTN Gateway Active DS0 Channels (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of currently active DS0 channels for a PSTN gateway.

Syntax

DEF SaveAlias 10703;

Dim I0 AS Integer Default * NAME If;

V1=OIDVAL( 8 * delta(ifOutOctets.%I0) );

V2=OIDVAL(delta(sysUpTime.0)/100) ;

V3=OIDVAL((%V1/%V2)/64000);

V4=OIDVAL(int(%V3));

V5=OIDVAL(distrib(ifType.%I0, "==18:1,default:0"));

Sum(*, %V4*%V5)

Generic Database Alias

PSTN Gateway Active DS0 Channels (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > 6500 DS0 Channel

MIB

rfc2233-IF-MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
PSTN Gateway Active DS0 Channels (Nb)

Type

Generic

Description

The total number of active DS0 channels for all of the enabled PRIs in a PSTN device.

Alias For

PSTN Gateway Active DS0 Channels (Nb) (Gauge)

PSTN Gateway Active DS0 Channels (Nb) (Gauge)

PSTN Gateway Total Active DS0 Channels (Nb) (Gauge)

Formula Editor Path

AP > Generic > VOIP > Cisco > PSTN Gateway
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PSTN Gateway Call Setup Quality (percent) (Successful / Total)

Type

Generic

Description

Percentage of successful call setups for a PSTN gateway device.

Alias For

PSTN Gateway Call Setup Quality (percent) (successful / Total)

PSTN Gateway Call Setup Quality (percent) (successful / unsuccessful)

Formula Editor Path

AP > Generic > VOIP > Cisco > PSTN Gateway
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PSTN Gateway Call Setup Quality (percent) (successful / Total)

Type

SNMP (collection)

Description

The percentage of successful call setups for a PSTN gateway device.

Syntax

DEF SaveAlias 10708;

V1= OIDVAL(sum(*, delta(isdnSigStatsInCalls.*)));

V2= OIDVAL(sum(*, delta(isdnSigStatsOutCalls.*)));

V3= OIDVAL(sum(*, delta(isdnSigStatsInConnected.*)));

V4= OIDVAL(sum(*, delta(isdnSigStatsOutConnected.*)));

100*((%V3+%V4) / (%V1+%V2))

Generic Database Alias

PSTN Gateway Call Setup Quality (percent) (Successful / Total)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > ISDN DS0 Channel Usage

MIB

rfc2127-ISDN-MIB
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PSTN Gateway Call Setup Quality (percent) (successful / 
unsuccessful)

Type

SNMP (collection)

Description

Total call setup quality for a PSTN device (successful/unsuccessful).

Syntax

DEF SaveAlias 10708;

100*(delta(cpmCallVolSuccISDNDigital.0) / delta(cpmCallVolSuccISDNDigital.0) + 
delta(cpmISDNCallsRejected.0) + delta(cpmISDNCallsClearedAbnormally.0) + 
delta(cpmISDNNoResource.0))

Generic Database Alias

PSTN Gateway Call Setup Quality (percent) (Successful / Total)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > POP DS0 Channel Usage

MIB

CISCO-POP-MGMT-MIB.my
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PSTN Gateway DS1 Active DS0 Channels (Nb)

Type

SNMP (collection)

Description

Number of active DS0 channels that are active for a specific serial E1/T1 interface. 

Because there is no specific OID for this measurement in the MIB, this metric assumes the following:

• 1 Call = 1 DS0 Channel = 64 kbps

• Throughput (in or out) / 64000 = Active Channels

Syntax

Dim I1 AS Integer Default * NAME If;

V1=OIDVAL( 8 * delta(ifOutOctets.%I1) );

V2=OIDVAL(delta(sysUpTime.0)/100);

V3=OIDVAL((%V1/%V2)/64000);

V4=OIDVAL(int(%V3));

V5=OIDVAL(distrib(ifType.%I1, "==18:1,default:0"));

%V4*%V5

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > 6500 DS0 Channel

MIB

rfc1907-SNMPv2-MIB

rfc2233-IF-MIB
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PSTN Gateway ICMP Inbound Errors (percent)

Type

SNMP (collection)

Description

Percentage of inbound ICMP errors.

Syntax

(100*(delta(icmpInErrors.0)/distrib(delta(icmpInMsgs.0), "==0:1, 
default:*")))*distrib(delta(sysUpTime.0), "default:1"); 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Device

MIB

rfc1213-MIB-II
382 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 7:  Collection Formulas
PSTN Gateway ICMP Outbound Errors (percent)

Type

SNMP (collection)

Description

Percentage of outbound SNMP errors.

Syntax

(100*(delta(icmpOutErrors.0)/distrib(delta(icmpOutMsgs.0), "==0:1, 
default:*")))*distrib(delta(sysUpTime.0), "default:1"); 

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Device

MIB

rfc1213-MIB-II
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Chapter 7:  Collection Formulas
PSTN Gateway Network Errors (percent)

Type

SNMP (collection)

Description

Percentage of network errors observed by a PSTN gateway.

Syntax

distrib(delta(sysUpTime.0), "default:1") * 
((delta(ipOutDiscards.0)+delta(ipInDiscards.0)+delta(ipOutNoRoutes.0)+delta(icmp
InErrors.0)+delta(icmpOutErrors.0))/(delta(ipForwDatagrams.0) + 
delta(ipOutRequests.0) + delta(ipInReceives.0)))*100

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Device

MIB

rfc1213-MIB-II
384 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 7:  Collection Formulas
PSTN Gateway Packet Discards

Type

SNMP (collection)

Description

The total number of PSTN Gateway packets discarded.

Syntax

distrib(delta(sysUpTime.0), "default:1") * 
((delta(ipOutDiscards.0)+delta(ipInDiscards.0))/(delta(ipForwDatagrams.0) + 
delta(ipOutRequests.0) + delta(ipInReceives.0)))*100

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Device

MIB

rfc1213-MIB-II
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PSTN Gateway Total Active DS0 Channels (Nb) (Gauge)

Type

SNMP (collection)

Description

The total number of currently active DS0 channels for a PSTN Gateway.

Syntax

DEF SaveAlias 10703;

V1= OIDVAL(sum(*, distrib(isdnBearerOperStatus.%I1, 
"==1:0,==2:0,==3:0,==4:1")));

%V1

Generic Database Alias

PSTN Gateway Active DS0 Channels (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > ISDN DS0 Channel Usage

MIB

rfc2127-ISDN-MIB
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Chapter 7:  Collection Formulas
PSTN Gateway Total Call Signaling Errors (Nb)

Type

SNMP (collection)

Description

The total number of signaling errors observed for a PSTN Gateway.

Syntax

DEF SaveAlias 10707;

delta(cpmISDNCallsRejected.0) + delta(cpmISDNCallsClearedAbnormally.0) + 
delta(cpmISDNNoResource.0)

Generic Database Alias

PSTN Gateway Total Number of Unsuccessful Calls (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > POP DS0 Channel Usage

MIB

CISCO-POP-MGMT-MIB.my
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PSTN Gateway Total Calls per minute (calls/mn) (sum of all DS0s)

Type

SNMP (collection)

Description

The total calls per minute summed for all configured PRIs on a PSTN Gateway.

Syntax

DEF SaveAlias 10705;

V1= OIDVAL(sum(*, 
(delta(cpmCallCount.%I1.%I2.%I3)/(delta(sysUpTime.0)/100))/60));

%V1

Generic Database Alias

PSTN Gateway Total Number of Calls per mn (Calls/mn)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > POP DS0 Channel Usage

MIB

CISCO-POP-MGMT-MIB.my

rfc1213-MIB-II
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PSTN Gateway Total Number Calls Rejected (Nb)

Type

SNMP (collection)

Description

The total number of rejected calls for a PSTN Gateway.

Syntax

DEF SaveAlias 10707;

V1= OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(isdnSigStatsOutConnected.*)));

V2= OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(isdnSigStatsOutCalls.*)));

V3= OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(isdnSigStatsInConnected.*)));

V4= OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(isdnSigStatsInCalls.*)));

(%V2-%V1) + (%V4-%V3)

Generic Database Alias

PSTN Gateway Total Number of Unsuccessful Calls (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > ISDN DS0 Channel Usage

MIB

rfc2127-ISDN-MIB

rfc1213-MIB-II
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PSTN Gateway Total Number of Calls (Nb)

Type

Generic

Description

The total number of calls for a PSTN device.

Alias For

PSTN Gateway Total Number of Calls

PSTN Gateway Total Number of Calls (sum of all DS0s)

Formula Editor Path

AP > Generic > VOIP > Cisco > PSTN Gateway
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PSTN Gateway Total Number of Calls (sum of all DS0s)

Type

SNMP (collection)

Description

The total number of currently active calls for all DS0s configured in a PSTN Gateway.

Syntax

DEF SaveAlias 10704;

V1= OIDVAL(sum(*, delta(cpmCallCount.%I1.%I2.%I3)));

%V1

Generic Database Alias

PSTN Gateway Total Number of Calls (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > POP DS0 Channel Usage

MIB

CISCO-POP-MGMT-MIB.my
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PSTN Gateway Total Number of Calls per mn (Calls/mn)

Type

Generic

Description

The total number of calls per minute for a PSTN device.

Alias For

PSTN Gateway Total Calls per minute (calls/mn) (sum of all DS0s)

PSTN Gateway Total Number of Calls per mn (Calls/mn)

Formula Editor Path

AP > Generic > VOIP > Cisco > PSTN Gateway
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PSTN Gateway Total Number of Calls per mn (Calls/mn)

Type

SNMP (collection)

Description

The total number of calls per minute for a PSTN Gateway.

Syntax

DEF SaveAlias 10705;

V1 = OIDVAL(sum(*, delta(isdnSigStatsInCalls.*)));

V2 = OIDVAL(sum(*, delta(isdnSigStatsOutCalls.*)));

V3 = (%V1+%V2)/(delta(sysUpTime.0)/100);

V4 = %V3/60;

%V4

Generic Database Alias

PSTN Gateway Total Number of Calls per mn (Calls/mn)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > ISDN DS0 Channel Usage

MIB

rfc2127-ISDN-MIB
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PSTN Gateway Total Number of Calls

Type

SNMP (collection)

Description

The total number of calls observed by a PSTN Gateway.

Syntax

DEF SaveAlias 10704;

V1= OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(isdnSigStatsInCalls.*)));

V2= OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(isdnSigStatsOutCalls.*)));

%V1 + %V2

Generic Database Alias

PSTN Gateway Total Number of Calls (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > ISDN DS0 Channel Usage

MIB

rfc2127-ISDN-MIB

rfc1213-MIB-II
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PSTN Gateway Total Number of Successful Calls (Nb)

Type

Generic

Description

The total number of successful calls for a PSTN gateway device.

Alias For

PSTN Gateway Total Number of Successful Calls (Nb)

PSTN Gateway Total Number of Successful Calls (Nb)

Formula Editor Path

AP > Generic > VOIP > Cisco > PSTN Gateway
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PSTN Gateway Total Number of Successful Calls (Nb)

Type

SNMP (collection)

Description

The total number of successful calls for a PSTN Gateway.

Syntax

DEF SaveAlias 10706;

delta(cpmCallVolSuccISDNDigital.0)

Generic Database Alias

PSTN Gateway Total Number of Successful Calls (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > POP DS0 Channel Usage

MIB

CISCO-POP-MGMT-MIB.my
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PSTN Gateway Total Number of Successful Calls (Nb)

Type

SNMP (collection)

Description

The total number of successful calls made through a PSTN Gateway.

Syntax

DEF SaveAlias 10706;

V1= OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(isdnSigStatsInConnected.*)));

V2= OIDVAL(distrib(delta(sysUpTime.0), "default:1") * sum(*, 
delta(isdnSigStatsOutConnected.*)));

%V1+%V2

Generic Database Alias

PSTN Gateway Total Number of Successful Calls (Nb)

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > ISDN DS0 Channel Usage

MIB

rfc1213-MIB-II

rfc2127-ISDN-MIB
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PSTN Gateway Total Number of Unsuccessful Calls (Nb)

Type

Generic

Description

The total number of unsuccessful calls for a PSTN gateway device.

Alias For

PSTN Gateway Total Call Signaling Errors (Nb)

PSTN Gateway Total Number Calls Rejected (Nb)

Formula Editor Path

AP > Generic > VOIP > Cisco > PSTN Gateway
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PSTN Gateway Total Packets per Second

Type

SNMP (collection)

Description

The total number of packets per second for a PSTN Gateway.

Syntax

(delta(ipForwDatagrams.0) + delta(ipOutRequests.0) + 
delta(ipInReceives.0))/(delta(sysUpTime.0)/100)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Device

MIB

rfc1213-MIB-II
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SCS

Type

Import

Description

Severely concealed seconds. Concealment lasting longer than fifty milliseconds or five percent of the voice traffic.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CMR
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ShortCall

Type

Import

Description

Identifies a call successfully established, but with a call duration of less than one second. In this case, the 
CallManager set the CallDuration value to 0 in the CDR table.

A short call is also:

• A successful call

• Any inbound, outbound, or other type of call described in this chapter

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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SIPCallsActive

Type

Import

Description

Total number of currently active SIP calls for the resource or resources specified.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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SIPCallsInProgress

Type

Import

Description

Total number of SIP calls being established at the time of sampling.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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SNMP Availability (percent) (avg last hour)

Type

SNMP (collection)

Description

The average of SNMP availability percentages over the last hour, for CallManager devices.

Syntax

Stat( "Targets" , %H1 , "SNMP Availability (%) [last hour]" )

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device
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SNMP Availability (percent) (avg last hour)

Type

SNMP (collection)

Description

The average of SNMP availability percentages over the last hour, for PSTN Gateway devices.

Syntax

Stat( "Targets" , %H1 , "SNMP Availability (%) [last hour]" )

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Device
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SNMP Availability (percent) (avg last hour)

Type

SNMP (collection)

Description

The average of SNMP availability percentages over the last hour, for Cisco Gatekeeper devices.

Syntax

Stat( "Targets" , %H1 , "SNMP Availability (%) [last hour]" )

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > Gatekeeper > Device
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SNMP Availability (percent) (avg last hour)

Type

SNMP (collection)

Description

Netcool/Proviso performance Metric. Works with PVL 1.2 or better.

Syntax

Stat( "Targets" , %H1 , "SNMP Availability (%) [last hour]" )

Generic Database Alias

None.

Formula Editor Path

AP > PROVISO > Targets
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SNMP Response Time (ms) (avg last hour)

Type

SNMP (collection)

Description

The average of SNMP packet response times, in milliseconds, over the last hour, for CallManager Server devices.

Syntax

Stat( "Targets" , %H1 , "Average SNMP Response Time (ms) [last hour]" )

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > CCM Server > Device
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SNMP Response Time (ms) (avg last hour)

Type

SNMP (collection)

Description

The average of SNMP packet response times, in milliseconds, over the last hour, for PSTN Gateway devices.

Syntax

Stat( "Targets" , %H1 , "Average SNMP Response Time (ms) [last hour]" )

Generic Database Alias

None.

Formula Editor Path

AP > Specific > SNMP > VOIP > Cisco > PSTN Gateway > Device
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SNMP Response Time (ms) (avg last hour)

Type

SNMP (collection)

Description

Netcool/Proviso performance metric. Works with PVL 1.2 or better.

Syntax

Stat( "Targets" , %H1 , "Average SNMP Response Time (ms) [last hour]" )

Generic Database Alias

None.

Formula Editor Path

AP > PROVISO > Targets
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SNMP Unavailable (percent) (avg last hour)

Type

CME

Description

The average of SNMP unavailability percentages over the last hour.

Syntax

^(100 - avail)

Formula Input

Input: avail
Source: SNMP Availability (percent) (avg last hour) (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > PROVISO > Targets
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SuccessfulCall

Type

Import

Description

Identifies a call successfully established. Once the call is established, the communication starts between the two 
parties.

A successful call can be inbound, outbound, or any other type of call described in this chapter.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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T1ChannelsActive

Type

Import

Description

Total number of T1 channels currently in use in the target device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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T1SpansInService

Type

Import

Description

Total number of T1 spans available in the target device.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > Perfmon
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TollbypassCallDuration

Type

Import

Description

The duration of a toll bypass call, in seconds.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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TollBypassCall

Type

Import

Description

Identifies a call where the caller is an internal extension managed by the CallManager, and where the callee can 
be an internal extension or any external PSTN number, with one or more of the following criteria:

• Outbound call

• Off-net call

• The call is going through a PSTN Gateway, and the caller site and PSTN Gateway site are different

An intersite legacy PBX call can be also a toll bypass call if the PSTN Gateway site is different from the caller site.

Toll bypass calls can save money on long distance or international calls by using a remote PSTN Gateway with 
local fees. For example: A caller in Boston makes a call to an external PSTN number in London. Because there 
is an IP-VPN between the Boston office and the London office with a PSTN Gateway in London, the call goes 
through the IP network until the London office’s PSTN Gateway.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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Total Number of Calls (Nb) CME(Bulk) VOIP Cisco

Type

CME

Description

The total number of calls for all callers and callees.

Syntax

^(isCaller + isCallee)

Formula Input

Input: isCallee
Source: isCallee (Formula)

Input: isCaller
Source: isCaller (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Total Number of Outgoing External Calls (Nb)

Type

CME

Description

The total number of outbound calls going to the PSTN.

An outgoing external call can be any of these call types:

• Local

• Long distance

• International

This metric is a subset of the Cluster Total Number of External Calls (Nb).

Syntax

^(Local + International + LongDistance)

Formula Input

Input: International
Source: International (Formula)

Input: Local
Source: Local (Formula)

Input: LongDistance
Source: LongDistance (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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Total Number of VoiceMail Direct Calls (Nb) CME(Bulk) VOIP Cisco

Type

CME

Description

The total number of voicemail calls that are direct calls to voicemail (that is, users calling voicemail directly rather 
than being forwarded). This metric is the opposite of ForwardToVoiceMai.

Syntax

^(VoiceMailCall - ForwardCallToVoiceMail)

Formula Input

Input: ForwardCallToVoiceMail
Source: ForwardToVoiceMail (Formula)

Input: VoiceMailCall
Source: VoiceMailCall (Formula)

Generic Database Alias

None.

Formula Editor Path

AP > Specific > CME > VOIP > Cisco
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UnsuccessfulCall

Type

Import

Description

Identifies a call that has not been successfully established. In this case, the call setup has been rejected, and the 
communication between the two parties never started.

An unsuccessful call can be inbound, outbound, or any other type of call described in this chapter.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
420 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 7:  Collection Formulas
VoicemailCallDuration

Type

Import

Description

Duration of a call with the voicemail application, in seconds.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 421



Chapter 7:  Collection Formulas
VoiceMailCall

Type

Import

Description

Identifies a call where the final destination (callee) is voicemail. The voicemail application is managed through a 
specific range of extensions numbers, defined site by site, using the global variable VoiceMailExtensionRange.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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VoicemailPackets

Type

Import

Description

Number of packets that the sub-element sent and received during a voicemail call. 

This metric comes from the CMR table. It is set once the call is established with one of the voicemail extensions.

Syntax

#Bulk Metric

Generic Database Alias

None.

Formula Editor Path

AP > Specific > Bulk > VOIP > Cisco > CDR
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NOTES
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Chapter 8:  Discovery Formulas 

This chapter discusses the following topics: 

Overview

A discovery formula (also called an inventory formula) allows Netcool/Proviso to recognize resources specific 
to the target devices and technologies supported in the Cisco IP Telephony environment so that information can 
then be collected on those resources. A discovery formula runs during the inventory process - the process of 
discovering and analyzing the network. Discovery formulas for some network interfaces and devices (for example, 
Frame Relay) are already included with Netcool/Proviso DataMart. 

The Cisco IP Telephony Technology Pack provides discovery formulas specific to the devices and technologies 
that operate in the Cisco IP Telephony environment. This user guide discusses the discovery formulas that the 
Cisco IP Telephony Technology Pack provides. 

Netcool/Proviso Discovery Formula Tree

The Cisco IP Telephony Technology Pack provides a formula tree where the SNMP discovery formulas are 
defined in the Netcool/Proviso database. On the following pages, the path that is defined for each formula 
reflects that formula’s location in the formula tree. You can access this directory using the Netcool/Proviso 
DataMart Formula Selector. See the Netcool/Proviso DataMart Configuration Guide for more information.

Topic Page 

Overview 425

Netcool/Proviso Discovery Formula Tree 425 

Discovery Formula Structure 426
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Discovery Formula Structure

A discovery formula typically has three sections:

• Instance variable declaration. Instance variables represent the input values for a formula. The following 
line is an example of an instance variable declaration:

Dim I1 AS Integer Default * NAME RTTMonIndex;

• Temporary variable definition. Temporary variables hold the result of an SNMP query. These variables 
can then be used as parameters in subsequent queries. The following line is an example of a temporary 
variable definition:

V01=OIDINST(rttMonCtrlAdminStatus.%I1==1, once);

• Results line. The last line in the formula returns the formula result. The results line includes a sub-element 
instance string and a set of sub-element properties.

See the Netcool/Proviso SNMP Formula Language Guide for detailed information about the syntax used to write discovery 
formulas. 

The Results Line

The discovery formula results line has four fields. Fields are delimited by a double-bar (||):

• Field 1 specifies the sub-element instance string transmitted to each collection formula when the specified 
sub-element is deployed for collection. The instance string for a given sub-element appears in the instance 
field (Sub-Element view) of the Netcool/Proviso DataMart Resource Editor.

• Field 2 specifies the custom label of a sub-element. The custom label for a given sub-element appears in the 
label field (Sub-Element view) of the Netcool/Proviso DataMart Resource Editor.

The custom label may also display in reports that show statistics for a sub-element. The custom label typically 
displays under some Name, Device Name, or some similar column.

• Field 3 defines the property list (as name/value pairs). The property list for a given sub-element appears in 
the Property and Value columns (Sub-Element view) of the Netcool/Proviso DataMart Resource Editor.

• Field 4 is an optional field that, if specified, contains the invariant of the sub-element. The invariant is used 
during the synchronization process to detect a change of element properties, including the instance string 
(the first field).

Note:  The results line must appear as a single line in the formula.
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CCM_Gateway_Device

Type

SNMP (discovery)

Description

Sub-element discovery for CallManager gateways through the CCM MIB. This allows the retrieval of gateway 
registration status with the CallManager during collection.

Syntax

Dim I1 AS Integer Default * NAME Gateway;

V1 = OIDVAL(ccmGatewayInetAddress.%I1 format clean, once);

V2=OIDVAL(ccmClusterId.1);

V3=OIDVAL(ccmGatewayType.%I1);

V4 = OIDINST( not (ccmGatewayDescription.%I1 like ""));

V5 = OIDVAL(ccmGatewayDescription.%V4, once);

%V1 index "Gateway<%I1>||Gateway: 
%V1||VoIPCallMgrGatewayName<%V5>VoIPCallMgrClusterId<%V2>VoIPCallMgrGatewayType<
%V3>VoIPCallMgrGatewayIpAddress<%V1>||%V2_%V5||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

CISCO-CCM-MIB.my
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CCM_Media_Device

Type

SNMP (discovery)

Description

CallManager media device discovery.

Syntax

Dim I1 AS Integer Default * NAME Media;

V1 = OIDVAL(ccmMediaDeviceName.%I1);

V2=OIDVAL(ccmClusterId.1);

V3=OIDVAL(ccmMediaDeviceType.%I1);

V4=OIDVAL(ccmMediaDeviceDescription.%I1);

V5=OIDVAL(ccmMediaDeviceInetAddress.%I1);

%V1 index "MediaDevice<%I1>||MediaDevice: 
%V1||VoIPCallMgrMediaDeviceName<%V4>VoIPCallMgrClusterId<%V2>VoIPCallMgrMediaDev
iceType<%V3>VoIPCallMgrMediaDeviceIpAddress<%V5>||%V2_%V1||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

CISCO-CCM-MIB.my
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CCM_Server_Device

Type

SNMP (discovery)

Description

CallManager Server device discovery.

Syntax

V1 = OIDVAL(ccmClusterId.1);

V2 = OIDVAL(cdpGlobalDeviceId.0);

V3 = OIDVAL(ccmDescription.1);

V4 = OIDVAL(ccmVersion.1);

%V1 index 
"<NULL>||%V2||VoIPDeviceType<CallManagerServer>VoIPCallMgrClusterId<%V1>VoIPCall
MgrServerId<%V2>VoIPCallMgrServerDescr<%V3>VoIPCallMgrServerVersion<%V4>||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

CISCO-CCM-MIB.my

CISCO-CDP-MIB.my
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CCM_Server_FileSystem

Type

SNMP (discovery)

Description

CallManager Server file system discovery.

Syntax

Dim I1 AS Integer Default * NAME FileSys;

V1 = OIDINST((hrStorageIndex.%I1) != 1, once);

V2 = OIDVAL(hrStorageDescr.%V1);

V3=OIDVAL(ccmClusterId.1);

V4=OIDVAL(sysName.0);

%V2 index "FileSys<%V1>||File System: 
%V2||VoIPCallMgrFileSystemName<%V2>VoIPCallMgrClusterId<%V3>||%V4_%V2||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

rfc1514-HOSTRESOURCES

CISCO-CCM-MIB.my

rfc1213-MIB-II
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CCM_Server_Interface

Type

SNMP (discovery)

Description

CallManager Server interface discovery.

Syntax

Dim I1 AS Integer Default * NAME If;

V009 = OIDINST(ifAdminStatus.%I1 == 1);

V002=OIDVAL(ccmClusterId.1);

V001 = OIDVAL(ifType.%V009 format clean, once);

%V001 index "If<%V009>||-
UNSPECIFIED||VoIPCallMgrClusterId<%V002>VoIPCallMgrCustomerId<%V002>||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

rfc1213-MIB-II

CISCO-CCM-MIB.my
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CCM_Server_Process

Type

SNMP (discovery)

Description

CallManager Server process discovery.

Syntax

Dim I1 AS Integer Default * NAME Process;

V1 = OIDINST( not (hrSWRunName.%I1 like "java.exe") && not(hrSWRunName.%I1 like 
"services.exe") && not(hrSWRunName.%I1 like "csrss.exe") && not(hrSWRunName.%I1 
like "WINLOGON.EXE") && not(hrSWRunName.%I1 like "svchost.exe") && 
not(hrSWRunName.%I1 like "dllhost.exe"));

V2 = OIDVAL(hrSWRunName.%V1, once);

V3=OIDVAL(ccmClusterId.1);

V4=OIDVAL(sysName.0);

%V2 index "Process<%V1>||Process: 
%V2||VoIPCallMgrProcessName<%V2>VoIPCallMgrClusterId<%V3>||%V4_%V2||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

rfc1213-MIB-II

CISCO-CCM-MIB.my

rfc1514-HOSTRESOURCES
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CCM_Server_SqlDatabase

Type

SNMP (discovery)

Description

CallManager Server SQL database discovery.

Syntax

Dim I1 AS Integer Default * NAME SqlDb;

V1 = OIDVAL(mssqlDbInfoDbName.%I1 format clean, once);

V2=OIDVAL(ccmClusterId.1);

V3=OIDVAL(sysName.0);

%V1 index "SqlDb<%I1>||SqlDatabase: 
%V1||VoIPCallMgrSqlDbName<%V1>VoIPCallMgrClusterId<%V2>||%V3_%V1||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

rfc1213-MIB-II

CISCO-CCM-MIB.my

MSSQL-MIB.my
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Gatekeeper_Device

Type

SNMP (discovery)

Description

Gatekeeper device discovery.

Syntax

V1=OIDVAL(cgkStatsAdmissionRequests.0);

%V1 index "<NULL>||-UNSPECIFIED||VoIPDeviceType<CiscoGatekeeper>||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

rfc1213-MIB-II

CISCO-GATEKEEPER-MIB.my
434 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Chapter 8:  Discovery Formulas
PSTN_Gateway_Device

Type

SNMP (discovery)

Description

PSTN Gateway device discovery.

Syntax

Dim I1 AS Integer Default * NAME If;

Dim I2 AS Integer Default * NAME Dev;

V002 = OIDVAL(sysLocation.0,once);

V003 = OIDINST((cdpCachePlatform.%I1.%I2)== "cisco Cat6k-MSFC", once);

V004 = OIDVAL(cdpCacheDeviceId.%V003); #Catalyst 6500 with MSFC WAN module;

V011 = OIDVAL(sysObjectID.0);

V012 = OIDVAL(filter(%V011 like "1.3.6.1.4.1.9.1.162")); #AS5300;

V022 = OIDVAL(filter(%V011 like "1.3.6.1.4.1.9.1.436")); #3745;

V032 = OIDVAL( Sum(*, FirstN(1, isdnBearerOperStatus.%I1))); #ISDN-MIB support;

V042 = OIDVAL(filter(%V011 like "1.3.6.1.4.1.9.1.404")); #VG248;

%V012 index "<NULL>||-
UNSPECIFIED||VoIPCallMgrClusterId<%V002>VoIPCallMgrCustomerId<%V002>VoIPDeviceTy
pe<PSTNGatewayCiscoAS5300>||";

%V022 index "<NULL>||-
UNSPECIFIED||VoIPCallMgrClusterId<%V002>VoIPCallMgrCustomerId<%V002>VoIPDeviceTy
pe<PSTNGatewayCisco3745>||";

%V032 index "<NULL>||-
UNSPECIFIED||VoIPCallMgrClusterId<%V002>VoIPCallMgrCustomerId<%V002>VoIPDeviceTy
pe<PSTNGatewayCiscoOtherISDN>||";

%V042 index "<NULL>||-
UNSPECIFIED||VoIPCallMgrClusterId<%V002>VoIPCallMgrCustomerId<%V002>VoIPDeviceTy
pe<PSTNGatewayCiscoVG248>||";

%V004 index "<NULL>||*WS6608: 
%V004||VoIPCallMgrClusterId<%V002>VoIPCallMgrCustomerId<%V002>VoIPDeviceType<PST
NGatewayCiscoCat6k>||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

rfc2127-ISDN-MIB
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rfc1213-MIB-II

CISCO-CDP-MIB.my
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PSTN_Gateway_DSP_Card

Type

SNMP (discovery)

Description

PSTN Gateway DSP card discovery.

Syntax

Dim I1 AS Integer Default * NAME DSPCard;

V1 = OIDVAL(cdspCardIndex.%I1);

V2 = OIDVAL(cdspCardMaxChanPerDSP.%I1);

V3 = OIDVAL(sysLocation.0, once);

V4 = OIDVAL(sysName.0, once);

%V1 index "DSPCard<%I1>||DSPCard: 
<%V1>||VoIPCallMgrDSPMaxChannel<%V2>VoIPCallMgrClusterId<%V3>VoIPCallMgrCustomer
Id<%V4>||"; 

Formula Editor Path

Alias Instance and Label Inventory > AP > VOIP > Cisco

MIB

CISCO-DSP-MGMT-MIB.my

rfc1213-MIB-II
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Appendix A: Configuration

This appendix explains how to configure the Cisco IP Telephony Technology Pack and consists of the following 
topics: 

Overview 

Netcool/Proviso supports the following two types of technology packs, based on the type of data that they 
collect: 

• SNMP 

These packs are MIB-based, and their configuration is relatively straightforward. 

• BULK (or UBA) 

These packs collect data against non-SNMP devices, and rely on the Universal Bulk Adaptor (UBA) of the 
Netcool/Proviso DataChannel to process the data. Prior to Netcool/Proviso 443, BULK packs could be 
very difficult to configure, and in many cases required extensive Netcool/Proviso domain knowledge. 

Netcool/Proviso 443 introduces a graphical user interface (GUI) to configure Netcool/Proviso UBA technology 
packs on supported Netcool/Proviso platforms.

The Cisco IP Telephony Technology Pack is an SNMP and UBA technology pack. 

Before You Begin 

Before configuring the Cisco IP Telephony Technology Pack, ensure that you: 

• Have the following software or guides: 

—  The release notes for the current technology pack release. 

—  The version of the Netcool/Proviso DataMart Configuration Guide that corresponds to your version of 
Netcool/Proviso. 

Topic Page 

Overview 439 

Before You Begin 439 

Configure the Technology Pack 440 

Other Tasks and Considerations 455 
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Important:  You will need to refer to this guide in order to run a Bulk inventory profile. 

—  Access to the Netcool/Proviso DataMart server. 

—  An X Window server on the DataMart server. 

Note:  (Pre-443 Netcool/Proviso) If there is no graphics card on the DataMart server, you can install the Xvfb 
virtual frame buffer package to provide X Window services, as described in the Netcool/Proviso Installation 
Guide. 

—  Access to the SilverStream server. 

—  Access to the DataChannel server. 

• Have completed the following tasks: 

—  Installed the current version of the Netcool/Proviso components, as described in the Netcool/Proviso 
Installation Guide. 

—  Installed the MIB-II technology pack 

Note:  Starting with version 4.3-T, the MIB-II Technology Pack no longer resides in the single bundled jar 
file. It is a stand-alone technology pack that is contained in its own jar file. 

—  Installed the Cisco IP Telephony Technology Pack. 

—  Configured at least one DataChannel. 

—  Configured a UBA Bulk Collector subchannel. 

—  Configured an SNMP Collector subchannel. 

Note:  This technology pack contains a Java application, ProvisoCUCM, that sends data requests to CUCM 
servers. The ProvisoCUCM application requires the Java Runtime Environment (JRE) version 1.5 or greater.

Configure the Technology Pack 

To configure the Cisco IP Telephony Technology Pack, follow these steps: 

Important:  Localization is now done automatically during installation of the technology pack and requires no 
manual steps to configure. 

1. Load the DataMart environment. 

To load the shell with the DataMart environment, follow these steps: 

1-a. Log in to the DataMart server as pvuser. 

1-b. Change your working directory to the DataMart home directory (/opt/datamart, by default), using 
the following command: 

cd /opt/datamart 

1-c. Load the shell with the DataMart environment, by sourcing the dataMart.env file, as follows: 

. /opt/datamart/dataMart.env 

Note:  After you load the DataMart environment into the shell, the PVMHOME variable is set to the 
DataMart home directory, /opt/datamart by default. These instructions assume that this variable has been set. 
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2. Copy technology-specific files from the DataMart server to the DataChannel server. 

Technology-specific files are used to associate a UBA technology pack with a specific instance of the UBA. 

Note:  While it is possible to install DataMart and DataChannel on the same server, in a typical installation 
these modules are installed on separate servers. If this is the case, use ftp to copy the technology-specific files. 
Otherwise, if DataMart and DataChannel are on the same server, use the cp command to copy the files to the 
appropriate DataChannel directory. 

To copy technology-specific files to the DataChannel server, follow these steps: 

2-a. Log in to the Netcool/Proviso DataChannel server by entering the username and password that you 
specified when installing and configuring a DataChannel. The default username and password are 
pvuser and PV, respectively. 

2-b. Change your working directory to the DATA_CHANNEL_HOME/scripts directory by entering the 
following command, replacing DATA_CHANNEL_HOME with the DataChannel home directory 
(/opt/datachannel, by default): 

$ cd DATA_CHANNEL_HOME/scripts 

2-c. Using the ftp utility in text mode, log into the DataMart server using the appropriate username and 
password (pvuser and PV, by default). 

2-d. Using the cd sub-command, change your working directory to the 
$PVMHOME/APFiles/voip_cisco_ipt/datachannel/scripts/voip_cisco_ipt 
directory. 

2-e. Using the get sub-command, copy the Bulk Adaptor Design Files (*.js), scripts (if any), and other 
files (if any) from the DataMart server to the DataChannel server. 

2-f. (Pre-443 Netcool/Proviso only) Copy the voip_cisco_ipt_sample_dc.cfg template file as 
follows: 

*  Using the cd sub-command, change your working directory to the 
$PVMHOME/APFiles/voip_cisco_ipt/datachannel/conf directory. 

*  Using the get sub-command, copy the voip_cisco_ipt_sample_dc.cfg template file from the 
DataMart server to the DataChannel server. 

2-g. Exit the ftp utility by entering the bye sub-command. 

2-h. Verify that the technology-specific files now reside in the target directory as follows: 

*  (Netcool/Proviso 443 and higher) Verify that the Bulk Adaptor Design Files (*.js), scripts (if any), 
other files (if any) now reside in the DATA_CHANNEL_HOME/scripts directory. 

*  (Pre-443 Netcool/Proviso) Verify that the Bulk Adaptor Design Files (*.js), scripts (if any), other 
files (if any), and voip_cisco_ipt_sample_dc.cfg template file now reside in the 
DATA_CHANNEL_HOME/scripts directory. 

3. Activate data collection requests. 

During installation of the technology pack, all predefined data collection requests are promoted to the 
database and set to inactive (that is, idle displays in the Active column of the Netcool/Proviso DataMart 
Request Editor). You need to activate these predefined data collection requests using the Request Editor. 

To set data collection requests to active, follow these steps: 

3-a. Change your working directory to $PVMHOME/bin (/opt/datamart/bin, by default) on the 
DataMart server. 

3-b. Invoke the DataMart GUI by entering the following command and pressing Enter: 

pvm 
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3-c. Click the Configuration tab, then click Request Editor to open the Request Editor. 

3-d. Click the Collection tab. 

3-e. Click Refresh. 

The predefined data collection requests are loaded into the Request Editor from the database. 

3-f. Click the Inactive button in the Filter group box to display only idle requests. 

3-g. In the Sub-Element Groups pane, select all idle data collection requests in the following group or 
groups: 

Root->Sub-Element Collect->Cisco 

3-h. Click the Active box under Details. The Request Editor toggles the idle setting for these data collection 
requests from idle to active in the Active column. 

3-i. Click Save. 

4. Merge the technology pack’s sub-element inventory text files. 

Sub-element inventory control rules for the Cisco IP Telephony Technology Pack are contained in the file 
voip_cisco_ipt_inventory_subelements.txt, which is installed in the following directory on the 
DataMart server: 

$PVMHOME/APFiles/voip_cisco_ipt/datamart/conf 

You must merge the contents of this file with the file inventory_subelements.txt located in 
$PVMHOME/conf (typically, /opt/datamart/conf) on the DataMart server: 

To merge the sub-element inventory control rules for the Cisco IP Telephony Technology Pack, follow these 
steps: 

4-a. Change your working directory to $PVMHOME/conf by entering the following command: 

cd $PVMHOME/conf 

4-b. Copy voip_cisco_ipt_inventory_subelements.txt to the $PVMHOME/conf directory, by 
entering the following command: 

cp $PVMHOME/APFiles/voip_cisco_ipt/datamart/conf/voip_cisco_ipt_inventory_subelements.txt . 

4-c. Make a backup copy of the inventory_subelements.txt file by entering the following 
command: 

cp inventory_subelements.txt inventory_subelements.txt.ORIG 

4-d. Append the contents of voip_cisco_ipt_inventory_subelements.txt to 
inventory_subelements.txt, by entering the following command: 

cat voip_cisco_ipt_inventory_subelements.txt >> inventory_subelements.txt 

Important:  Ensure that you use two forward brackets (>>); otherwise, the original contents of 
inventory_subelements.txt will be overwritten. 

4-e. Perform a diff on the backed-up file and the appended file to ensure that the merge succeeded, as 
shown in the following example: 

diff inventory_subelements.txt inventory_subelements.txt.ORIG 

Important:  If you do not have a CCM environment, skip Step 5 and continue with Step 6.

5. CCM environment only: Configure the Data Direct SQL Server Bridge

The Netcool/Proviso Cisco IP Telephony Technology Pack collects data from SNMP devices and, through 
SQL for Call Detail Records, from each CCM database. 
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The technology pack’s UBA is responsible for retrieving CCM data, using the Data Direct SQL server bridge 
to do so. This bridge is part of the UBA installation. No additional software is required.

You need to set up the Data Direct SQL server bridge to get Call Detail Records from each CallManager 
Publisher. The complete configuration is done by editing the $DC_HOME/conf/odbc.ini file as user 
pvuser.

[ODBC Data Sources] 
Your_Data_Source1=DataDirect 4.20 SQL Server Wire Protocol 
Your_Data_Source2=DataDirect 4.20 SQL Server Wire Protocol 
Your_Data_SourceN=DataDirect 4.20 SQL Server Wire Protocol

[Your_Data_Source1] 
Driver=PVmsss20.so 
Description=DataDirect 4.20 SQL Server Wire Protocol 
Address=xx.xx.xx.xx,1433 
AnsiNPW=Yes 
Database=CDR 
QuoteId=No

[Your_Data_Source2] 
Driver=PVmsss20.so 
Description=DataDirect 4.20 SQL Server Wire Protocol 
Address=xx.xx.xx.xx,1370 
AnsiNPW=Yes 
Database=CDR 
QuoteId=No

[Your_Data_SourceN] 
Driver=PVmsss20.so 
Description=DataDirect 4.20 SQL Server Wire Protocol 
Address=xx.xx.xx.xx,1433 
AnsiNPW=Yes 
Database=CDR 
QuoteId=No

[ODBC] 
IANAAppCodePage=4 
InstallDir=/opt/datachannel/ 
Trace=0 
TraceDll=/opt/datachannel/lib/odbctrac.so 
TraceFile=odbctrace.out 
UseCursorLib=0

All fields above which appear in boldface red and must be configured according to your CallManager 
Publisher environment, as follows:

Field Description

[ODBC Data 
Sources]

One entry per CallManager Publisher.

Note:
The data source name must match the data source name specified in the corresponding 
URI (Uniform Resource Identifier) parameter in the dc.cfg file. Each line in this 
section should also be associated with a subsection that configures the data source.
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Important:  If you do not have a CUCM environment, skip Step 6 through Step 9, and continue 
with Step 10.

6. CUCM environment only: On the DataChannel host, create a directory for each CUCM server from which 
CDR, CMR, and Perfmon data files will be requested. For example, if you will be requesting data files from 
two CUCM servers, you might create the following directories:

/opt/datachannel/cucm1 
/opt/datachannel/cucm2

These directories will contain the ProvisoCUCM application and other files needed to send SOAP requests 
to each CUCM server.

Note:  If you will be requesting CDR and CMR data files through a master CUCM server, you need to create 
just one directory for those requests. However, if you will be requesting Perfmon data, you must create a separate 
directory for each CUCM server from which you will request Perfmon data.

7. CUCM environment only: Copy the following files into each one of the directories you just created in Step 6:

—  ProvisoCUCM.jar

—  cucm.properties

—  startcucm.sh

—  stopcucm.sh

These files were included in the technology-specific files you copied to DATA_CHANNEL_HOME/scripts 
in step 2-e on page 441. 

8. CUCM environment only: Configure each of the cucm.properties files you copied in Step 7.

Each cucm.properties file is associated with an instance of the ProvisoCUCM application that resides 
in the same directory as the file. The ProvisoCUCM instance reads the cucm.properties file to find the 
address and login credentials of the associated CUCM server, the address and login credentials of the 
DataChannel host for the CUCM server to use when pushing the requested files via FTP back to the 
DataChannel host, and other required configuration details.

The following table describes the fields in the cucm.properties files:

[Data Source Name] The configuration of the specified data source.

• [Data Source Name]: for example, [SANFRANCISCO]

• Address: the remote IP address and TCP port of the CallManager Publisher 
Database (for example, 192.168.1.1,1433). To verify the remote connection 
configuration, establish the connection manually from a shell window: telnet 
xx.xx.xx.xx 1433 or telnet xx.xx.xx.xx 1370. The remote TCP 
port can be 1433 or 1370 according to the SQL Server configuration.

[ODBC] A global section that defines the global environment for the bridge.

Field Description

Field Description

cucm.host The IP address of the CUCM server associated with this properties file. 
Examples: cucm.host=10.1.2.3 

cucm.host=cucm.mycorp.com

cucm.port The port number for SOAP requests sent to the CUCM server.
Example: cucm.port=443
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cucm.user User ID required for login to the CUCM.
Example: cucm.user=cucmuser

cucm.pass User password required for login to the CUCM.
Example: cucm.pass=cucmpwd

ftp.user User ID required for login to the DataChannel host that issued the SOAP 
request.
Example: ftp.user=provisouser

ftp.pass User password required for login to the DataChannel host that issued the 
SOAP request.
Example: ftp.pass=provisopwd

ftp.host The IP address of the DataChannel host where the requested data files are 
to be returned through FTP.
The FTP server must be the host where the ProvisoCUCM instance for 
this cucm.properties file is running.
Examples: ftp.host=10.4.5.6 

ftp.host=proviso.mycorp.com

ftp.secure If true, instructs the CUCM server to return the requested data files over 
a secure FTP connection.
If false, the CUCM server will not use a secure FTP connection.
Example: ftp.secure=true

ftp.remotedir The location on the DataChannel host where the requested data files are 
to be copied.
Example: ftp.remotedir=/export/home/pvuser/CUCM/files

collect_cdr If true, ProvisoCUCM requests CDR and CMR data from the CUCM 
server.
If false, ProvisoCUCM will not poll the CUCM server for CDR and 
CMR data.
Example: collect_cdr=true

collect_perfmon If true, ProvisoCUCM requests Perfmon data from the CUCM server.
If false, ProvisoCUCM will not poll the CUCM server for Perfmon 
data.
Example: collect_perfmon=true

cdr_output_dir The location on the DataChannel host where the ProvisoCUCM instance 
generates output from a CDR file and its associated CMR file.
The output is a single CSV file that contains correlated data from the CDR 
file and CMR file.
Example: cdr_output_dir=/opt/uba/cdrcmr

perfmon_output_dir The location on the DataChannel host where the ProvisoCUCM instance 
generates output, in CSV format, from a Perfmon data file.
Example: perfmon_output_dir=/opt/uba/perfmon

Field Description
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resend_sent_files If true, the CUCM server will re-send files that it has already successfully 
sent. Since the CUCM can be configured to send data files to any host 
specified by CUCM Web administration configuration settings, this field 
must be set to true to ensure that data files are also sent to the 
DataChannel host that requested them.
Use the false setting in the following situations:

• If you prefer to have the data files pushed back to the DataChannel 
host according to a schedule specified by CUCM Web administration 
configuration settings. Set the CUCM configuration to push the data 
files back to the DataChannel server where the ProvisoCUCM 
instance is running.

• If data files are being pushed back to the DataChannel host too slowly 
for your needs. 

If this field is false, the ProvisoCUCM instance will request the data files 
from the CUCM server and receive none. It will then check for the data 
files in the location specified by the CUCM Web administration 
configuration (at time intervals specified by run_interval or 
perfmon_interval). If the files are there, ProvisoCUCM retrieves the 
files and generates the CSV output to cdr_output_dir (or 
perfmon_output_dir with Perfmon data) on the DataChannel host 
that requested the data.
Example: resend_sent_files=true

grace_period The time, in milliseconds, to subtract from the polling start time. The 
polling start time is the time that the ProvisoCUCM instance begins 
polling the CUCM server for data.
The grace period is intended to help you avoid missing data files that the 
CUCM has not yet written for the current time period.
ProvisoCUCM uses the polling start time specified in the field 
start_time of the file cucm.TIMESTAMP. This file resides in the same 
directory as the cucm.properties file.
If the file does not exist when ProvisoCUCM is instantiated, it starts 
polling the CUCM server immediately, creates cucm.TIMESTAMP, and 
writes the current time to it.
Example grace period (100 seconds): grace_period=100000
Example start time (1/20/2009 at 12:00): start_time=1232470820931

run_interval The interval, in milliseconds, at which ProvisoCUCM polls the CUCM 
server for CDR and CMR data files, and checks cdr_output_dir for 
data files pushed there by the CUCM server.
Example (15 minutes): run_interval=900000

perfmon_interval The interval, in milliseconds, at which ProvisoCUCM polls the CUCM 
server for Perfmon data files, and checks perfmon_output_dir for 
data files pushed there by the CUCM server.
Example (5 minutes): run_interval=300000

Field Description
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Note:  Before proceeding to the next step, be sure you have configured each cucm.properties file in the directories 
you created in Step 6.

9. CUCM environment only: Start all ProvisoCUCM applications by running the startcucm.sh file in each 
directory that you created in Step 6.

ProvisoCUCM writes a log file in the same directory where its ProvisoCUCM.jar file resides. Monitor 
the log file to make sure that ProvisoCUCM is successfully communicating with the CUCM server. Also, 
verify that CSV files are being generated to the output directories (cdr_output_dir and/or 
perfmon_output_dir).

Note:  Be sure that all ProvisoCUCM instances are operating successfully before proceeding to the next step.

10. Define global variables.

Global variables are specific to each CCM or CUCM cluster. You assign values to global variables in either 
of the following files: 

—  CCMConfig.js. with CCM clusters

—  CUCMConfig.js with CUCM clusters

The Cisco IP Telephony Technology Pack includes the configuration files CCMConfig.js and 
CUCMConfig.js. In Step 2-e, you copied these files to DATA_CHANNEL_HOME/scripts (typically, 
/opt/datachannel/scripts).

These configuration files contain sample values. Edit either or both files to assign values appropriate for 
locations in your Cisco IP Telephony CCM or CUCM environment. The following table describes the global 
variables to define:

debug If true, enables debug mode for ProvisoCUCM operations. Error 
information pertaining to the SOAP interaction with the CUCM server is 
written to a log file. The log file resides in the same directory as the 
ProvisoCUCM.jar and cucm.properties files.
If false, debug mode is not enabled.
Example: debug=true

Field Description

Variable Description

CUSTOMERNAME String specifying the customer’s identifier. This value allows automatic grouping 
and report navigation by customer. 
Example: var CUSTOMERNAME="TELINDUS";

CMCLUSTER String specifying the cluster’s identifier. This value allows automatic grouping and 
report navigation by cluster.
Example: var CMCLUSTER="SF";

OUTBOUNDPREFIX Integer specifying the prefix to dial to call outside of the PBX (for example, 9 
within the US, or 0 within Europe.) 
Example: var OUTBOUNDPREFIX=0;
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11. (Requires the Netcool/Proviso DataMart Configuration Guide) Run the initial SNMP inventory and initiate a 
discovery. 

site A variable assigned to the JavaScript object Site. A Site object defines a set of 
properties specific for a site, business department, location, remote office, or group of 
people. You can define multiple Site objects. Objects are distinguished through the site 
name you pass to the object.

Create a Site object as follows:

site = new Site("MySite");

In the example, MySite is the site name.

A site object contains the following methods: 

• addLocalCallPrefix(string prefix)

The prefix argument specifies n digits in a local call prefix, where n is the prefix 
length. If the first n digits in a phone number match the prefix, the phone number is 
determined to be a local number. Many local call prefixes can be defined for the same 
site through this method.

Example: site.addLocalCallPrefix("999");

• addExtensionRange(int startNumber, int endNumber)

The two arguments specify the extension range for a site, beginning with the first 
extension in the range, and ending with the last extension. 

Each number within the range is an internal extension for the named site. Many 
extension ranges can be defined for the site through this method. The values allow 
automatic grouping, report navigation by site, and path sub-element definition.

Example: site.addExtensionRange(1000,1830);

• addVoiceMailRange(int startNumber, int endNumber)

The two arguments specify the VoiceMail extension range for a site, beginning with 
the first VoiceMail extension in the range, and ending with the last extension. 

Each number within the range is an internal VoiceMail extension for the named site. 
Many VoiceMail extension ranges can be defined for the site through this method. 
The values allow automatic grouping, report navigation by site, and specific reports 
on the VoiceMail application.

Example: site.addVoiceMailRange(9000,9050);

• addPstnGatewayIpAddress(string ipAddress)

The argument specifies the IP address of a PSTN gateway. Many PSTN gateway 
addresses can be defined for the named site through this method. The values allow 
automatic grouping, report navigation by site, and path and gateway sub-element 
definition. 

Example: site.addPstnGatewayIpAddress("10.1.184.20");

Note:  Use the following method only in the CUCMConfig.js file.

• addCucmAddress(string ipAddress)

The argument specifies the IP address of a CUCM server in the cluster. 

Example: site.addCucmAddress("10.1.6.8");

Variable Description
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An inventory collects data about the network resources that the technology pack monitors. After you install 
an SNMP technology pack, you must create an inventory profile using the Inventory Tool Wizard and then 
initiate a discovery by executing the inventory profile using the Inventory Tool. 

Running the initial inventory against SNMP objects is an intricate task and unfortunately beyond the scope 
of this configuration appendix. For instructions on using the Inventory Tool Wizard to create an inventory 
profile and the Inventory Tool to execute the inventory profile, see the Netcool/Proviso DataMart Configuration 
Guide. 

12. Edit pack-specific UBA parameters, based on the following Netcool/Proviso platforms: 

—  443 and higher 

—  Pre-443 

443 and Higher 

In this release of Netcool/Proviso, you were instructed to modify the technology pack-specific UBA 
parameters when you installed the Cisco IP Telephony Technology Pack, using the Topology Editor. If you 
did not modify the UBA parameters with site-specific values or you want to make additional edits, you can 
do so now. Otherwise, you can go to the next step. 

See the Installing Technology Packs chapter of the Netcool/Proviso Installation Guide for more information. 

Pre-443 

The Cisco IP Telephony Technology Pack requires specific UBA parameters that are not in the dc.cfg file. 
The DataChannel installer creates a dc.cfg file in the DATA_CHANNEL_HOME/conf directory 
(/opt/datachannel/conf, by default). These pack-specific parameters were delivered in a template file 
called voip_cisco_ipt_sample_dc.cfg. 

The best practice on adding these pack-specific parameters to the dc.cfg file is to: 

—  Edit the pack-specific UBA parameters in the template file with site-specific values. 

—  Manually add them to the dc.cfg file. 

To edit the pack-specific UBA parameters in the template file with site-specific values, follow these steps: 

12-a. On the DataChannel server, change your working directory to the 
DATA_CHANNEL_HOME/scripts directory by entering the following command, replacing 
DATA_CHANNEL_HOME with the DataChannel home directory (/opt/datachannel, by default): 

cd DATA_CHANNEL_HOME/scripts 

12-b. Make a backup copy of the voip_cisco_ipt_sample_dc.cfg template file, by entering the 
following command: 

cp voip_cisco_ipt_sample_dc.cfg voip_cisco_ipt_sample_dc.cfg.ORIG 

12-c. In a text editor, open the voip_cisco_ipt_sample_dc.cfg template file for editing. 

12-d. Edit the pack-specific UBA parameters according to the instructions provided in Appendix B, Template File 
Reference. 

Note:  The cross reference link to Appendix B, Template File Reference does not work due to a formatting 
limitation. 

12-e. When you are satisfied with your edits, write (but do not quit) the 
voip_cisco_ipt_sample_dc.cfg template file. 

Important:  Editing the dc.cfg file is a non-trivial task and prone to error. Take your time and check your work 
carefully. 
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To manually add the pack-specific UBA parameters to the dc.cfg file, follow these steps: 

12-f. Open a second terminal emulator. 

12-g. On the DataChannel server, change your working directory to the DATA_CHANNEL_HOME/conf 
directory (/opt/datachannel/conf, by default), by entering the following command: 

cd DATA_CHANNEL_HOME/conf 

12-h. Make a backup copy of the dc.cfg file, by entering the following command: 

cp dc.cfg dc.cfg.ORIG 

12-i. In a text editor, open the dc.cfg file for editing. 

12-j. Search for the UBA parameters, which begin with the string UBA. These parameters were written to the 
dc.cfg file when you configured the UBA Bulk Collector and installed the DataChannel 
configuration, as described in the Netcool/Proviso Installation Guide. 

12-k. Copy the pack-specific UBA parameters from the voip_cisco_ipt_sample_dc.cfg template file 
to the dc.cfg file. 

12-l. When you are satisfied with your edits, do the following: 

—  Quit the voip_cisco_ipt_sample_dc.cfg template file. 

—  Write and quit the dc.cfg file. 

13. Load the DataChannel environment. 

In subsequent steps, you will execute dccmd commands. To ensure that you can run these commands, load 
the shell with the DataChannel environment by following these steps: 

13-a. Log in to the DataChannel server as pvuser. 

13-b. Change your working directory to the DataChannel home directory (/opt/datachannel, by 
default), using the following command: 

cd /opt/datachannel 

13-c. Load the shell with the DataChannel environment, by sourcing the dataChannel.env file, as 
follows: 

. /opt/datachannel/dataChannel.env 

14. Restart the DataChannel to activate the UBA and read in changes to dc.cfg. 

14-a. Open a terminal emulator on the DataChannel server. 

14-b. Use the dccmd command to stop all DataChannel applications: 

dccmd -action stop all 

14-c. Use the dccmd command to release all daemons running in the DataChannel: 

dccmd -action forget all 

14-d. Use the following command to find the process identifiers (pids) associated with the DataChannel 
visual processes: 

DATA_CHANNEL_HOME/bin/findvisual 

where: 

DATA_CHANNEL_HOME is /opt/datachannel, by default. 

14-e. Use the following commands to stop each DataChannel visual process: 

kill -9 <cnsw_pid> 

kill -9 <logw_pid> 
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kill -9 <amgrw_pid> 

kill -9 <cmgrw_pid> 

14-f. Use the following commands to restart each DataChannel visual process: 

cnsw

logw

amgrw

cmgrw

14-g. Use the dccmd command to start all DataChannel applications: 

dccmd -action start all 

14-h. Use the dccmd command to verify that all of the DataChannel applications started properly: 

dccmd -action status all 

More specifically, make sure that the UBA application associated with the DataChannel you configured 
for the Cisco IP Telephony Technology Pack is running. 

14-i. Watch the output of the status switch to verify that all the necessary processes are running. If these 
processes are running, run the tail utility on the log file for the UBA by issuing a command similar 
to the following: 

tail -f DATA_CHANNEL_HOME/log/proviso.log | grep UBA.<channel>.<collector>- | more 

where: 

The following table identifies some events to watch for during the syntax check: 

Variable Meaning

DATA_CHANNEL_HOME Is /opt/datachannel, by default. 

<channel> Specifies the channel number (for example, 1) you 
specified when configuring this DataChannel. 

<collector> Specifies the collector number (for example, 100) you 
specified when configuring this UBA Bulk Collector. 

The trailing dash (–) after <collector> Removes extraneous log messages from your view. That is, 
the trailing dash guarantees that the command displays 
only those messages generated by your application. The 
first set of messages relate to syntax checks. 

Event Meaning 

The UBA application starts successfully, but then stops 
executing. 

Typically, this event occurs because of a licensing issue. 

The Bulk Adaptor Design File might be corrupt. This event causes a syntax error before the UBA 
application connects to the database. 
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15. Ensure that the Bulk input files can be read. 

To verify that the UBA application can read the Bulk input files, follow these steps: 

15-a. Place a Bulk input file at the source input location. 

—  (443 only) The source input location for Bulk input files is specified using the URI parameter from the 
pack’s XSD file, which you can view using the Topology Editor. 

—  (Pre-443 only) The source input location for Bulk input files is specified using the URI parameter from 
the template file, which you added to the dc.cfg file in a previous step. 

Within the configured file retrieval interval (typically, five minutes), the UBA application retrieves the 
Bulk input file and copies it to the following directory: 

DATA_CHANNEL_HOME/UBA.<channel>.<collector>/<instance>/do/ 

where: 

The UBA application then processes the Bulk input file according to the instructions in the Bulk Adaptor 
Design File. 

Note:  The first time that the UBA processes a Bulk input file, it passes a metric to the CME. The CME 
rejects this metric as a BAD_METRIC because the metric does not have an associated grouped sub-element prior 
to the time this metric is recorded. This is expected behavior. The CME accepts metrics from the Bulk input files 
after the inventory is run. 

15-b. Ensure that the UBA application can successfully read the Bulk input file you copied into the source 
input location by issuing a tail utility command similar to the following: 

The UBA application connects to the database. This event causes a message similar to the following to 
display: 

DB_CONNECT Connecting to <sid> as 
<user> 

If you see this database connection message without prior 
errors, the UBA application has passed the syntax check. 

Event Meaning 

Variable Meaning 

DATA_CHANNEL_HOME Is /opt/datachannel, by default. 

<channel> Specifies the channel number (for example, 1) you 
specified when configuring this DataChannel. 

<collector> Specifies the collector number (for example, 100) you 
specified when configuring this UBA Bulk Collector. 

<instance> (443 only) Specifies the string for the INSTANCES parameter in the 
pack’s XSD file. Typically, this string represents the name 
of the pack and is read-only. You can view the string 
specified for INSTANCES using the Topology Editor. 

<instance> (pre-443 only) Specifies the string for the INSTANCES parameter in the 
pack’s template file. You were instructed to copy this 
parameter to the dc.cfg file in a previous step. 
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tail -f DATA_CHANNEL_HOME/log/proviso.log | grep UBA.<channel>.<collector>- | more 

The following table identifies the success messages you should look for. Line breaks appear in the 
messages to make them more readable. 

16. Run the Bulk inventory profile. 

The UBA application handles the inventory and metrics according to the instructions provided in the 
technology pack’s design file or files. Specifically, the UBA application inserts the created elements, sub-
elements, and metrics into the database. However, the UBA application does not handle the grouping of 
these elements and sub-elements. 

To handle the grouping of the elements and sub-elements that were inserted into the database, UBA 
technology packs supply a Bulk inventory profile. This Bulk inventory profile is automatically created when 
the pack is installed. Bulk inventory profiles use the following name syntax: 

bulk_N 

Success Message Meaning 

PERF_INPUT_PROCESSING Processed <integer> records in <float> 
seconds (<float> records/minute): <int> records 

Specifies a Bulk Adaptor Design File 
completion message. A Bulk Adaptor 
Design File successfully completes 
when an informational message similar 
to this one displays in the log file. 

Success occurs when <int> records 
equals 0. 

METRIC_STREAM_INFO Completed writing metric output: 
DATA_CHANNEL_HOME/UBA.<channel>.<collector>/streaming/ 

state/temp/output/<time>.<instance>.NRAW.BOF; wrote <int> 
metrics; <int> bad resource IDs; <int> bad formula names (#())

Specifies a metric creation success 
message. The UBA application 
successfully creates metrics when a 
debug 2 message similar to this one 
displays in the log file. 

For some technology packs, the metric 
creation may be done across different 
instances of UBA applications. Success 
occurs when <int> metrics is greater 
than one, <int> bad resource IDs 
equals 0, and <int> bad formula names 
equals 0. 

PERF_INVFLUSH Inserted/updated <int> inventory objects in 
<float> seconds 

Specifies an inventory success message. 
The inventory successfully completes 
when an informational message similar 
to this one displays in the log file. 

If <int> is greater than one, the UBA 
application created or updated at least 
one sub-element, and the inventory 
process is successful. The log file might 
record further details (if necessary) in 
the messages associated with the 
PERF_INVFLUSHPV sub-element 
message category. 
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where: 

You must use the Inventory Tool to run a Bulk inventory profile. 

To run this technology pack’s Bulk inventory profile, perform the following steps: 

16-a. In the command window where you loaded the DataMart environment, change your working directory 
to $PVMHOME/bin (/opt/datamart/bin, by default) on the DataMart server. 

16-b. Invoke the DataMart GUI by entering the following command and pressing Enter: 

pvm 

16-c. Click Inventory Tool in the Resource tab. The Inventory Tool window appears. 

This window displays a list of the existing inventory profiles on the Configuration tab. The name of the 
inventory profile to run is bulk_N, where N is the collector number configured for this pack. 

16-d. On the Configuration tab, click on the Bulk inventory profile for this technology pack and then select 
Run Profile from the Action menu. 

The Live Information tab displays messages about the status of the profile. See the Netcool/Proviso 
DataMart Configuration Guide for more information about running an inventory profile. 

16-e. (Optional) Every time the UBA technology pack’s design file creates new elements, sub-elements, and 
metrics, you need to perform the previous steps to group the elements and sub-elements. One way to 
accomplish this task on a regular basis is to create a cron entry that make use of the inventory CLI 
command. The following example shows a cron entry that periodically performs the grouping 
operation for a Bulk inventory profile called bulk_100: 

0 * * * * . /opt/datamart/dataMart.env && inventory -name bulk_100 -action pregrouping -reload 
-noX 

0 * * * * . /opt/datamart/dataMart.env && inventory -name bulk_100 -action grouping -reload -noX 

See the Netcool/Proviso Command Line Interface Guide for more information about the inventory command. 

17. Deploy reports. 

After the technology pack installation completes, the rules for the new device are automatically loaded into 
the database. The inventory process uses those rules to group elements and sub-elements. You must 
manually deploy (auto-group) the reports by associating them with groups in the DataMart Resource Editor’s 
NOC Reporting tree.

To deploy the Cisco IP Telephony Technology Pack reports, follow these steps: 

17-a. Open the Netcool/Proviso DataMart Resource Editor. 

17-b. Click the ReportSEGroup tab. 

17-c. Move the cursor to the left pane and scroll up to select any group under the SUB-ELEMENTS->NOC 
Reporting tree. 

17-d. Right-click and select the AutoGrouping option from the menu. The AutoGrouping option places the 
reports in dynamically generated groups created during inventory. 

17-e. Click Yes to continue. 

17-f. Click Close to exit the message box, or click Details to view a description of any errors. 

Syntax Item Meaning 

bulk_ Identifies this as a Bulk inventory profile for a UBA 
technology pack. 

N Specifies the collector number (for example, 100) the user 
specified when configuring this UBA Bulk Collector. 
454 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Appendix A:  Configuration
17-g. (Optional) You can also deploy reports on a regular basis by creating a cron entry that makes use of the 
inventory CLI command and the -reportGrouping option. This option instructs the inventory 
command to run the report grouping rules and update the deployed reports stored in the database. 
Report grouping rules must first have been created before this option can be used. For information on 
creating report grouping rules, see the Netcool/Proviso DataMart Configuration Guide. 

The following example shows a cron entry that periodically performs the deploy report operation: 
0 * * * * . /opt/datamart/dataMart.env && inventory -noX -reportGrouping 

See the Netcool/Proviso Command Line Interface Guide for more information about the inventory 
command.

Other Tasks and Considerations 

This section contains information on the following topics: 

• Verifying Resources 

Verifying Resources 

Use the Netcool/Proviso DataMart Resource Editor to determine if the technology pack’s resources (elements, 
sub-elements, properties, and so forth) were successfully discovered and created in the database during inventory. 

See the Netcool/Proviso DataMart Configuration Guide for information on using the Netcool/Proviso DataMart 
Resource Editor. 
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 455



Appendix A:  Configuration
456 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Appendix B: UBA Parameters Reference (443, 
Topology Editor) 

This appendix provides Unix reference pages for each of the pack-specific UBA parameters supplied with the 
XSD file for the Cisco IP Telephony Technology Pack. The descriptions are the same as those that display in the 
Topology Editor Help. These reference pages are provided as a convenience. 

UBA Parameters Reference 

The following pages provide a reference of the UBA parameters that this technology pack provides. The reference 
pages have the following sections: 

• Parameter name. Each reference page begins with the parameter name. Parameter names use the following 
syntax: 

[<instance>.][<schema>.]<parameter_name> 

where: 

—  <instance> — Specifies the group alias, which is typically a string that represents the name of the 
technology pack. 

—  <schema> — Specifies the string passed to the input schema object referenced in the pack’s Bulk Adaptor Design 
(JavaScript) file. 

—  <parameter_name> — Specifies the name of the parameter. 

In the Detail sections of the reference pages, parameter names in the descriptions are typically referenced as 
<schema>.<parameter_name> or simply <parameter_name>. The descriptions do not reference the <instance> part 
of the parameter name. 

• Description. A short description that identifies the purpose of the parameter. 

• Component. The DataChannel application (component) to which the parameter applies. The value 
specified for this parameter controls the behavior of this DataChannel application. This section can contain 
the following values: 

—  BLB — Specifies the DataChannel BLB (Bulk Load Balancer) application. 

—  IF — Specifies the DataChannel Inventory File (IF) application. Examples of IF applications include: 

*  SAMIF — Specifies the IF application for the Alcatel 5620 SAM Technology Pack. 

*  QCIF — Specifies the IF application for the Alcatel 5620 NM Technology Pack. 

—  UBA — Specifies the DataChannel UBA (Universal Bulk Adaptor) application. 

Most UBA technology packs operate with only the UBA application. 

• Value. Specifies the following information: 

—  Default — Identifies the default value, if one is specified, for the parameter. 

—  Attribute — Specifies whether the parameter is writable. 

—  Location — Specifies the location of the parameter in the Topology Editor. 
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• Detail. Provides details about the parameter, including possible values. 
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INSTANCES

Description

Group alias.

Component

UBA

Value

Default: VOIP_CISCO_IPT_PERFMON

Attribute: Read-only

Location: Advanced Properties tab

Detail

The DataChannel supports multiple instances of technology packs running in a single channel component. 
Therefore, there must be a way to guarantee that the DataChannel applications that handle inventory and metrics 
parse the correct design files and read the appropriate Bulk input files. The INSTANCES parameter helps ensure 
that the DataChannel applications that handle inventory and metrics perform the correct operation for a specific 
technology pack.

The value of INSTANCES is one of the following: 

• VOIP_CISCO_IPT with CCM or CUCM metrics. 

• VOIP_CISCO_IPT_PERFMON with CUCM Perfmon metrics. 

This is a read-only parameter whose value you cannot change. Typically, the value for INSTANCES is a string that 
represents the name of the technology pack.
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INSTANCES

Description

Group alias.

Component

UBA

Value

Default: VOIP_CISCO_IPT

Attribute: Read-only

Location: Advanced Properties tab

Detail

The DataChannel supports multiple instances of technology packs running in a single channel component. 
Therefore, there must be a way to guarantee that the DataChannel applications that handle inventory and metrics 
parse the correct design files and read the appropriate Bulk input files. The INSTANCES parameter helps ensure 
that the DataChannel applications that handle inventory and metrics perform the correct operation for a specific 
technology pack.

The value of INSTANCES is one of the following: 

• VOIP_CISCO_IPT with CCM or CUCM metrics. 

• VOIP_CISCO_IPT_PERFMON with CUCM Perfmon metrics. 

This is a read-only parameter whose value you cannot change. Typically, the value for INSTANCES is a string that 
represents the name of the technology pack.
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INSTANCES

Description

Group alias.

Component

UBA

Value

Default: VOIP_CISCO_IPT

Attribute: Read-only

Location: Advanced Properties tab

Detail

The DataChannel supports multiple instances of technology packs running in a single channel component. 
Therefore, there must be a way to guarantee that the DataChannel applications that handle inventory and metrics 
parse the correct design files and read the appropriate Bulk input files. The INSTANCES parameter helps ensure 
that the DataChannel applications that handle inventory and metrics perform the correct operation for a specific 
technology pack.

The value of INSTANCES is one of the following: 

• VOIP_CISCO_IPT with CCM or CUCM metrics. 

• VOIP_CISCO_IPT_PERFMON with CUCM Perfmon metrics. 

This is a read-only parameter whose value you cannot change. Typically, the value for INSTANCES is a string that 
represents the name of the technology pack.
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VOIP_CISCO_IPT.CCMINPUT.DELETEONACQUIRE

Description

Deletes CCM Bulk input files after acquisition.

Component

UBA

Value

Default: false

Attribute: Writable

Location: Advanced Properties tab

Detail

The CCMINPUT.DELETEONACQUIRE parameter specifies whether the Bulk input files should be preserved after 
the UBA acquires them. A related parameter - CCMINPUT.URI - specifies the location of the Bulk input files.

Set this parameter to the value true to instruct this UBA application to delete the CCM Bulk input files after it 
acquires them. Otherwise, set this parameter to false to instruct this UBA application to preserve the Bulk input 
files after it acquires them.
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VOIP_CISCO_IPT.CCMINPUT.URI

Description

CCM Bulk input files location.

Component

UBA

Value

Default: No default value

Attribute: Read-only

Location: Properties tab

Detail

The DataChannel applications that handle inventory and metrics must be directed to the location of the Bulk 
input files generated by the devices associated with the technology on which the application operates. The 
CCMINPUT.URI parameter specifies the location for the specified DataChannel applications to retrieve these Bulk 
input files. A related parameter - CCMINPUT.DELETEONACQUIRE - specifies whether the UBA application should 
delete the Bulk input files after it acquires them.

The syntax for the URI is as follows:  
sqldb:odbc*threaded/username=userName;password=password;environment=dataSourceName

For example: sqldb:odbc*threaded/username=sa;password=netcool;environment=SANFRANCISCO 

Note:  The URIs you specify must match the URIs of each CCM Publisher data source defined in the 
odbc.ini file.
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VOIP_CISCO_IPT.CDRINPUT.DELETEONACQUIRE

Description

Deletes CUCM Bulk input files after acquisition.

Component

UBA

Value

Default: false

Attribute: Writable

Location: Advanced Properties tab

Detail

The CDRINPUT.DELETEONACQUIRE parameter specifies whether the Bulk input files should be preserved after 
the UBA acquires them. A related parameter - CDRINPUT.URI - specifies the location of these Bulk input files.

Set this parameter to the value true to instruct this UBA application to delete the CUCM Bulk input files after 
it acquires them. Otherwise, set this parameter to false to instruct this UBA application to preserve the Bulk 
input files after it acquires them.
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VOIP_CISCO_IPT.CDRINPUT.URI

Description

CUCM Bulk input files location.

Component

UBA

Value

Default: No default value

Attribute: Read-only

Location: Properties tab

Detail

The DataChannel applications that handle inventory and metrics must be directed to the location of the Bulk 
input files generated by the devices associated with the technology on which the application operates. The 
CDRINPUT.URI parameter specifies the location, in Universal Resource Identifier (URI) format, for the specified 
DataChannel applications to retrieve Bulk input files for CDR data.

A related parameter - CDRINPUT.DELETEONACQUIRE - specifies whether the UBA application should delete these 
Bulk input files after it acquires them.
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VOIP_CISCO_IPT.DESIGNFILE

Description

JavaScript file that controls UBA for CCM or CUCM metrics.

Component

UBA

Value

Default: CUCMAdaptor.js

Attribute: Read-only

Location: Properties tab

Detail

Netcool/Proviso technology packs control the behavior of the DataChannel UBA application through 
instructions contained in Bulk Adaptor design (JavaScript) files. The DESIGNFILE parameter identifies the name 
of a technology pack’s design file.

CCM metrics require the CCMAdaptor.js design file. CUCM metrics require the CUCMAdaptor.js design file.

This is a read-only parameter.
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VOIP_CISCO_IPT.DESIGNFILE

Description

JavaScript file that controls UBA for CCM or CUCM metrics.

Component

UBA

Value

Default: CCMAdaptor.js

Attribute: Read-only

Location: Properties tab

Detail

Netcool/Proviso technology packs control the behavior of the DataChannel UBA application through 
instructions contained in Bulk Adaptor design (JavaScript) files. The DESIGNFILE parameter identifies the name 
of a technology pack’s design file.

CCM metrics require the CCMAdaptor.js design file. CUCM metrics require the CUCMAdaptor.js design file.

This is a read-only parameter.
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VOIP_CISCO_IPT.INPUT_DIRECTORY

Description

Path to Bulk input files directory for CCM or CUCM metrics.

Component

UBA

Value

Default: sqldb:odbc*threaded/username=user&password=passwd&environment=EXAMPLE

Attribute: Writable

Location: Properties tab

Detail

The INPUT_DIRECTORY parameter specifies the path to the directory where the generated Bulk input files should 
be stored.

Do not enter any subdirectories and the actual wildcards used to specify the Bulk input files to be acquired. Any 
subdirectories and wildcards are automatically specified in the URI-related parameters. An example of an input 
directory specification is opt/uba.

CCM metrics are accessed through ODBC to a SQL database. CUCM metrics are accessed through SOAP 
requests.
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Appendix B:  UBA Parameters Reference (443, Topology Editor)
VOIP_CISCO_IPT.INPUT_DIRECTORY

Description

Path to Bulk input files directory for CCM or CUCM metrics.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_DIRECTORY parameter specifies the path to the directory where the generated Bulk input files should 
be stored.

Do not enter any subdirectories and the actual wildcards used to specify the Bulk input files to be acquired. Any 
subdirectories and wildcards are automatically specified in the URI-related parameters. An example of an input 
directory specification is opt/uba.

CCM metrics are accessed through ODBC to a SQL database. CUCM metrics are accessed through SOAP 
requests.
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VOIP_CISCO_IPT.INPUT_FTP_PASSWORD

Description

FTP or SFTP password for Bulk input files used in CCM or CUCM environments.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_FTP_PASSWORD parameter specifies the password that the server administrator assigned (using the 
ftp or sftp utility) to the FTP or SFTP user. The FTP or SFTP user specifies this password to gain access to the 
server on which the Bulk input files reside.

Likewise, the UBA uses this same password to gain access to the server on which the Bulk input files reside.
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VOIP_CISCO_IPT.INPUT_FTP_USERNAME

Description

FTP or SFTP username for Bulk input files used in CCM or CUCM environments.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_FTP_USERNAME parameter specifies the username that the server administrator assigned (using the 
ftp or sftp utility) to the FTP or SFTP user. The FTP or SFTP user specifies this username to gain access to the 
server on which the Bulk input files reside.

Likewise, the UBA uses this same username to gain access to the server on which the Bulk input files reside.
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VOIP_CISCO_IPT.INPUT_HOST

Description

Hostname for Bulk input files in CCM or CUCM environments.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_HOST parameter specifies the hostname of the server on which the Bulk input files reside. These are 
the files that the UBA parses.
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Appendix B:  UBA Parameters Reference (443, Topology Editor)
VOIP_CISCO_IPT.INPUT_HOST

Description

Hostname for Bulk input files in CCM or CUCM environments.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_HOST parameter specifies the hostname of the server on which the Bulk input files reside. These are 
the files that the UBA parses.
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 473



Appendix B:  UBA Parameters Reference (443, Topology Editor)
VOIP_CISCO_IPT.INPUT_USE_SECURE_FTP

Description

Acquire CCM or CUCM Bulk input files using secure FTP.

Component

UBA

Value

Default: false

Attribute: Writable

Location: Properties tab

Detail

The INPUT_USE_SECURE_FTP parameter specifies whether FTP (File Transfer Protocol) or SFTP (secure FTP) 
is used. To use FTP, specify the value false. Otherwise, to use SFTP, specify the value true. The default value 
is false.

To use the sftp command, you must have an SSH client installed on the servers where the Bulk input files reside 
and where the DataChannel is running. Typically, an SSH client is installed by default on most Unix systems. For 
more information, see your operating system documentation or the sftp manpage. 

Note:  You cannot do the following: 

• Use an FTP client to connect to an SFTP server 

• Connect to an FTP server with a client that supports only SFTP
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Appendix B:  UBA Parameters Reference (443, Topology Editor)
VOIP_CISCO_IPT.INPUT_USE_SECURE_FTP

Description

Acquire CCM or CUCM Bulk input files using secure FTP.

Component

UBA

Value

Default: false

Attribute: Writable

Location: Properties tab

Detail

The INPUT_USE_SECURE_FTP parameter specifies whether FTP (File Transfer Protocol) or SFTP (secure FTP) 
is used. To use FTP, specify the value false. Otherwise, to use SFTP, specify the value true. The default value 
is false.

To use the sftp command, you must have an SSH client installed on the servers where the Bulk input files reside 
and where the DataChannel is running. Typically, an SSH client is installed by default on most Unix systems. For 
more information, see your operating system documentation or the sftp manpage. 

Note:  You cannot do the following: 

• Use an FTP client to connect to an SFTP server 

• Connect to an FTP server with a client that supports only SFTP
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VOIP_CISCO_IPT_PERFMON.DESIGNFILE

Description

JavaScript file that controls UBA for CUCM Perfmon metrics.

Component

UBA

Value

Default: CUCMPerfmonAdaptor.js

Attribute: Read-only

Location: Properties tab

Detail

Netcool/Proviso technology packs control the behavior of the DataChannel UBA application through 
instructions contained in Bulk Adaptor design (JavaScript) files. The DESIGNFILE parameter identifies the name 
of a technology pack’s design file.

This is a read-only parameter. You cannot change the name of the technology pack’s Bulk Adaptor design file.
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VOIP_CISCO_IPT_PERFMON.INPUT_DIRECTORY

Description

Path to Bulk input files directory for CUCM Perfmon metrics.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_DIRECTORY parameter specifies the path to the directory where the generated Bulk input files should 
be stored.

Do not enter any subdirectories and the actual wildcards used to specify the Bulk input files to be acquired. Any 
subdirectories and wildcards are automatically specified in the URI-related parameters. An example of an input 
directory specification is opt/uba.

CUCM Perfmon metrics are accessed through SOAP requests.
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VOIP_CISCO_IPT_PERFMON.INPUT_FTP_PASSWORD

Description

FTP or SFTP password for Bulk input files used for collecting Perfmon metrics in CUCM environments.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_FTP_PASSWORD parameter specifies the password that the server administrator assigned (using the 
ftp or sftp utility) to the FTP or SFTP user. The FTP or SFTP user specifies this password to gain access to the 
server on which the Bulk input files reside.

Likewise, the UBA uses this same password to gain access to the server on which the Bulk input files reside.
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VOIP_CISCO_IPT_PERFMON.INPUT_FTP_USERNAME

Description

FTP or SFTP username for Bulk input files used for collecting Perfmon metrics in CUCM environments.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_FTP_USERNAME parameter specifies the username that the server administrator assigned (using the 
ftp or sftp utility) to the FTP or SFTP user. The FTP or SFTP user specifies this username to gain access to the 
server on which the Bulk input files reside.

Likewise, the UBA uses this same username to gain access to the server on which the Bulk input files reside.
Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W 479



Appendix B:  UBA Parameters Reference (443, Topology Editor)
VOIP_CISCO_IPT_PERFMON.INPUT_HOST

Description

Hostname for Bulk input files containing Perfmon metrics in CUCM environments.

Component

UBA

Value

Default: No default value

Attribute: Writable

Location: Properties tab

Detail

The INPUT_HOST parameter specifies the hostname of the server on which the Bulk input files reside. These are 
the files that the UBA parses.
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VOIP_CISCO_IPT_PERFMON.INPUT_USE_SECURE_FTP

Description

Acquire CUCM Perfmon Bulk input files using secure FTP.

Component

UBA

Value

Default: false

Attribute: Writable

Location: Properties tab

Detail

The INPUT_USE_SECURE_FTP parameter specifies whether FTP (File Transfer Protocol) or SFTP (secure FTP) 
is used. To use FTP, specify the value false. Otherwise, to use SFTP, specify the value true. The default value 
is false.

To use the sftp command, you must have an SSH client installed on the servers where the Bulk input files reside 
and where the DataChannel is running. Typically, an SSH client is installed by default on most Unix systems. For 
more information, see your operating system documentation or the sftp manpage. 

Note:  You cannot do the following: 

• Use an FTP client to connect to an SFTP server 

• Connect to an FTP server with a client that supports only SFTP
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VOIP_CISCO_IPT_PERFMON.PERFMON.DELETEONACQUIRE

Description

Deletes CUCM Perfmon Bulk input files after acquisition.

Component

UBA

Value

Default: false

Attribute: Writable

Location: Advanced Properties tab

Detail

The PERFMON.DELETEONACQUIRE parameter specifies whether the Bulk input files should be preserved after the 
UBA acquires them. A related parameter - PERFMON.URI - specifies the location of these Bulk input files.

Set this parameter to the value true to instruct this UBA application to delete the CUCM Perfmon Bulk input 
files after it acquires them. Otherwise, set this parameter to false to instruct this UBA application to preserve 
the Bulk input files after it acquires them.
482 Netcool/Proviso Cisco IP Telephony Technology Pack User’s Guide, Version 4.3-W



Appendix B:  UBA Parameters Reference (443, Topology Editor)
VOIP_CISCO_IPT_PERFMON.PERFMON.URI

Description

CUCM Perfmon Bulk input files location.

Component

UBA

Value

Default: No default value

Attribute: Read-only

Location: Properties tab

Detail

The DataChannel applications that handle inventory and metrics must be directed to the location of the Bulk 
input files generated by the devices associated with the technology on which the application operates. The 
PERFMON.URI parameter specifies the location, in Universal Resource Identifier (URI) format, for the specified 
DataChannel applications to retrieve Bulk input files for CDR data.

A related parameter - PERFMON.DELETEONACQUIRE - specifies whether the UBA application should delete these 
Bulk input files after it acquires them. 
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Appendix C: Template File Reference

You should be reading this appendix after you have opened the voip_cisco_ipt_sample_dc.cfg template 
file for editing, as instructed to do so in Appendix A, Configuration. 

Note:  The cross reference link to Appendix A, Configuration does not work due to a formatting limitation. 

This appendix provides a Unix reference page that identifies the pack-specific UBA parameters you need to add 
to the dc.cfg file and explains how to tailor the values to your specific deployment. 

Pack-Specific UBA Parameters 

Template File Name 

voip_cisco_ipt_sample_dc.cfg 

File Location 

The voip_cisco_ipt_sample_dc.cfg template file resides in the following directory on the DataChannel 
server: 

DATA_CHANNEL_HOME/scripts (/opt/datachannel/scripts, by default) 

You were instructed to copy the voip_cisco_ipt_sample_dc.cfg template file in a configuration step (Copy 
technology-specific files from the DataMart server to the DataChannel server) described in Appendix A, Configuration. 

Note:  The cross reference links to the configuration step and Appendix A, Configuration do not work due to a 
formatting limitation. 

Pack-Specific UBA Parameters 

The voip_cisco_ipt_sample_dc.cfg template file provides the following pack-specific UBA parameters: 

UBA.<channel_number>.<collector_number>.INSTANCES=<instance> 
UBA.<channel_number>.<collector_number>.TIMEZONE=GMT 
UBA.<channel_number>.<collector_number>.<instance>.DESIGNFILE=CCMAdaptor.js 
UBA.<channel_number>.<collector_number>.<instance>.CCMINPUT.URI=<input_files_location> 
UBA.<channel_number>.<collector_number>.<instance>.CCMINPUT.DELETEONACQUIRE=true 
UBA.<channel_number>.<collector_number>.METRIC_STREAM_TYPE=BOF 
UBA.<channel_number>.<collector_number>.DEBUG_WALKBACK_ON_ADAPTOR_ERROR=TRUE 
UBA.<channel_number>.<collector_number>.SERVICE_INSTANCE=GLOBAL 
UBA.<channel_number>.<collector_number>.INVENTORY_SUBELEMENT_FLUSH_THRESHOLD=1 
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Pack-Specific UBA Parameter Values 

Additional Information on UBA Parameter Values 

INSTANCES 

The DataChannel UBA application supports multiple instances of technology packs running in a single channel 
component. Therefore, there must be a way to guarantee that the UBA parses the correct design file and reads 
the appropriate Bulk input files. The INSTANCES parameter helps ensure that the DataChannel UBA application 
performs the correct operation for a specific technology pack. 

The Cisco IP Telephony Technology Pack provides an INSTANCES parameter in its 
voip_cisco_ipt_sample_dc.cfg template file. You supply an arbitrary string — referred to as a group alias 
— to the INSTANCES parameter. After you define the INSTANCES parameter with a specific string, make sure 
you specify this string wherever <instance> appears in the template file. 

You can associate this group alias with any arbitrary string. For example, you might associate this group alias with 
the location (for example, BOSTON, LOWELL, BERLIN, PARIS, and so forth) of the data source. 

URI 

You must specify the Uniform Resource Identifier (URI) for each CCM Publisher bulk adaptor configured in the 
dc.cfg file. 

The syntax for the URI is as follows. The variable portions of the URI string are indicated by italic text within 
brackets (< >):

UBA.2.215.SANFRANCISCO.CCMINPUT.URI=sqldb:odbc*threaded/username=<userName>& 
password=<password>&environment=<dataSourceName>

For example:

UBA.2.215.SANFRANCISCO.CCMINPUT.URI=sqldb:odbc*threaded/username=sa&password
=netcool&environment=SANFRANCISCO

Note:  The URIs you specify in the dc.cfg file must match the URIs of each CCM Publisher data source defined 
in the odbc.ini file.

UBA Parameter Value Meaning 

<channel_number> Replace with the channel number that was configured for this 
technology pack. This channel number appears in the dc.cfg 
file. 

<collector_number> Replace with the UBA Bulk Collector number that was configured 
for this technology pack. This collector number appears in the 
dc.cfg file. 

<instance> Replace the variable with an arbitrary string (for example, 
LOWELL) that identifies a group alias to be associated with 
subsequent lines in this section of the dc.cfg file. See Additional 
Information on UBA Parameter Values on page 486 for more 
information on this UBA parameter value. 

<input_files_location> Specify the URIs of each CCM Publisher data source defined in the 
odbc.ini file.
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Notes

Use the following guidelines to determine if you have the correct value for the 
UBA.<channel_number>.<collector_number>.DB_USERNAME parameter in the dc.cfg file: 

• The UBA technology pack requires the DataChannel UBA application to process metrics only. In this 
scenario, the UBA technology pack provides a metrics schema in its design file. In this case, DB_USERNAME 
must be set to PV_COLL. 

• The UBA technology pack requires the DataChannel UBA application to process both inventory and 
metrics. In this scenario, the UBA technology pack provides metrics and inventory schemas in its design file. 
In this case, DB_USERNAME must be set to PV_GUI. 

For the Cisco IP Telephony Technology Pack, DB_USERNAME should be set to PV_GUI. 

Examples 

The following example shows the UBA parameter settings for the Cisco IP Telephony Technology Pack: 

UBA.2.215.ROOT_DIRECTORY=/opt/datachannel
UBA.2.215.INSTANCES=SANFRANCISCO
UBA.2.215.RUNINTERVAL=1800
UBA.2.215.SANFRANCISCO.TIMEZONE=GMT
UBA.2.215.SANFRANCISCO.DESIGNFILE=CCMAdaptor.js
UBA.2.215.SANFRANCISCO.CCMINPUT.URI=sqldb:odbc*threaded/username=sa&password= 
netcool&environment=SANFRANCISCO
UBA.2.215.SANFRANCISCO.CCMINPUT.DELETEONACQUIRE=false
UBA.2.215.METRIC_STREAM_TYPE=BOF
UBA.2.215.DEBUG_WALKBACK_ON_ADAPTOR_ERROR=TRUE
UBA.2.215.DUAL_LOGGING=true
UBA.2.215.LOG_FILTER=FEWI 12345
UBA.2.215.SERVICE_INSTANCE=GLOBAL
UBA.2.215.COLLECTOR_LIST=215
UBA.2.215.DB_USERNAME=PV_GUI
UBA.2.215.DB_PASSWORD=AAAC
UBA.2.215.INVENTORY_SUBELEMENT_FLUSH_THRESHOLD=10
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Additional Copyright Information

The following copyright information is for software used by Netcool/Proviso.

Tcl 8.3.3, Combat/TCL 0.7.3, Combat/TCL 0.7.5, TclX 8.3, TK 8.3.3

This software is copyrighted by the Regents of the University of California, Sun Microsystems, Inc., Scriptics Corporation, and 
other parties. The following terms apply to all files associated with the software unless explicitly disclaimed in individual files.  

The authors hereby grant permission to use, copy, modify, distribute, and license this software and its documentation for any 
purpose, provided that existing copyright notices are retained in all copies and that this notice is included verbatim in any 
distributions. No written agreement, license, or royalty fee is required for any of the authorized uses. Modifications to this software 
may be copyrighted by their authors and need not follow the licensing terms described here, provided that the new terms are clearly 
indicated on the first page of each file where they apply.  

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, ITS 
DOCUMENTATION, OR ANY DERIVATIVES THEREOF, EVEN IF THE AUTHORS HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.  

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
AND NON-INFRINGEMENT. THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS, AND THE AUTHORS AND 
DISTRIBUTORS HAVE NO OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, 
OR MODIFICATIONS.  

GOVERNMENT USE: If you are acquiring this software on behalf of the U.S. government, the Government shall have only 
"Restricted Rights" in the software and related documentation as defined in the Federal Acquisition Regulations (FARs) in Clause 
52.227.19 (c) (2). If you are acquiring the software on behalf of the Department of Defense, the software shall be classified as 
"Commercial Computer Software" and the Government shall have only "Restricted Rights" as defined in Clause 252.227-7013 (c) 
(1) of DFARs. Notwithstanding the foregoing, the authors grant the U.S. Government and others acting in its behalf permission to 
use and distribute the software in accordance with the terms specified in this license. 

SCOTTY Stack

This software is copyrighted by Juergen Schoenwaelder, the Technical University of Braunschweig, the University of Twente, and 
other parties. The following terms apply to all files associated with the software unless explicitly disclaimed in individual files.

The authors hereby grant permission to use, copy, modify, distribute, and license this software and its documentation for any 
purpose, provided that existing copyright notices are retained in all copies and that this notice is included verbatim in any 
distributions. No written agreement, license, or royalty fee is required for any of the authorized uses. Modifications to this software 
may be copyrighted by their authors and need not follow the licensing terms described here, provided that the new terms are clearly 
indicated on the first page of each file where they apply. 

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO 
ANY PARTY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS 
SOFTWARE, ITS DOCUMENTATION, OR ANY DERIVATIVES THEREOF, 
EVEN IF THE AUTHORS HAVE BEEN ADVISED OF THE POSSIBILITY OF 

SUCH DAMAGE. 

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 

Windows Explorer.lnk
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AND NON-INFRINGEMENT.  THIS SOFTWARE IS PROVIDED ON AN “AS IS” BASIS, AND THE AUTHORS AND 
DISTRIBUTORS HAVE NO OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, 
OR MODIFICATIONS. 

Various copyrights apply to this package, listed in 3 separate parts below.  Please make sure that you include all the parts.  Up until 
2001, the project was based at UC Davis, and the first part covers all code written during this time.  From 2001 onwards, the project 
has been based at SourceForge, and Networks Associates Technology, Inc hold the copyright on behalf of the wider Net-SNMP 
community, covering all derivative work done since then.  An additional copyright section has been added as Part 3 below also under 
a BSD license for the work contributed by Cambridge Broadband Ltd. to the project since 2001.

Part 1: CMU/UCD copyright notice: (BSD like)

Copyright © 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright © 1996, 1998-2000 The Regents of the University of California

All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appears in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation, and that the name of CMU and The Regents of the University of California not be 
used in advertising or publicity pertaining to distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH REGARD 
TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO 
EVENT SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS 
OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Part 2: Networks Associates Technology, Inc copyright notice (BSD)

Copyright © 2001, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer 

in the documentation and/or other materials provided with the distribution.
• Neither the name of the NAI Labs nor the names of its contributors may be used to endorse or promote products derived 

from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL 
THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Part 3: Cambridge Broadband Ltd. copyright notice (BSD)

Portions of this code are copyright © 2001, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
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• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer 
in the documentation and/or other materials provided with the distribution.

• The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDER 
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

BLT 2.4u

Portions (c) 1993 AT&T, (c) 1993 - 1998 Lucent Technologies, (c) 1994-1998 Sun Microsystems, Inc., and (c) 1987-1993 The 
Regents of the University of California. 

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appears in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation, and that the names of AT&T, Lucent Technologies Inc., Sun Microsystems, Inc. and 
The Regents of the University of California not be used in advertising or publicity pertaining to distribution of the software without 
specific written permission. 

THE COPYRIGHT HOLDERS AND OTHER CONTRIBUTORS DISCLAIM ALL WARRANTIES WITH REGARD TO 
THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.  IN NO 
EVENT SHALL THE COPYRIGHT HOLDERS OR OTHER CONTRIBUTORS BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS 
OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 

CMU-SNMP 1.14

CMU/UCD copyright notice: (BSD like) Copyright 1989, 1991, 1992 by Carnegie Mellon University 

Derivative Work - 1996, 1998-2000 Copyright 1996, 1998-2000 The Regents of the University of California 

All Rights Reserved 

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appears in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation, and that the name of CMU and The Regents of the University of California not be 
used in advertising or publicity pertaining to distribution of the software without specific written permission. 

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH REGARD 
TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.  IN NO 
EVENT SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS 
OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 

Scotty 2.8, incrTCL 3.0, [incr TCL] 3.2

Portions Copyright (c) 1987-1994 The Regents of the University of California. Copyright (c) 1994-1995 Sun Microsystems, Inc.  
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This software is copyrighted by the Regents of the University of California, Sun Microsystems, Inc., and other parties. The following 
terms apply to all files associated with the software unless explicitly disclaimed in individual files.  

The authors hereby grant permission to use, copy, modify, distribute, and license this software and its documentation for any 
purpose, provided that existing copyright notices are retained in all copies and that this notice is included verbatim in any 
distributions. No written agreement, license, or royalty fee is required for any of the authorized uses. Modifications to this software 
may be copyrighted by their authors and need not follow the licensing terms described here, provided that the new terms are clearly 
indicated on the first page of each file where they apply.  

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, ITS 
DOCUMENTATION, OR ANY DERIVATIVES THEREOF, EVEN IF THE AUTHORS HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.  

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
AND NON-INFRINGEMENT. THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS, AND THE AUTHORS AND 
DISTRIBUTORS HAVE NO OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, 
OR MODIFICATIONS.  

RESTRICTED RIGHTS: Use, duplication or disclosure by the government is subject to the restrictions as set forth in 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software Clause as DFARS 252.227-7013 and FAR 52.227-
19.  

Portions Copyright (c) 1993-1998 Lucent Technologies, Inc.  

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and warranty 
disclaimer appear in supporting documentation, and that the names of Lucent Technologies any of their entities not be used in 
advertising or publicity pertaining to distribution of the software without specific, written prior permission.  

Lucent disclaims all warranties with regard to this software, including all implied warranties of merchantability and fitness. In no 
event shall Lucent be liable for any special, indirect or consequential damages or any damages whatsoever resulting from loss of 
use, data or profits, whether in an action of contract, negligence or other tortuous action, arising out of or in connection with the 
use or performance of this software. 

UCD SNMP 4.2.5

Portions Copyright 1989, 1991, 1992 by Carnegie Mellon University.  Derivative Work - 1996, 1998-2000, Copyright 1996, 1998-
2000 The Regents of the University of California All Rights Reserved 

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appears in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation, and that the name of CMU and The Regents of the University of California not be 
used in advertising or publicity pertaining to distribution of the software without specific written permission. 

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH REGARD 
TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.  IN NO 
EVENT SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS 
OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 

Portions Copyright:  (c) 2001-2003, Networks Associates Technology, Inc, (c) 2001-2003, Cambridge Broadband Ltd,  (c) 2003-
2005, Sparta, Inc., (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and Telecommunications, 
(c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com.  All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in 
the documentation and/or other materials provided with the distribution. 
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3. Neither the names of Networks Associates Technology, Inc, Cambridge Broadband Ltd., Sparta, Inc., Cisco, Inc, Beijing 
University of Posts and Telecommunications, Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product 
names, nor the names of their contributors may be used to endorse or promote products derived from this software without specific 
prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL 
THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

JDOM 1.0

Copyright (C) 2000-2004 Jason Hunter & Brett McLaughlin. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer. 

 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the disclaimer that follows 
these conditions in the documentation and/or other materials provided with the distribution. 

3. The name "JDOM" must not be used to endorse or promote products derived from this software without prior written 
permission.  For written permission, please contact <request_AT_jdom_DOT_org>. 

 4. Products derived from this software may not be called "JDOM", nor may "JDOM" appear in their name, without prior written 
permission from the JDOM Project Management <request_AT_jdom_DOT_org>. 

 In addition, we request (but do not require) that you include in the end-user documentation provided with the redistribution and/or 
in the software itself an acknowledgement equivalent to the following: 

"This product includes software developed by the JDOM Project (http://www.jdom.org/)." Alternatively, the acknowledgment 
may be graphical using the logos available at http://www.jdom.org/images/logos. 

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE JDOM AUTHORS OR THE PROJECT CONTRIBUTORS 
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

This software consists of voluntary contributions made by many individuals on behalf of the JDOM Project and was originally 
created by Jason Hunter <jhunter_AT_jdom_DOT_org> and Brett McLaughlin <brett_AT_jdom_DOT_org>.  For more 
information on the JDOM Project, please see <http://www.jdom.org/>.  

Regex 1.1a

Copyright (C) 1996, 1999 Vassili Bykov. It is provided to the Smalltalk community in hope it will be useful. 

1. This license applies to the package as a whole, as well as to any component of it. By performing any of the activities described 
below, you accept the terms of this agreement. 

2. The software is provided free of charge, and ``as is'', in hope that it will be useful, with ABSOLUTELY NO WARRANTY. The 
entire risk and all responsibility for the use of the software is with you. Under no circumstances the author may be held responsible 
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for loss of data, loss of profit, or any other damage resulting directly or indirectly from the use of the software, even if the damage 
is caused by defects in the software. 

3. You may use this software in any applications you build. 

4. You may distribute this software provided that the software documentation and copyright notices are included and intact. 

5. You may create and distribute modified versions of the software, such as ports to other Smalltalk dialects or derived work, 
provided that: 

a. any modified version is expressly marked as such and is not misrepresented as the original software;  

b. credit is given to the original software in the source code and documentation of the derived work;  

c. the copyright notice at the top of this document accompanies copyright notices of any modified version. 

Xwpick

Copyright © 1993, 1994 by Evgeni Chernyaev 

Permission to use, copy, modify, and distribute this software and its documentation for non-commercial purpose is hereby granted 
without fee, provided that the above copyright notice appear in all copies and that both the copyright notice and this permission 
notice appear in supporting documentation. Xwpick is used for printing utilities.

Sieve of Erastothenes

Copyright Frank Pilhofer, fp@fpx.de

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in 
the documentation and/or other materials provided with the distribution. 

Neither the name of Frank Pilhofer nor the names of its contributors may be used to endorse or promote products derived from 
this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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